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ABSTRAK 

 

Penelitian ini bertujuan untuk mengetahui efektivitas penggunaan media 

pembelajaran E-Learning berbasis web pada pelajaran Teknologi Informasi dan 

Komunikasi terhadap hasil belajar siswa Kelas X SMA Negeri 1 Kalasan apabila 

dibandingkan dengan pembelajaran konvensional yang diberlakukan di sekolah 

tersebut.  

Metode penelitian yang digunakan dalam penelitian ini adalah metode 

penelitian quasi eksperimen dengan sampel penelitiannya adalah kelas XA dan 

XB SMA Negeri 1 Kalasan. Adapun desain penelitian yang digunakan adalah 

pretest-posttest control group design. Uji beda dilakukan untuk mengukur 

perbedaan efektivitas media pembelajaran E-Learning berbasis web dan media 

pembelajaran konvensional berdasarkan kriteria hasil belajarnya.  

Berdasarkan hasil penelitian dapat diambil kesimpulan bahwa efektivitas 

media pembelajaran E-Learning berbasis web masuk dalam kriteria sedang yaitu 

dengan indeks normalized gain sebesar 0.54, efektivitas media pembelajaran 

konvensional masuk dalam kriteria sedang yaitu dengan indeks normalized gain 

sebesar 0.30 dan peningkatan hasil belajar dengan media pembelajaran E-

Learning lebih baik dibandingkan dengan peningkatan hasil belajar media 

pembelajaran konvensional pada materi Perangkat Lunak Pembuat Presentasi 

Kelas X SMA Negeri 1 Kalasan. Berdasarkan hasil uji t dari nilai rata-rata hasil 

belajar diperoleh 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  > 𝑡𝑡𝑎𝑏𝑒𝑙  (2.870 > 1.672), serta nilai signifikansi (P) 

adalah 0.006 < ∝ (0.05), dengan demikian 𝐻𝑜  ditolak dan 𝐻𝑎  diterima. Ini 

membuktikan bahwa media pembelajaran E-Learning berbasis web efektif untuk 

meningkatkan hasil belajar siswa pada materi Perangkat Lunak Pembuat 

Presentasi Kelas X SMA Negeri 1 Kalasan.  

Kata kunci : media pembelajaran, E-Learning, konvensional, hasil belajar. 
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BAB I 

PENDAHULUAN 

 

A. Latar Belakang  

Perkembangan teknologi informasi dan komunikasi telah membawa 

perubahan yang sangat besar bagi kemajuan dunia pendidikan. Seiring dengan 

perkembangan tersebut metode pembelajaran juga banyak mengalami 

perkembangan, baik metode pembelajaran secara personal, media pembelajaran 

ataupun proses pembelajaran. Bentuk dari perkembangan teknologi informasi 

yang diterapkan di dunia pendidikan adalah E-Learning. E-Learning merupakan 

sebuah inovasi yang mempunyai kontribusi sangat besar terhadap perubahan 

proses pembelajaran, dimana proses belajar tidak lagi hanya mendengarkan uraian 

materi dari guru tetapi siswa juga melakukan aktivitas lain seperti mengamati, 

melakukan, mendemonstrasikan dan lain-lain. Materi bahan ajar dapat 

divisualisasikan dalam berbagai format dan bentuk yang lebih dinamis dan 

interaktif sehingga learner atau murid akan termotivasi untuk terlibat lebih jauh 

dalam proses pembelajaran tersebut. 

SMA Negeri 1 Kalasan, masih memberlakukan pembelajaran konvensional. 

Pembelajaran konvensional yang dimaksud di sini adalah pembelajaran yang 

penyampaian materinya diuraikan oleh guru dengan media pembelajaran yang 

standar, misalnya powerpoint atau tanpa media pembelajaran kemudian 

memberikan soal (penugasan) kepada siswa dengan materi yang terbatas. 

Berdasarkan data yang diperoleh dari beberapa indikator hasil berbincang dengan 

guru TIK dan observasi di kelas, menunjukkan bahwa secara umum siswa kelas X 
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SMA Negeri 1 Kalasan berada dalam rentang minat belajar TIK rendah yang 

sangat berpengaruh pada hasil belajar. Memperhatikan hal tersebut, kemungkinan 

sistem yang digunakan dalam pembelajaran kurang tepat sehingga berpengaruh 

pada hasil belajar. Selengkapnya bisa dilihat pada Lembar Observasi (lampiran 1). 

Di sisi lain, sarana dan prasarana yang dimiliki sekolah seperti jaringan 

internet kurang dioptimalkan. Hal ini terlihat pada kurang dimanfaatkannya 

internet sebagai sumber belajar. Sekolah sudah memiliki E-Learning namun 

belum dimanfaatkan secara optimal oleh guru mata pelajaran, terutama TIK. 

Dengan adanya media pembelajaran E-Learning ini, diharapkan akan membuat 

proses pembelajaran menjadi lebih kondusif, meningkatkan minat siswa, serta 

dapat mempertinggi proses belajar siswa dalam pembelajaran yang pada 

gilirannya diharapkan dapat mempertinggi hasil belajar yang dicapainya. Hal ini 

dikarenakan E-Learning menuntut siswa untuk bisa berinteraksi dengan internet, 

seperti mengakses informasi yang luas, memunculkan keaktifan siswa yang 

disebabkan tantangan, serta ketersediaan materi untuk pembelajaran.  

Penelitian ini mengkaji pemanfaatan media pembelajaran E-Learning yang 

telah ada di SMA Negeri 1 Kalasan untuk mata pelajaran TIK sebagai sumber 

belajar yang optimal untuk meningkatkan hasil belajar siswa, sehingga peran guru 

sebagai fasilitator dapat dilaksanakan. Selain itu, keaktifan siswa lebih ditekankan 

jika menggunakan media pembelajaran E-Learning karena langkah pembelajaran 

yang runtut telah diberikan sehingga budaya belajar yang diciptakan di sini 

menuntut siswa untuk mandiri dengan harapan mampu meningkatkan pemahaman 
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siswa terhadap materi pelajaran yang akhirnya mampu sejalan dengan 

meningkatnya hasil belajar siswa tersebut.  

B. Identifikasi Masalah  

1. Keterbatasan sumber belajar berbasis teknologi komputer dan telekomunikasi. 

2. Materi yang sifatnya aplikatif atau terapan yang seharusnya lebih banyak 

melatih siswa namun kurangnya kompetensi guru, pembelajaran masih 

bersifat normatif.  

3. Siswa membutuhkan akses belajar yang luas, aktif, kreatif, dan suasana 

belajar yang menantang.  

4. Penggunaan internet belum optimal dalam pencarian sumber belajar.  

5. Kurangnya ketertarikan dan minat siswa dalam mengikuti pembelajaran TIK 

menggunakan metode konvensional selama ini yang diindikasikan selaras 

dengan rendahnya pula hasil belajar siswa. 

C. Batasan Masalah  

Penelitian ini fokus pada efektivitas penggunaan media pembelajaran E-

Learning berbasis web pada pelajaran Teknologi Informasi dan Komunikasi 

terhadap hasil belajar siswa Kelas X SMA Negeri 1 Kalasan pada satu standar 

kompetensi, satu kompetensi dasar dan dua materi pokok, sehingga mampu 

mencakup reliabilitas hasil. Penelitian ini diterapkan pada standar kompetensi 

“Menggunakan perangkat lunak pembuat presentasi” dan kompetensi dasar 

“Membuat presentasi teks dengan variasi gambar dan animasi”. Penelitian 

dilakukan menggunakan 2 kelompok sampel supaya dapat melihat efektivitas 



4 
 

pada kedua media pembelajaran, maka perlu adanya kelompok pembanding 

tersebut (kelas konvensional).  

D. Rumusan Masalah   

Bagaimana efektivitas penggunaan media pembelajaran E-Learning berbasis 

web pada pelajaran Teknologi Informasi dan Komunikasi terhadap hasil belajar 

siswa Kelas X SMA Negeri 1 Kalasan? 

E. Tujuan Penelitian  

Mengetahui efektivitas penggunaan media pembelajaran E-Learning 

berbasis web pada pelajaran Teknologi Informasi dan Komunikasi terhadap hasil 

belajar siswa Kelas X SMA Negeri 1 Kalasan.  

F. Manfaat Penelitian  

1. Manfaat Teoritis  

Memberikan sumbangsih pada ilmu pengetahuan tentang pengembangan E-

Learning berbasis web sebagai media pembelajaran yang tepat, efektif, inovatif 

dan dapat digunakan dalam pembelajaran TIK, serta dapat meningkatkan hasil 

belajar siswa.  

2. Manfaat Praktis  

a. Bagi Guru  

1) Membantu guru dalam melaksanakan pembelajaran secara individual, 

interaktif, dan kreatif dengan sumber belajar yang luas (open source). 

2) Guru dapat memfasilitasi pengembangan potensi, gaya belajar, serta 

kebutuhan belajar siswa yang beragam.  

3) Guru termotivasi untuk mengembangkan E-Learning. 
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4) Guru dapat berperan sebagai fasilitator dalam pembelajaran.  

b. Bagi Siswa  

1) Siswa dapat melakukan pembelajaran TIK di mana pun dan kapan pun 

jika E-Learning ini dimanfaatkan secara optimal.  

2) Siswa dapat belajar menurut kemampuan dan minatnya.  

3) Siswa memiliki sumber belajar yang luas.  

c. Bagi Sekolah  

1) Tersedianya sumber belajar alternatif yang dapat digunakan dalam 

kegiatan pembelajaran secara interaktif.  

2) Mendukung pengembangan teknologi di lingkungan sekolah.  

G. Daya Pendukung Penelitian   

1. Sekolah mampu menyediakan sarana komputer dan jaringan internet yang 

memadai. 

2. Siswa dan guru mampu mengoperasikan komputer dan internet.  

3. Sekolah sudah memiliki E-Learning yang belum dioptimalkan.  

4. E-Learning dapat diaplikasikan juga melalui jaringan local (LAN).  
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BAB II 

LANDASAN TEORI 

 

A. Kajian Teori 

1. Pembelajaran  

Makna pembelajaran dalam Kamus Besar Bahasa Indonesia,  adalah proses, 

cara perbuatan menjadikan orang atau makhluk hidup belajar. Lebih lanjut, Wina 

Sanjaya (2008:51) mengemukakan bahwa pembelajaran merupakan kegiatan yang 

bertujuan membelajarkan siswa.  

Undang-Undang Republik Indonesia Nomor 20 Tahun 2003 tentang Sistem 

Pendidikan Nasional, mengemukakan bahwa pembelajaran adalah proses interaksi 

peserta didik dengan pendidik dan sumber belajar pada suatu lingkungan belajar. 

Setiap guru penting untuk memahami sistem pembelajaran, karena dengan 

pemahaman sistem ini, setiap guru akan memahami tentang tujuan pembelajaran 

atau hasil yang diharapkan, proses kegiatan pembelajaran yang harus dilakukan, 

pemanfaatan setiap komponen dalam proses kegiatan untuk mencapai tujuan yang 

ingin dicapai dan bagaimana mengetahui keberhasilan pencapaian tersebut.  

Tujuan pembelajaran adalah kemampuan (kompetensi) atau keterampilan 

yang diharapkan dapat dimiliki oleh siswa setelah mereka melakukan proses 

pembelajaran tertentu (Wina Sanjaya, 2008:86). Lebih lanjut, Wina Sanjaya 

(2008:88) mengemukakan bahwa rumusan tujuan pembelajaran harus 

mengandung unsur ABCD, yaitu Audience (siapa yang harus memiliki 

kemampuan), Behaviour (perilaku yang bagaimana yang diharapkan dapat 

dimiliki), Condition (dalam kondisi dan situasi yang bagaimana subjek dapat 
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menunjukkan kemampuan sebagai hasil belajar yang telah diperolehnya), dan 

Degree (kualitas atau kuantitas tingkah laku yang diharapkan dicapai sebagai 

batas minimal).  

Di sisi lain, upaya peningkatan kualitas pembelajaran perlu 

mempertimbangkan perubahan-perubahan dalam proses pembelajaran, yang 

antara lain ditandai dengan adanya perubahan dari model belajar terpusat pada 

guru ke model terpusat pada peserta didik, dari kerja terisolasi ke kerja kolaborasi, 

dari pengiriman informasi sepihak ke pertukaran informasi, dari pembelajaran 

pasif ke pembelajaran aktif dan partisipatif, dari yang bersifat faktual ke cara 

berpikir kritis, dari respon reaktif ke proaktif, dari konteks artificial ke konteks 

dunia nyata, dari single media ke multimedia. Oleh karena itu, pembelajaran harus 

berpotensi mengembangkan suasana belajar mandiri. Dalam hal ini, pembelajaran 

dituntut dapat menarik perhatian peserta didik dan sebanyak mungkin 

memanfaatkan momentum kemajuan teknologi khususnya dengan 

mengoptimalkan pemanfaatan teknologi informasi dan komunikasi (information 

and communication technology). 

Membahas tentang teknologi, tak lepas dari kemajuan Teknologi Informasi 

dan Komunikasi (TIK) dan berbagai kemungkinan penerapannya, khususnya pada 

pembelajaran. Kekuatan TIK pada pembelajaran, akan melahirkan konsep E-

Learning, manfaat  E-Learning, dan bahan-bahan pembelajaran untuk E-Learning 

(Budi Murtiyasa, 2012). 

Berdasarkan uraian di atas dapat disimpulkan bahwa pembelajaran adalah 

proses kegiatan belajar yang melibatkan berbagai komponen, yaitu guru, siswa, 
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tujuan, materi, metode, media, evaluasi dengan pendidikan dan sumber belajar 

pada suatu lingkaran belajar untuk mencapai tujuan pembelajaran yang ingin 

dicapai. Pada penelitian ini, proses pembelajaran menggunakan media online (E-

Learning) untuk menyampaikan materi sekaligus membudayakan peserta didik 

untuk mencari referensi belajar secara online, lebih luas dan mandiri.  

2. Efektivitas  

Efektivitas berasal dari kata dasar efektif. Menurut Kamus Besar Bahasa 

Indonesia (1990:219), kata efektif mempunyai arti efek, pengaruh, akibat atau 

dapat membawa hasil. Jadi efektivitas adalah keaktifan, daya guna, adanya 

kesesuaian dalam suatu kegiatan orang yang melaksanakan tugas dengan sasaran 

yang dituju.  

Berdasarkan uraian di atas dapat disimpulkan bahwa efektivitas adalah suatu 

keadaan yang menunjukkan sejauh mana rencana dapat tercapai. Semakin banyak 

rencana yang dapat dicapai, semakin efektif pula kegiatan tersebut, sehingga kata 

efektivitas dapat juga diartikan sebagai tingkat keberhasilan yang dapat dicapai 

dari suatu cara atau usaha tertentu sesuai dengan tujuan yang hendak dicapai. 

Dapat disimpulkan juga bahwa suatu media pembelajaran bisa dikatakan efektif 

ketika memenuhi criteria, diantaranya mampu memberikan pengaruh, perubahan 

atau dapat membawa hasil. Ketika kita merumuskan tujuan instruksional, maka 

efektivitas dapat dilihat dari seberapa jauh tujuan itu tercapai. Semakin banyak 

tujuan tercapai, maka semakin efektif pula media pembelajaran tersebut.  
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3. Efektivitas Pembelajaran  

Menurut Popham (2003:7), efektivitas proses pembelajaran seharusnya 

ditinjau dari hubungan guru tertentu yang mengajar kelompok siswa tertentu, di 

dalam situasi tertentu dalam usahanya mencapai tujuan-tujuan instruksional 

tertentu. Efektivitas proses pembelajaran berarti tingkat keberhasilan guru dalam 

mengajar kelompok siswa tertentu dengan menggunakan metode tertentu untuk 

mencapai tujuan instruksional tertentu.  

Dunne (1996:12) berpendapat bahwa efektivitas pembelajaran memiliki dua 

karakteristik. Karakteristik pertama ialah “memudahkan murid belajar” sesuatu 

yang bermanfaat, seperti fakta, keterampilan, nilai, konsep atau sesuatu hasil 

belajar yang diinginkan. Kedua, bahwa keterampilan diakui oleh mereka yang 

berkompeten menilai, seperti guru, pengawas, tutor atau murid sendiri.  

Strategi guru untuk dapat meningkatkan efektivitas pembelajaran di dalam 

kelas, Sutikno Sobry (2008:87) memaparkan sebagai berikut :  

 

 

 

 

 

 

 

 

Gambar 1. Upaya Dalam Peningkatan Efektivitas Pembelajaran 

Harus didasarkan pada tujuan pembelajaran 

instruksional yang telah ditetapkan.  

Persiapan 

Pelaksanaan  

Evaluasi  

1. Datang tepat waktu. 

2. Menumbuhkan motivasi pada peserta didik.  

3. Menciptakan komunikasi (interaksi) yang baik.  

4. Menggunakan media pembelajaran yang baik 

dan bervariasi.  

5. Menggunakan model pembelajaran yang baik 

dan bervariasi.  

6. Memberi ringkasan materi dan atau handout  

1. Mengecek / membuat silabus.  

2. Menentukan tujuan instruksional umum. 

3. Menentukan tujuan instruksional khusus. 

4. Memilih model pembelajaran dan alat bantu yang 

relevan. 

5. Menentukan cara evaluasi. 

6. Menentukan kapan pendidikan dimulai.  

7. Menentukan bacaan wajib dan pilihan. 

8. Belajar dan menguasai bahan pelajaran yang 

akan disampaikan.  

9. Membuat ringkasan / garis besar apa yang akan 

disampaikan.  
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Pendapat yang menyatakan tentang indikator sesuatu bisa dikatakan efektif :  

1. Menurut Sinambela (2006:78), pembelajaran dikatakan efektif apabila 

mencapai sasaran yang diinginkan, baik dari segi tujuan pembelajaran maupun 

prestasi siswa yang maksimal. Beberapa indikator keefektifan pembelajaran : 

a. ketercapaian ketuntasan belajar,  

b. ketercapaian keefektifan aktivitas siswa (yaitu pencapaian waktu ideal 

yang digunakan siswa untuk melakukan setiap kegiatan yang termuat 

dalam rencana pembelajaran),  

c. ketercapaian efektivitas kemampuan guru mengelola pembelajaran, dan 

respon siswa terhadap pembelajaran yang positif.  

2. Menurut Wotruba dan Wright dalam Yusufhadi Miarso (2004), indikator yang 

dapat digunakan untuk menentukan efektivitas dalam proses pembelajaran 

adalah : 

a. pengorganisasian materi yang baik, 

b. komunikasi yang efektif, 

c. penguasaan dan antusiasme terhadap materi pelajaran, 

d. sikap positif terhadap siswa, 

e. pemberian nilai yang adil,  

f. keluwesan dalam pendekatan pembelajaran, dan  

g. hasil belajar siswa yang baik.  

Berdasarkan uraian yang telah disebutkan di atas, dapat disimpulkan bahwa 

efektivitas pembelajaran adalah tingkat keberhasilan yang dapat dicapai dari suatu 

metode pembelajaran tertentu sesuai dengan tujuan pembelajaran yang telah 
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direncanakan. Tingkat keberhasilan yang digunakan pada penelitian ini adalah 

indikator ketuntasan hasil belajar siswa.  

4. Media Pembelajaran  

Media adalah bagian yang tidak terpisahkan dari proses belajar mengajar. 

Istilah media merupakan bentuk jamak dari medium yang secara harfiah berarti 

tengah, perantara atau pengantar (Azhar Arsyad, 2004).  

Olson dalam Yusufhadi Miarso (2004), mendefinisikan medium sebagai 

teknologi untuk menyajikan, merekam, membagi, dan mendistribusikan simbol 

melalui rangsangan indera tertentu, disertai penstrukturan informasi. Secara lebih 

khusus, pengertian media dalam proses belajar mengajar cenderung di artikan 

sebagai alat-alat grafis, photografis, atau elektronis untuk menangkap, 

memproses, dan menyusun kembali informasi visual atau verbal (Gerlach & Ely, 

dalam Azhar Arsyad, 2004).  

Pada pembahasan tentang media, istilah media pendidikan dan media 

pembelajaran pada beberapa literatur menunjukkan makna yang sama dan dapat 

digunakan secara bergantian (Yusufhadi Miarso, 2004). Gagne dalam Yusufhadi 

Miarso (2004), menyatakan bahwa media pendidikan adalah berbagai jenis 

komponen dalam lingkungan siswa yang dapat merangsang siswa untuk belajar. 

Sementara itu Briggs mengemukakan bahwa media pembelajaran adalah sarana 

untuk memberikan perangsangan bagi si belajar agar proses belajar terjadi. 

Selanjutnya Yusufhadi Miarso (2004) menyatakan bahwa media pembelajaran 

adalah segala sesuatu yang digunakan untuk menyalurkan pesan serta dapat 
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merangsang pikiran, perasaan, perhatian, dan kemauan siswa sehingga dapat 

mendorong terjadinya proses belajar yang disengaja, bertujuan dan terkendali.  

Secara umum, media pembelajaran mempunyai kegunaan-kegunaan sebagai 

berikut (Yusufhadi Miarso, 2004) : 

a. Media mampu memberikan rangsangan yang bervariasi kepada otak, 

sehingga otak dapat berfungsi secara optimal.  

b. Media dapat mengatasi keterbatasan pengalaman yang dimiliki oleh siswa. 

Kehidupan keluarga dan masyarakat sangat menentukan pengalaman yang 

dimiliki. Ketersediaan buku dan bacaan lain, kesempatan bepergian dan 

sebagainya adalah faktor yang menentukan kekayaan pengalaman anak. 

Jika dalam mengkongkritkan suatu materi ajar, siswa tidak mungkin untuk 

dibawa ke objek yang dipelajari maka objek yang dibawa ke siswa melalui 

media. 

c. Media dapat melampaui batas ruang kelas.  

d. Media memungkinkan adanya interaksi langsung antara siswa dan 

lingkungannya. 

e. Media menghasilkan keseragaman pengamatan. Pengamatan yang 

dilakukan bisa bersama-sama diarahkan kepada hal-hal yang dimaksudkan 

oleh guru. 

f. Membangkitkan keinginan dan minat baru. 

g. Media membangkitkan motivasi dan merangsang untuk belajar. 

h. Media memberikan pengalaman yang integral (menyeluruh) dari sesuatu 

yang kongkrit maupun abstrak. Sebuah film atau serangkaian foto dapat 
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memberikan imajinasi yang kongkret tentang wujud, ukuran, lokasi, dan 

sebagainya. 

i. Media memberikan kesempatan untuk belajar mandiri, pada tempat, waktu 

serta kecepatan yang ditentukan sendiri. 

j. Media meningkatkan kemampuan keterbacaan baru (new literacy) yaitu 

kemampuan untuk membedakan dan menafsirkan objek, tindakan, dan 

lambang yang tampak, baik yang dialami maupun buatan manusia yang 

terdapat dalam lingkungan. 

k. Media mampu meningkatkan efek sosialisasi, yaitu dengan meningkatkan 

kesadaran akan dunia sekitar. 

l. Media dapat meningkatkan kemampuan ekspresi diri siswa maupun guru. 

Perkembangan media pembelajaran mengikuti perkembangan teknologi. 

Berdasarkan perkembangan teknologi. Menurut Ashby (dalam Yusufhadi Miarso, 

2004) perkembangan media telah menimbulkan empat kali revolusi dunia 

pendidikan. Seels dan Richey (dalam Azhar Arsyad, 2004) membagi media 

pembelajaran dalam empat kelompok, yaitu: 

a. Media hasil teknologi cetak 

Media hasil teknologi cetak adalah cara untuk menghasilkan atau 

menyampaikan materi melalui proses pencetakan mekanis atau fotografis. 

Kelompok media hasil teknologi cetak meliputi teks, grafik, foto, dan representasi 

fotografik. Materi cetak dan visual merupakan pengembangan dan penggunaan 

kebanyakan materi pengajaran lainnya. Teknologi ini menghasilkan materi dalam 
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bentuk salinan tercetak, contohnya buku teks, modul, majalah, hand-out, dan lain-

lain. 

b. Media hasil teknologi audio-visual 

Media hasil teknologi audio-visual menghasilkan atau menyampaikan 

materi dengan menggunakan mesin-mesin mekanis dan elektronik untuk 

menyajikan pesan-pesan audio dan visual. Contohnya proyektor film, televisi, 

video, dan sebagainya. 

c. Media hasil teknologi berbasis komputer 

Media hasil teknologi berbasis komputer merupakan cara menghasilkan atau 

menyampaikan materi dengan menggunakan sumber-sumber yang berbasis 

mikro-prosesor. Berbagai jenis aplikasi teknologi berbasis komputer dalam 

pengajaran umumnya dikenal sebagai computer-assisted instruction (pengajaran 

dengan bantuan komputer). 

d. Media hasil teknologi gabungan 

Media hasil teknologi gabungan adalah cara untuk menghasilkan atau 

menyampaikan materi yang menggabungkan beberapa bentuk media yang 

dikendalikan oleh komputer. Perpaduan beberapa teknologi ini dianggap teknik 

yang paling canggih. Contohnya: teleconference. 

Nana Sudjana dan Ahmad Rivai (2001:2) mengatakan bahwa media 

pembelajaran dapat mempertinggi proses belajar siswa dalam pembelajaran yang 

pada gilirannya diharapkan dapat mempertinggi hasil belajar yang dicapainya. 

Alasannya berkenaan dengan manfaat media pembelajaran dalam proses belajar 

siswa yakni :  
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a. Pembelajaran akan lebih menarik perhatian siswa sehingga dapat 

menumbuhkan motivasi belajar, 

b. Bahan pembelajaran akan lebih jelas maknanya sehingga akan lebih 

dipahami oleh para siswa dan memungkinkan siswa menguasai tujuan 

pembelajaran lebih baik,  

c. Metode mengajar akan lebih bervariasi, 

d. Siswa lebih banyak melakukan kegiatan belajar sebab tidak hanya 

mendengarkan uraian guru tetapi juga aktivitas lain seperti mengamati, 

melakukan, mendemonstrasikan dan lain-lain. 

5. E-Learning  

Kemajuan teknologi informasi dan komunikasi saat ini memberikan banyak 

kemudahan dan kemungkinan dalam membuat suatu perancangan dan 

pengembangan sistem pendidikan, khususnya konsep dan model pembelajaran 

online atau bayak yang menyebutkannya dengan E-Learning. 

Horton dalam bukunya E-Learning Tools and Technologies (2003) :  

E-Learning adalah segala pemanfaatan atau penggunaan teknologi internet 

dan web untuk menciptakan pengalaman belajar. E-Learning dapat dipandang 

sebagai suatu pendekatan yang inovatif untuk dijadikan sebuah desain media 

penyampaian yang baik, terpusat pada pengguna, interaktif dan sebagai 

lingkungan belajar yang memiliki berbagai kemudahan-kemudahan bagi siapa 

saja, dimana saja dan kapan saja. Dengan memanfaatkan berbagai atribut dan 

sumber teknologi digital dengan bentuk lain dari materi dan bahan pembelajaran 

yang sesuai untuk diterapkan pada suatu lingkungan belajar yang terbuka, 

fleksibel dan terdistribusi. 

 

E-Learning adalah pembelajaran yang menggunakan TIK untuk 

mentransformasikan proses pembelajaran antara pendidik dan peserta didik. 

Tujuan utama penggunaan teknologi ini adalah meningkatkan efisiensi dan 
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efektivitas, transparansi, dan akuntabilitas pembelajaran. Di samping itu, suatu  E-

Learning juga harus mempunyai kemudahan bantuan profesional isi pelajaran 

secara on line. Dari uraian tersebut jelas bahwa E-Learning menggunakan 

teknologi informasi dan komunikasi sebagai alat; dengan tujuan meningkatkan 

efisiensi, efektivitas, transparansi, akuntabilitas, dan kenyamanan belajar; dengan  

obyeknya adalah layanan pembelajaran yang lebih baik, menarik, interaktif, dan 

atraktif. Hasil akhir yang diharapkan adalah peningkatan prestasi dan kecakapan 

akademik peserta didik serta pengurangan biaya, waktu, dan tenaga untuk proses 

pembelajaran (Budi Murtiyasa, 2012).  

a. E-Learning sebagai salah satu bentuk alat pendukung SCL (Student 

Centered Learning) 

1) Definisi SCL 

Gibbs dalam tulisan Sparrow dkk (2000:114) menyatakan bahwa SCL 

adalah suatu metode pembelajaran dimana guru dan penyelenggara pendidikan 

memberikan otonomi dan kendali lebih besar kepada siswa untuk menentukan 

materi pelajaran, model pembelajaran dan cepat-lambat tahapan dalam 

pembelajaran. Hal tersebut akan sangat berharga dan bermanfaat sepanjang 

hidup siswa. Melaksanakan pembelajaran dengan menggunakan metode SCL 

berarti guru perlu membantu siswa untuk menentukan tujuan yang dapat 

dicapai, mendorong siswa untuk dapat menilai hasil belajarnya sendiri, 

membantu mereka untuk bekerja sama dalam kelompok, dan memastikan agar 

mereka mengetahui bagaimana memanfaatkan semua sumber belajar yang 

tersedia.  
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Jacobsen (2009:227) menyatakan bahwa yang menjadi fokus dalam 

metode ini adalah keterlibatan, inisiatif, dan interaksi sosial siswa dengan 

segenap pengalaman, perspektif, latar belakang, bakat, minat, kemampuan, 

dan kebutuhannya. Oleh karena itu, kegiatan pembelajaran harus dirancang 

sedemikian rupa agar (hampir) semua siswa yang berada di dalamnya dapat 

meraih kesuksesan. Berdasarkan pendapat diatas, disimpulkan bahwa metode 

pembelajaran SCL adalah metode yang menempatkan siswa sebagai pusat 

pembelajaran sehingga mendorong untuk belajar lebih aktif (active learning), 

di mana siswa memiliki tanggung jawab yang lebih dalam proses belajarnya. 

2) Desain Pembelajaran SCL 

Menurut Jacobsen (2009:230), desain atau strategi pembelajaran yang 

berpusat pada siswa meliputi pembelajaran kooperatif, diskusi dan 

pembelajaran yang berbasis masalah. Adapun desain pembelajaran SCL pada 

penelitian ini (Rt. Nuqi B-BPPT, 2006) adalah sebagai berikut : 

a) Constructivisme. Pada tahapan ini guru membantu dalam 

membangun pemahaman siswa dari pengalaman baru berdasarkan 

pengetahuan awal siswa. 

b) Cooperative Learning. Pembelajaran kooperatif sebagai lingkungan 

belajar dimana siswa bekerja dalam kelompok heterogen untuk 

menyelesaikan tujuan bersama. 

c) Problem Based Learning (PBL). Pembelajaran berbasis PBL 

diartikan sebagai rangkaian aktivitas pembelajaran yang menekankan 

proses penyelesaian masalah melalui diskusi kelompok. Dalam 
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pembelajaran, guru memberikan kekuasaan pada siswa untuk dapat 

mencari dan mendiskusikan informasi secara autonom dan dapat 

dipertanggungjawabkan. 

d) Presentation. Presentation adalah penyampaian informasi 

pengetahuan. Kegiatan ini dilakukan tiap kelompok tentang pokok 

bahasan masalah tertentu.  

e) Reflection. Pada tahapan ini guru me-review proses pembelajaran 

yang dilakukan serta siswa mencatat apa yang telah dipelajarinya. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2. Langkah-langkah penerapan SCL (Rt. Nuqi B- BPPT 2006)  
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a. E-Learning sebagai Media Pembelajaran  

E-Learning termasuk model pembelajaran yang berpusat pada peserta didik. 

Dengan ini, peserta didik dituntut mandiri dan bertanggung jawab terhadap proses 

pembelajarannya, sebab ia dapat belajar di mana saja, kapan saja, yang penting 

tersedia alatnya. E-Learning menuntut keaktifan peserta didik. Melalui E-

Learning, peserta didik dapat mencari dan mengambil informasi atau materi 

pembelajaran berdasarkan silabus atau kriteria yang telah ditetapkan pengajar atau 

pengelola pendidikan. Peserta didik akan memiliki kekayaan informasi, sebab ia 

dapat mengakses informasi dari mana saja yang berhubungan dengan materi 

pembelajarannya. Peserta didik  juga dapat berdiskusi secara online dengan 

pakar-pakar pada bidangnya, melalui e-mail atau chatting. Dengan demikian, jelas 

bahwa keaktifan peserta didik dalam E-Learning sangat menentukan hasil belajar 

yang mereka peroleh. Semakin ia aktif, semakin banyak pengetahuan atau 

kecakapan yang akan diperoleh.  

Dengan sistem semacam ini diharapkan bahwa hasil akhir proses belajar 

dengan E-Learning akan lebih baik, sebab tuntutan belajar tuntas (mastery 

learning) dapat dipenuhi. Peserta didik juga bebas mengakses bahan pembelajaran 

E-Learning dari mana saja ia suka. Bahan pembelajaran E-Learning yang 

dirancang dengan baik dan profesional akan memperhatikan dan menggunakan 

ciri-ciri multimedia. Artinya, dalam bahan pembelajaran tersebut di samping 

memuat teks, juga dapat memuat gambar, grafik, animasi, simulasi, audio, dan 

video. Pemilihan warna yang baik dan tepat juga akan meningkatkan penampilan 

di layar monitor. Hal ini menjadikan bahan pembelajaran  E-Learning menjadi 
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lebih menarik, berkesan, interaktif dan atraktif. Dari keadaan semacam ini 

memungkinkan peserta didik selalu ingat tentang apa yang dipelajari.  

Model pengembangan TIK di pendidikan dapat dilakukan dalam empat 

tahapan, yaitu emerging, applying, infusing, dan  transforming (Majumdar (2005) 

dalam Budi Murtiyasa (2012)). Emerging adalah tahap dimana semua insan 

pendidikan menjadi memiliki perhatian terhadap TIK. Hal ini ditandai dengan 

kebutuhan akan dukungan terhadap performa kerja.  Applying adalah tahapan 

dimana para insan pendidikan mulai belajar menggunakan TIK. Pada tahapan ini 

kebutuhan untuk meningkatkan kualitas pembelajaran tradisional dengan TIK 

mulai dirasakan sebagai suatu kebutuhan. Infusing adalah tahap dimana para insan 

pendidikan mulai mengetahui bagaimana dan kapan menggunakan TIK. Hal ini 

ditunjukkan dengan kemampuan menyediakan fasilitas belajar berbasis TIK bagi 

para peserta didik Akhirnya tahap transforming adalah secara spesifik dapat 

menggunakan TIK untuk membantu menyelesaikan tugas-tugas pembelajaran 

yang dihadapinya. Dengan TIK dapat diciptakan lingkungan belajar yang inovatif, 

sehingga merangsang peserta didik untuk berpikir dan berkreasi untuk 

memecahkan masalah.  

Menurut Sudirman Siahaan (2004) dalam Edhy Sutanta (2009), setidaknya 

ada tiga fungsi E-Learning terhadap kegiatan pembelajaran di dalam kelas 

(classroom instruction) : 

a. Suplemen (tambahan). Dikatakan berfungsi sebagai suplemen apabila 

peserta didik mempunyai kebebasan memilih, apakah akan memanfaatkan 

materi pembelajaran elektronik atau tidak. Dalam hal ini tidak ada 
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keharusan bagi peserta didik untuk mengakses materi. Sekalipun sifatnya 

opsional, peserta didik yang memanfaatkannya tentu akan memiliki 

tambahan pengetahuan atau wawasan. 

b. Komplemen (pelengkap). Dikatakan berfungsi sebagai komplemen 

apabila materi pembelajaran elektronik diprogramkan untuk melengkapi 

materi pembelajaran yang diterima peserta didik di dalam kelas. Sebagai 

komplemen berarti materi pembelajaran elektronik diprogramkan untuk 

melengkapi materi pengayaan atau remedial. Dikatakan sebagai pengayaan 

(enrichment), apabila kepada peserta didik yang dapat dengan cepat 

menguasai/ memahami materi pelajaran yang disampaikan pada saat tatap 

muka diberi kesempatan untuk mengakses materi pembelajaran elektronik 

yang memang secara khusus dikembangkan untuk mereka. Tujuannya agar 

semakin memantapkan tingkat penguasaan terhadap materi pelajaran yang 

telah diterima di kelas. Dikatakan sebagai program remedial, apabila 

peserta didik  yang mengalami kesulitan memahami materi pelajaran pada 

saat tatap muka diberikan kesempatan untuk memanfaatkan materi 

pembelajaran elektronik yang memang secara khusus dirancang untuk 

mereka. Tujuannya agar peserta didik semakin mudah memahami materi 

pelajaran yang disajikan di kelas. 

c. Substitusi (pengganti). Dikatakan sebagai substitusi apabila E-Learning 

dilakukan sebagai pengganti kegiatan belajar, misalnya dengan 

menggunakan model-model kegiatan pembelajaran. Ada tiga model yang 

dapat dipilih, yakni : (1) sepenuhnya secara tatap muka (konvensional), (2) 
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sebagian secara tatap muka dan sebagian lagi melalui internet, atau (3) 

sepenuhnya melalui internet.  

Kelebihan E-Learning menurut Elangoan (1999), Soekartawi (2002), 

Mulvihil (1997), Utarini (1997) dalam Asep Herman Suyanto 2005, antara lain 

tersedianya fasilitas e-moderating di mana guru dan siswa dapat berkomunikasi 

secara mudah melalui fasilitas internet secara regular atau kapan saja kegiatan 

berkomunikasi itu dilakukan dengan tanpa dibatasi oleh jarak, tempat dan waktu. 

Kedua, guru dan siswa dapat menggunakan bahan ajar atau petunjuk belajar yang 

terstruktur dan terjadual melalui internet, sehingga keduanya bisa saling menilai 

sampai berapa jauh bahan ajar dipelajari. Ketiga, dapat belajar atau me-review 

bahan ajar setiap saat dan di mana saja kalau diperlukan mengingat bahan ajar 

tersimpan di komputer. Bila siswa memerlukan tambahan informasi yang 

berkaitan dengan bahan yang dipelajarinya, ia dapat melakukan akses di internet 

secara lebih mudah. Baik guru maupun siswa dapat melakukan diskusi melalui 

internet yang dapat diikuti dengan jumlah peserta yang banyak, sehingga 

menambah ilmu pengetahuan dan wawasan yang lebih luas. Poin penting adalah 

bahwa peran siswa dari yang biasanya pasif menjadi aktif. 

Walaupun demikian pemanfaatan E-Learning juga tidak terlepas dari 

berbagai kekurangan (Bullen, 2001; Beam, 1997 dalam Asep Herman Suyanto 

2005), antara lain kurangnya interaksi antara guru dan siswa atau bahkan antar 

siswa itu sendiri. Kurangnya interaksi ini bisa memperlambat terbentuknya values 

dalam proses belajar dan mengajar. Kecenderungan mengabaikan aspek akademik 

atau aspek sosial dan sebaliknya mendorong tumbuhnya aspek komersial. Proses 
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belajar dan mengajarnya cenderung ke arah pelatihan daripada pendidikan. 

Berubahnya peran guru dari yang semula menguasai teknik pembelajaran 

konvensional, kini juga dituntut mengetahui teknik pembelajaran yang 

menggunakan ICT. Kemudian, tidak semua tempat tersedia fasilitas internet dan 

kurangnya tenaga yang mengetahui dan memiliki keterampilan internet. 

Kehadiran guru sebagai makhluk yang hidup yang dapat berinteraksi secara 

langsung dengan para murid telah menghilang dari ruang-ruang elektronik E-

Learning ini. Inilah yang menjadi ciri khas dari kekurangan E-Learning yang 

tidak bagus. Sebagaimana asal kata dari E-Learning yang terdiri dari e 

(elektronik) dan learning (belajar), maka sistem ini mempunyai kelebihan dan 

kekurangan. 

b. Perbandingan antara pembelajaran konvensional dengan 

pembelajaran E-Learning  

Perbedaan pembelajaran konvensional dengan E-Learning yaitu pada 

pembelajaran konvensional, guru dianggap sebagai orang yang serba tahu dan 

ditugaskan untuk menyalurkan ilmu pengetahuan kepada peserta didiknya. 

Sedangkan di dalam E-Learning fokus utamanya adalah pelajar. Pelajar mandiri 

pada waktu tertentu dan bertanggung jawab untuk pembelajarannya. Suasana 

pembelajaran E-Learning akan memaksa pelajar memainkan peranan yang lebih 

aktif dalam pembelajarannya. Pelajar membuat perancangan dan mencari materi 

dengan usaha dan inisiatif sendiri. Menurut Reza Syaeful (2007) dalam Ade 

Suyitno (2012), perbedaan pembelajaran E-Learning dengan metode pengajaran 

konvensional adalah :  
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Tabel 1. Perbedaan Pembelajaran Konvensional dan E-Learning 

Pembelajaran Konvensional Pembelajaran E-Learning 

Pengajar memainkan peran dalam 

memotivasi dan membimbing pelajar  

Bergantung pada motivasi diri pelajar  

Tes dan ujian dilakukan sesuai jadwal 

yang telah ditentukan secara umum  

Tes dan ujian dilakukan sesuai dengan 

kecepatan daya tangkap si pelajar  

Laboratorium tersedia dalam 

melakukan kegiatan tes dan 

eksperimen praktek  

Metode inovatif diperlukan untuk 

mengadakan tes dan eksperimen 

praktek  

Institusi memiliki kalender dan durasi 

tetap bagi tiap mata pelajaran  

Durasi mata pelajaran ditentukan oleh 

pelajar  

Kegiatan belajar dibatasi pada 

mereka yang bersekolah di institusi 

tersebut  

Lebih sukses dalam jumlah pelajar 

yang mengikuti pembelajaran online  

 

6. Mata Pelajaran Teknologi Informasi dan Komunikasi (TIK) 

Sekolah Menengah Atas (SMA) sebagai salah satu lembaga pendidikan 

menengah perlu membekali siswa dan lulusannya dengan keterampilan yang 

memadai termasuk kompetensi TIK. Menurut kurikulum Tahun 2004 tentang 

Standar Kompetensi Mata Pelajaran TIK SMA dan MA, tujuan khusus 

mempelajari TIK adalah :  

a. menyadarkan siswa akan potensi perkembangan TIK yang terus berubah 

sehingga siswa termotivasi untuk mengevaluasi dan mempelajari TIK 

sebagai dasar untuk belajar sepanjang hayat,  

b. memotivasi kemampuan siswa untuk bisa beradaptasi dan mengantisipasi 

perkembangan Teknologi Informasi dan Komunikasi, sehingga siswa bisa 
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melaksanakan dan menjalani aktifitas kehidupan sehari-hari secara 

mandiri dan lebih percaya diri,  

c. mengembangkan kompetensi siswa dalam penggunaan TIK untuk 

mendukung kegiatan belajar, bekerja, dan berbagai aktifitas dalam aspek 

kehidupan sehari-hari,  

d. mengembangkan kemampuan belajar berbasis Teknologi Informasi dan 

Komunikasi, sehingga proses pembelajaran dapat lebih optimal, dan 

terampil dalam berkomunikasi, mengorganisasi informasi, belajar, dan 

bekerjasama,  

e. mengembangkan kemampuan belajar mandiri, berinisiatif, inovatif, kreatif 

dan bertanggungjawab dalam penggunaan TIK untuk pembelajaran, 

bekerja, dan pemecahan masalah.  

Tuntutan yang harus dilaksanakan oleh guru dan sekolah dalam pelaksanaan 

proses pembelajaran yang memanfaatkan teknologi informasi dan komunikasi 

menghadapi berbagai kendala yang kompleks. Masalah utama yang seringkali 

dihadapi oleh pihak sekolah dan guru adalah keterbatasan sumber daya, baik 

sumber daya fisik, sumber daya manusia maupun sumber belajar berbasis 

teknologi komputer dan telekomunikasi. 

Badan Penelitian dan Pengembangan Pusat kurikulum Depdiknas (2007) 

dalam Naskah Akademik Kajian Kebijakan Kurikulum Mata Pelajaran TIK 

menyatakan : 

a. Visi mata pelajaran Teknologi Informasi dan Komunikasi yaitu agar siswa 

dapat dan terbiasa menggunakan perangkat Teknologi Informasi dan 
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Komunikasi secara tepat dan optimal untuk mendapatkan dan memproses 

informasi dalam kegiatan belajar, bekerja, dan aktifitas lainnya sehingga 

siswa mampu berkreasi, mengembangkan sikap imaginatif, 

mengembangkan kemampuan eksplorasi mandiri, dan mudah beradaptasi 

dengan perkembangan baru di lingkungannya. 

b. Melalui mata pelajaran Teknologi Informasi dan Komunikasi diharapkan 

siswa dapat terlibat pada perubahan pesat dalam kehidupan yang 

mengalami penambahan dan perubahan dalam penggunaan beragam 

produk teknologi informasi dan komunikasi. Siswa menggunakan 

perangkat Teknologi Informasi dan Komunikasi untuk mencari, 

mengeksplorasi, menganalisis, dan saling tukar informasi secara efisien 

dan efektif. Dengan menggunakan Teknologi Informasi dan Komunikasi, 

siswa akan dengan cepat mendapatkan ide dan pengalaman dari berbagai 

kalangan. Penambahan kemampuan siswa karena penggunaan Teknologi 

Informasi dan Komunikasi akan mengembangkan sikap inisiatif dan 

kemampuan belajar mandiri, sehingga siswa dapat memutuskan dan 

mempertimbangkan sendiri kapan dan dimana penggunaan Teknologi 

Informasi dan Komunikasi secara tepat dan optimal, termasuk apa 

implikasinya saat ini dan dimasa yang akan datang. 

c. Teknologi Informasi dan Komunikasi (TIK) mencakup dua aspek, yaitu 

Teknologi Informasi dan Teknologi Komunikasi. Teknologi Informasi, 

meliputi segala hal yang berkaitan dengan proses, penggunaan sebagai alat 

bantu, manipulasi, dan pengelolaan informasi. Teknologi Komunikasi 
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merupakan segala hal yang berkaitan dengan penggunaan alat bantu untuk 

memproses dan mentransfer data dari perangkat yang satu ke lainnya. 

Karena itu, Teknologi Informasi dan Teknologi Komunikasi adalah suatu 

padanan yang tidak terpisahkan yang mengandung pengertian luas tentang 

segala kegiatan yang terkait dengan pemrosesan, manipulasi, pengelolaan, 

dan transfer (pemindahan) informasi antar media. 

d. Secara khusus, tujuan mempelajari Teknologi Informasi dan Komunikasi 

adalah : 

1) Menyadarkan siswa akan potensi perkembangan teknologi informasi 

dan komunikasi yang terus berubah sehingga siswa dapat termotivasi 

untuk mengevaluasi dan mempelajari Teknologi Informasi dan 

Komunikasi sebagai dasar untuk belajar sepanjang hayat. 

2) Memotivasi kemampuan siswa untuk bisa beradaptasi dan 

mengantisipasi perkembangan Teknologi Informasi dan Komunikasi, 

sehingga siswa bisa melaksanakan dan menjalani aktifitas kehidupan 

seharihari secara mandiri dan lebih percaya diri. 

3) Mengembangkan kompetensi siswa dalam menggunakan Teknologi 

Informasi dan Komunikasi untuk mendukung kegiatan belajar, bekerja, 

dan berbagai aktifitas dalam kehidupan sehari-hari. 

4) Mengembangkan kemampuan belajar berbasis Teknologi Informasi 

dan Komunikasi, sehingga proses pembelajaran dapat lebih optimal, 

menarik, dan mendorong siswa terampil dalam berkomunikasi, 

terampil mengorganisasi informasi, dan terbiasa bekerjasama. 
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5) Mengembangkan kemampuan belajar mandiri, berinisiatif, inovatif, 

kreatif, dan bertanggung jawab dalam penggunaan Teknologi 

Informasi dan Komunikasi untuk pembelajaran, bekerja, dan 

pemecahan masalah sehari-hari. Berdasarkan uraian yang telah 

disebutkan diatas, dapat disimpulkan bahwa Mata Pelajaran TIK 

adalah mata pelajaran yang baru di sekolah yang merupakan suatu 

padanan yang tidak terpisahkan yang mengandung pengertian luas 

tentang segala aspek yang terkait dengan pemrosesan, manipulasi, 

pengelolaan, dan transfer (pemindahan) informasi antar media 

menggunakan teknologi tertentu yang menekankan siswa mampu 

memahami konsep, pengetahuan, dan operasi dasar komputer. 

Siswa SMA masuk pada tahap perkembangan orang dewasa. Dalam 

tingkatan perkembangan ini, individu sudah dapat memecahkan segala persoalan 

secara logik, berfikir secara ilmiah, dapat memecahkan masalah-masalah verbal 

yang kompleks atau secara singkat sudah tercapai kematangan struktur 

kognitifnya. Pembelajaran yang diberikan kepada orang dewasa dapat efektif, 

bilamana guru tidak terlalu mendominasi kelompok kelas, mengurangi banyak 

bicara, namun mengupayakan agar individu orang dewasa itu mampu menemukan 

alternatif-alternatif untuk mengembangkan kepribadian mereka. Seorang guru 

yang baik harus berupaya untuk banyak mendengarkan dan menerima gagasan 

seseorang, kemudian menilai dan menjawab pertanyaan yang diajukan mereka. 

Orang dewasa dapat dibelajarkan lebih aktif apabila mereka merasa ikut 

dilibatkan dalam aktivitas pembelajaran, terutama apabila mereka dilibatkan 
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member sumbangan pikiran dan gagasan yang membuat mereka merasa berharga 

dan memiliki harga diri di depan sesama temannya (Agus Marsidi, 2007).  

7. Hasil Belajar  

a. Belajar 

Belajar adalah perubahan, relatif permanen pada perilaku, pengetahuan 

dan kemampuan berfikir yang diperoleh karena pengalaman. Pengalaman 

tersebut dapat diperoleh dengan adanya interaksi antara seseorang dengan 

lingkungannya (Sardiman, 2000). Sementara itu Spears (dalam Sardiman, 

2000) mengemukakan bahwa belajar adalah mengobservasi, membaca, 

meniru, mencoba sesuatu sendiri, mendengar, dan mengikuti perintah. 

b. Definisi Hasil Belajar 

Hasil belajar adalah kemampuan yang dimiliki siswa setelah ia 

menerima pengalaman belajar. Hasil belajar siswa pada hakikatnya adalah 

perubahan mencakup bidang kognitif, afektif dan psikomotoris berorientasi 

pada proses belajar mengajar yang dialami siswa (Nana Sudjana, 2005).  

Nana Sudjana (2005) mengatakan bahwa hasil belajar itu berhubungan 

dengan tujuan instruksional dan pengalaman belajar yang dialami siswa, 

sebagaimana yang ditunjukkan dalam bagan di bawah ini :  

 

 

Gambar 3. Hubungan Tujuan Instruksional, Pengalaman Belajar,  

dan Hasil Belajar  

Bagan ini menggambarkan unsur yang terdapat dalam proses belajar 

mengajar. Hasil belajar dalam hal ini berhubungan dengan tujuan instruksional 

b 

c a 

Tujuan Instruksional 

 

Pengalaman belajar 
Hasil belajar 
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dan pengalaman belajar. Adanya tujuan instruksional merupakan panduan 

tertulis akan perubahan perilaku yang diinginkan pada diri siswa (Nana 

Sudjana, 2005), sementara pengalaman belajar meliputi apa-apa yang dialami 

siswa baik itu kegiatan mengobservasi, mengobservasi, membaca, meniru, 

mencoba sesuatu sendiri, mendengar, mengikuti perintah (Spears dalam 

Sardiman, 2008). 

Sistem pendidikan nasional dan rumusan tujuan pendidikan; baik tujuan 

kurikuler maupun tujuan instruksional pada umumnya menggunakan 

klasifikasi hasil belajar Bloom yang secara garis besar membaginya menjadi 

tiga ranah, ranah kognitif, afektif, dan psikomotoris. Ranah kognitif berkenaan 

dengan hasil belajar intelektual yang terdiri dari enam aspek, yakni: 

knowledge (pengetahuan), comprehension (pemahaman), aplikasi, analisis, 

sintesis, dan evaluasi. Kedua aspek pertama disebut kognitif tingkat rendah 

dan keempat aspek berikutnya termasuk kognitif tingkat tinggi. Ranah afektif 

berkenaan dengan sikap yang terdiri dari lima aspek, yakni: penerimaan, 

jawaban atau reaksi, penilaian, organisasi, dan internalisasi. Ranah 

psikomotoris berkenaan dengan hasil belajar keterampilan dan kemampuan 

bertindak yang terdiri atas enam aspek, yakni: gerakan refleks, keterampilan 

gerakan dasar, kemampuan perseptual, keharmonisan atau ketepatan, gerakan 

keterampilan kompleks, dan gerakan ekspresif dan interpretatif (Sudjana, 

2005).  

Menurut Hamalik (2008:155), hasil belajar didefinisikan sebagai “suatu 

proses terjadinya perubahan tingkah laku pada diri siswa, yang dapat diamati 
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dan diukur dalam bentuk perubahan pengetahuan sikap dan ketrampilan”. 

Perubahan tersebut dapat diartikan terjadinya peningkatan dan pengembangan 

yang lebih baik dibandingkan dengan sebelumnya, misalnya dari tidak tahu 

menjadi tahu, sikap kurang sopan menjadi sopan, dan sebagainya. 

Hasil belajar merupakan hasil kegiatan belajar siswa yang 

menggambarkan ketrampilan atau penguasaan siswa terhadap bahan ajar. 

Hasil belajar biasanya dinyatakan dengan nilai tes atau angka nilai yang 

diberikan oleh guru. Tes yang digunakan untuk menentukan hasil belajar 

merupakan suatu alat untuk mengukur aspek-aspek tertentu dari siswa. 

(Dimyati dan Mudjiono, 2009:256-259) 

Hasil belajar dalam pendidikan, khususnya dalam proses belajar 

mengajar mempunyai beberapa fungsi, seperti yang diungkapkan oleh W.S. 

Winkel, yang dikutip oleh Nana Sudjana (2004:142) sebagai berikut: 

1) Hasil belajar sebagai indikator kualitas dan kuantitas pengetahuan yang 

telah dikuasai anak didik. 

2) Hasil belajar sebagai lambang pemusatan hasrat keingintahuan. 

3) Hasil belajar sebagai bahan informasi dalam inovasi pendidikan. 

4) Hasil belajar sebagai indikator intern dan ekstern dari situasi institusi 

pendidikan. 

5) Hasil belajar dapat dijadikan indikator terhadap daya serap kecerdasan 

anak didik. 

Dari uraian di atas dapat disimpulkan bahwa hasil belajar adalah 

perubahan pada kognitif, afektif dan konatif sebagai pengaruh pengalaman 
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belajar yang dialami siswa baik berupa suatu bagian, unit, atau bab materi 

tertentu yang telah diajarkan. Dalam penelitian ini aspek yang di ukur adalah 

perubahan pada tingkat kognitifnya saja. 

Syaiful Bahri Djamarah (2003) menyatakan bahwa berhasil atau 

tidaknya seseorang dalam belajar disebabkan oleh faktor yang berasal dari 

dalam diri individu dan faktor dari luar individu.  

c. Jenis-jenis hasil belajar 

Bloom (dalam Yowanita Dwi Irwanti, 2011) membagi hasil belajar 

dalam tiga ranah, yakni ranah kognitif, ranah afektif dan ranah psikomotoris. 

1) Ranah kognitif 

Ranah ini berkenaan dengan hasil belajar intelektual yang terdiri dari 

enam aspek, yakni pengetahuan (knowledge), pemahaman, aplikasi, 

analisis, sintesis dan evaluasi.  

2) Ranah afekif 

Ranah afektif berkenaan dengan sikap dan nilai. Tipe hasil belajar 

afektif tampak pada siswa dalam berbagai tingkah laku seperti 

perhatiaannya terhadap pelajaran, disiplin, motivasi belajar, menghargai 

guru, kebiasaan belajar, dan hubungan sosial. 

3) Ranah psikomotoris 

Hasil belajar psikomotoris tampak dalam bentuk keterampilan (skill) 

dan kemampuan bertindak individu. 
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B. Penelitian yang Relevan 

Khasan Bisri. 2009. Efektivitas Penggunaan Metode Pembelajaran E-

Learning Berbasis Browser Based Training Terhadap Prestasi Belajar Siswa 

Pada Kompetensi Pemeliharaan/ Servis Transmisi Manual dan Komponen. UNS. 

Penelitian ini menggunakan metode ekperimen dengan pola randomized control-

group pretest-posttest design. Dalam rancangan ini mengambil dua kelompok 

(eksperimen dan kontrol) dari populasi tertentu. Kelompok eksperimen dikenai 

variabel perlakuan tertentu dalam jangka waktu tertentu, lalu kedua kelompok ini 

dikenai pengukuran yang sama, lalu dibandingkan hasilnya. Hasil belajar siswa 

yang diperoleh melalui selisih tes awal dan tes akhir kedua kelompok tersebut 

berbeda secara signifikan. Hal ini ditunjukkan dari hasil uji t yang diperoleh 

𝑡ℎ𝑖𝑡𝑢𝑛𝑔  = 0.0001 < 𝑡𝑡𝑎𝑏𝑒𝑙  = 0.05 yang berarti 𝐻𝑜  ditolak. Dengan penolakan 𝐻𝑜  ini 

berarti bahwa hasil belajar siswa pada kompetensi Pemeliharaan/ Service 

Transmisi Manual dan Komponen menggunakan metode pembelajaran Browser 

Based Training lebih baik dibandingkan dengan menggunakan metode 

konvensional.  

Kurnia Shinta Dewi. 2011. Efektivitas E-Learning Sebagai Media 

Pembelajaran Mata Pelajaran TIK Kelas XI di SMA Negeri Depok. Dalam 

penelitian ini menggunakan metode quasi eksperimental dengan menggunakan 

kelas eksperimen yang diberikan perlakuan pembelajaran E-Learning dan kelas 

lain sebagai kontrol yang diberikan pembelajaran konvensional. Dari hasil 

penelitian menunjukkan bahwa: 1) terdapat perbedaan prestasi mata pelajaran TIK 

di SMA Negeri 1 Depok yang diajarkan tanpa E-Learning dengan yang diajarkan 
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menggunakan E-Learning. Hal ini ditunjukkan dengan hasil uji Kolmogorov-

Smirnov = 2.066 dan sig < 0,05; 2). E-Learning efektif dapat meningkatkan 

prestasi siswa pada mata pelajaran TIK di SMA Negeri 1 Depok karena rata-rata 

peningkatan nilai mata pelajaran ini yang diajarkan dengan E-Learning lebih 

tinggi (7,5) dibanding dengan rata-rata peningkatan nilai yang diajar bukan 

dengan E-Learning (4,417). 

Tegar Pambuditama. 2010. Pengembangan Media Pembelajaran Berbasis 

E-Learning Untuk Meningkatkan Minat Siswa Terhadap Matematika (Pokok 

Bahasan Bangun Ruang SMA Kelas X Semester II). Universitas Muhammadiyah 

Surakarta. Penelitian dibatasi pada permasalahan media pembelajaran E-Learning 

menggunakan aplikasi blog pada pokok bahasan Bangun Ruang Kelas X SMA.  

C. Kerangka Berpikir  

Berdasarkan hasil kajian konsep teori hasil belajar dan hasil penelitian 

terdahulu yang relevan tentang penerapan media pembelajaran E-Learning serta 

analisis kebutuhan terhadap pentingnya kemandirian belajar dalam upaya 

meningkatkan keterampilan dan memperluas wawasan siswa SMA Negeri 1 

Kalasan, diidentifikasi bahwa pembelajaran TIK untuk materi perangkat lunak 

pembuat presentasi dengan media pembelajaran E-Learning dapat mempertinggi 

proses belajar siswa dalam pembelajaran yang pada gilirannya diharapkan dapat 

mempertinggi hasil belajar yang dicapainya. Pokok bahasan perangkat lunak 

pembuat presentasi dengan  media pembelajaran E-Learning dapat lebih menarik 

perhatian siswa sehingga dapat menumbuhkan motivasi belajar karena siswa tidak 

hanya mendengarkan uraian guru tetapi lebih banyak melakukan kegiatan belajar 
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seperti aktivitas mengamati, melakukan, mendemonstrasikan dan lain-lain. 

Ketertarikan  siswa terhadap pembelajaran perangkat lunak pembuat presentasi 

diharapkan dapat timbul karena penggunaan media pembelajaran yang lebih 

bervariasi yang nantinya akan menimbulkan motif untuk mencapai tujuan 

pembelajaran dan memotivasi siswa untuk meningkatkan hasil belajarnya. Bisa 

dipastikan bahwa ketika siswa dapat mengikuti pembelajaran secara aktif, maka 

kepahaman siswa terhadap materi tergolong tinggi, yang mana dapat 

meningkatkan hasil belajar siswa.  

Skema kerangka berpikir ditunjukkan pada gambar di bawah ini :  

 

 

 

 

 

 

Gambar 4. Kerangka berpikir dalam penelitian uji efektivitas 

D. Hipotesis  

Hipotesis yang diajukan dalam penelitian ini adalah : Efektivitas 

penggunaan media pembelajaran E-Learning berbasis web lebih tinggi daripada 

penggunaan media pembelajaran konvensional dalam meningkatkan hasil belajar 

siswa kelas X SMA Negeri 1 Kalasan pada mata pelajaran Teknologi Informasi 

dan Komunikasi.  
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BAB III 

METODOLOGI PENELITIAN 

 

A. Desain Penelitian  

1. Metode Penelitian  

Penelitian ini diarahkan sebagai pijakan dalam peningkatan hasil belajar 

siswa, yakni menitikberatkan pada sejauh mana efektivitas penggunaan E-

Learning dalam proses pembelajaran TIK di SMA dalam meningkatkan hasil 

belajar siswa tersebut.  

Dilihat dari tujuannya, penelitian ini termasuk bagian dari metode penelitian 

quasi experimental yang merupakan pengembangan dari metode true 

experimental. Yang dimaksud penelitian eksperimental yaitu penelitian yang 

dilakukan dengan memberikan perlakuan (treatment) tertentu terhadap subjek 

penelitian yang bersangkutan dengan menggunakan desain eksperimen Pretest-

Posttest Control Group Design. Kelompok eksperimen diberikan perlakuan 

penggunaan media pembelajaran E-Learning dan pada kelompok kontrol 

diberikan perlakuan konvensional yang diberlakukan di sekolah (media ceramah 

oleh guru). Rancangan penentuan sampel ini menggunakan teknik Random 

Sampling, dimana terdapat 7 kelas X SMA Negeri 1 Kalasan, dengan jumlah 224 

siswa.  

Tabel 2. Rencana Desain Penelitian Secara Umum 

Kelompok Pretest Perlakuan Posttest 

KE O1 X1 O2 

KK O3 X2 O4 
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 Keterangan :  

KE  :  Kelas eksperimen  

KK : Kelas kontrol  

O1  : Kemampuan kelas eksperimen sebelum diberi perlakuan  

O2 :  Kemampuan kelas eksperimen setelah diberi perlakuan  

O3 : Kemampuan kelas kontrol sebelum diberi perlakuan  

O4 : Kemampuan kelas kontrol setelah diberi perlakuan  

X1 :  Perlakuan dengan media pembelajaran E-Learning  

X2 : Perlakuan dengan media pembelajaran konvensional   

Sebelum diberi perlakuan, kedua kelompok kelas diberikan pretest terlebih 

dahulu, kemudian dilanjutkan dengan memberikan perlakuan pada masing-masing 

kelas. Setelah diberikan perlakuan pada masing-masing kelas, selanjutnya 

dilakukan posttest untuk mendapatkan nilai hasil belajar akhir yang kemudian 

akan dapat memperlihatkan efektivitas media E-Learning dan konvensional dalam 

meningkatkan hasil belajar siswa.  

2. Diagram Alur Penelitian  

Untuk lebih jelasnya mengenai alur penelitian yang dilakukan dapat dilihat 

pada flowchart di bawah ini :  
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Gambar 5. Diagram Alur Penelitian 
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Menurut Jacobsen, dkk (2009:230) desain atau strategi pembelajaran yang 

berpusat pada siswa meliputi pembelajaran kooperatif, diskusi dan pembelajaran 

yang berbasis masalah. Dalam penelitian ini, konsep SCL diterapkan 

menggunakan metode E-Learning dan disadur dari referensi e-book Rosenberg 

(2007:2).  

Bentuk perlakuan pembelajaran dengan penerapan media pembelajaran E-

Learning yang dilakukan dapat dilihat pada gambar berikut :  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6. Alur Penerapan E-Learning 
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Gambar 6 di atas menjelaskan tentang alur penerapan E-Learning dalam 

proses pembelajaran. Alur tersebut secara keseluruhan merupakan tahapan dalam 

Student Center Learning (SCL), dimana E-Learning merupakan salah satu bentuk 

SCL. SCL memiliki tahapan-tahapan constructivisme, cooperative learning, E-

Learning, memiliki referensi individu dan akhirnya akan membentuk budaya 

belajar mandiri.  

Pada tahap constructivisme, siswa diberikan 3 tahapan aktivitas yaitu 

pengulangan materi pelajaran sebelumnya, memotivasi siswa untuk pemanfaatan 

materi yang akan dipelajari dan membangun pemahaman materi sejak awal 

(berguna untuk meluruskan arah pemahaman saat proses pembelajaran).  

Tahapan kedua cooperative learning, siswa diperkenankan melakukan 

kegiatan kerjasama dengan teman dalam hal membuka E-Learning, log-in, 

mempelajari labsheet serta mengerjakan tugas praktek untuk membangun jiwa 

sosialnya. Dalam tahapan ini, saling membantu antar siswa dapat meningkatkan 

pemahaman akan aktivitas yang sedang siswa lakukan, karena kegiatan kerjasama 

yang dilakukan dengan sesama siswa melibatkan psikologi yang sama.  

Tahapan selanjutnya adalah metode inti E-Learning, meliputi 3 komponen 

penting strategi belajar untuk meningkatkan hasil belajar. Komponen pertama 

capture and creation of data adalah menyediakan link ke manajemen (sumber) 

pengetahuan sehingga siswa belajar mengakses link-link tersebut sebagai sumber 

belajar. Komponen kedua intelligent storage yakni mengelola kemampuan 

dengan lebih baik dan meningkatkan akses ke konten sumber belajar tersebut. 

Komponen ketiga dissemination and access practice merupakan tahap bimbingan 
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dan pembinaan untuk mengasah kemampuan yang diperolehnya dari tahapan 

sebelumnya. Siswa saling menyebarkan informasi ke sesama siswa sehingga bisa 

dijadikan latihan mengasah kemampuan untuk memanfaatkan ilmu yang sudah 

didapat. Pada komponen ketiga inilah guru berperan sebagai fasilitator.  

Apabila sudah melalui ketiga tahapan tersebut, selanjutnya siswa dapat 

mengakses link-link sumber belajar tersebut untuk dijadikan referensi individu 

yakni optimalisasi fasilitas internet yang selanjutnya akan terbentuk budaya 

belajar mandiri pada siswa. Secara keseluruhan, alokasi waktu untuk E-Learning 

sangat tertata dan terstruktur, sehingga dapat mengotimalkan proses belajar.  

Bentuk perlakuan pembelajaran konvensional pada sekolah bersangkutan :  

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 7. Alur Pembelajaran Konvensional 
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Gambar 7 menunjukkan alur pembelajaran konvensional yang diterapkan 

oleh sekolah. Proses pembelajaran diawali dengan pembukaan oleh guru, meliputi 

review materi pelajaran sebelumnya, presensi, dan memberikan kesempatan pada 

siswa untuk menilaikan tugas pekan sebelumnya. Setelah penilaian selesai, guru 

melanjutkan materi pelajaran dengan mendemonstrasikan tugas terlebih dahulu, 

kemudian siswa diberikan tugas yang sesuai dengan materi tersebut. Bagi siswa 

yang sudah menyelesaikan tugas, dapat menilaikan pada saat itu juga. Guru 

berkeliling mendatangi siswa untuk menilai sekaligus membantu siswa yang 

kesulitan dalam mengerjakan tugas. Ketika jam pelajaran selesai, guru 

menyampaikan kisi-kisi materi untuk pekan depan kemudian pembelajaran 

ditutup dengan doa. Apabila penilaian tugas belum selesai, dilanjutkan pada 

pembelajaran pekan selanjutnya.  

B. Definisi Operasional Variabel Penelitian  

Untuk menyatukan pandangan mengenai istilah dalam penelitian ini, maka 

batasan istilah dalam penelitian adalah sebagai berikut: 

1. Efektivitas 

Pengertian efektivitas dalam penelitian ini adalah tingkat keberhasilan yang 

dapat dicapai dari suatu cara atau usaha tertentu sesuai dengan tujuan 

pembelajaran yang telah direncanakan. Dalam hal ini efektivitas diukur dari hasil 

belajar yang diperoleh siswa, yang dilihat dari nilai pretest dan posttest terhadap 

tujuan pembelajaran, dimana setiap siswa mencapai nilai kriteria ketuntasan 

minimal (KKM) TIK ≥ 75. 
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2. Pembelajaran konvensional  

Pembelajaran konvensional yang dimaksud di sini adalah pembelajaran 

yang selama ini telah diterapkan oleh sekolah dalam menyampaikan pelajaran 

Teknologi Informasi dan Komunikasi. Kegiatan pembelajaran ini menggunakan 

media guru yang menyampaikan materi dengan ceramah dimana sesekali diselingi 

dengan presentasi powerpoint, tanpa terlalu melibatkan keaktifan siswa. Siswa 

hanya mengikuti apa yang guru contohkan kemudian mengerjakan tugas dan guru 

memberikan penilaian.  

3. Pembelajaran E-Learning  

Pembelajaran dengan media E-Learning adalah sistem pembelajaran di 

mana siswa diikutsertakan aktif dalam pembelajaran. Siswa memanfaatkan 

sumber belajar yang ada yaitu E-Learning yang di dalamnya mencakup materi 

pelajaran untuk di-eksplore sendiri oleh siswa, sedangkan guru berperan sebagai 

fasilitator dalam kegiatan pembelajaran tersebut.  

4. Hasil Belajar 

Hasil belajar adalah tingkat penguasaan individu terhadap materi 

pembelajaran sebagai akibat dari perubahan perilaku setelah mengikuti proses 

belajar mengajar berdasarkan tujuan pengajaran yang ingin dicapai. Hasil belajar 

pada penelitian ini hanya berkenaan dengan hasil belajar pada ranah kognitif yang 

akan diukur dengan tes. 
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C. Variabel Penelitian  

Variabel penelitian adalah suatu atribut atau sifat atau nilai dari orang, objek 

atau kegiatan yang mempunyai variasi tertentu yang ditetapkan oleh peneliti 

untuk dipelajari dan kemudian ditarik kesimpulannya (Sugiyono, 2012:61).  

Adapun variabel penelitian ada dua yaitu variabel bebas tentang media 

pembelajaran E-Learning dan konvensional, serta variabel terikat yaitu hasil 

belajar. Variabel dapat didefinisikan sebagai berikut : (1) media pembelajaran E-

Learning; (2) media pembelajaran konvensional; (3) hasil belajar siswa, bertujuan 

untuk mengetahui tingkat keberhasilan yang dicapai oleh siswa setelah mengikuti 

kegiatan pembelajaran. Dimana tingkat keberhasilan siswa ditandai selalu dengan 

skor, angka, kata atau huruf. Apabila tujuan utama kegiatan evaluasi hasil belajar 

ini sudah terealisasi, maka hasilnya dapat difungsikan dan ditujukan untuk 

diagnosis dan pengembangan, untuk seleksi, untuk kenaikan kelas dan untuk 

penempatan. 

D. Tempat dan Waktu Penelitian  

Penelitian ini dilakukan di SMA Negeri 1 Kalasan berlokasi di Bogem, 

Tamanmartani, Kalasan, Sleman Yogyakarta. Waktu penelitian ini dilaksanakan 

pada 16 Februari 2012 sampai dengan 5 Mei 2012.  

E. Populasi dan Sampel Penelitian  

Pada penelitian eksperimen murni kelompok subjek penelitian ditentukan 

secara acak, sehingga akan diperoleh kesetaraan kelompok yang berada dalam 

batas-batas fluktuasi acak. Namun, dalam dunia pendidikan khususnya dalam 

pembelajaran, pelaksanaan penelitian tidak selalu memungkinkan untuk 
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melakukan seleksi subjek secara acak, karena subjek secara alami telah terbentuk 

dalam satu kelompok utuh (naturally formed intact group), seperti kelompok 

siswa dalam satu kelas. Kelompok-kelompok ini juga sering kali jumlahnya 

sangat terbatas. Dalam keadaan seperti ini kaidah-kaidah dalam penelitian 

eksperimen murni tidak dapat dipenuhi secara utuh, karena pengendalian variabel 

yang terkait subjek penelitian tidak dapat dilakukan sepenuhnya, sehingga 

penelitian harus dilakukan dengan menggunakan intact group. Penelitian seperti 

ini disebut sebagai penelitian kuasi eksperimen (eksperimen semu). Jadi 

penelitian kuasi eksperimen menggunakan seluruh subjek dalam kelompok belajar 

(intact group) untuk diberi perlakuan (treatment), suatu produk atau intrumen 

penelitian (Tim Puslitjaknov, 2008). 

Rancangan penelitian Pretest-Postest Control Group Design digambarkan 

sebagai berikut: (1) Membagi unit percobaan atas dua kelompok. Kelompok satu 

yang menggunakan metode E-Learning web sebagai kelompok eksperimen dan 

kelompok kedua menggunakan media pembelajaran konvensional sebagai 

kelompok kontrol; (2) Memberikan tes awal untuk kedua kelompok dan hitung 

mean prestasi untuk masing-masing kelompok; (3) Memberikan perlakuan 

(treatment) dengan menggunakan media pembelajaran E-Learning pada 

kelompok eksperimen dan media pembelajaran konvensional untuk kelompok 

kontrol; (4) Memberikan tes akhir untuk kedua kelompok dan hitung mean 

prestasi masing-masing kelompok; (5) Menghitung selisih nilai rata-rata tes awal 

dan tes akhir (peningkatan hasil belajar) kedua kelompok kemudian 

membandingkan secara statistik.  
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Teknik sampling pada penelitian ini menggunakan Random Sampling. 

Sampel dari penelitian ini adalah siswa SMA Negeri 1 Kalasan Kelas X untuk 

mata pelajaran Teknologi Informasi dan Komunikasi diambil dua kelas secara 

acak. Untuk mengetahui keadaan lapangan dan menguatkan dalam pengambilan 

keputusan, dilakukanlah observasi dengan mengikuti pembelajaran di kelas dalam 

kondisi biasa (konvensional).  

F. Instrumentasi  

1. Instrumen Penelitian 

Menurut Sugiyono (2012:148) instrumen penelitian adalah sutu alat yang 

digunakan mengukur fenomena alam maupun sosial yang diamati. Suharsimi 

Arikunto (2010:192) menjelaskan bahwa instrumen penelitian adalah alat atau 

fasilitas yang digunakan oleh peneliti dalam mengumpulkan data agar 

pekerjaannya lebih mudah dan hasilnya lebih baik, lebih cermat, lengkap dan 

sistematis sehingga lebih mudah diolah. 

Berdasarkan uraian di atas dapat disimpulkan bahwa instrumen penelitian 

adalah suatu alat yang digunakan untuk mengukur dan mengumpulkan data dalam 

penelitian sehingga lebih mudah diolah. 

Berikut langkah-langkah menyusun instrumen: 

a. Menetapkan variabel 

Menetapkan sebuah obyek dalam penelitian yang memiliki ciri khusus 

serta memungkinkan untuk diobservasi dan diukur. 

b. Membuat definisi operasional variabel 
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Menjelaskan definisi dari kata-kata kunci yang terdapat dalam judul 

penelitian agar diperoleh kesamaan pengertian dan komunikasi ilmiah tanpa 

menimbulkan bias dan salah pengertian. 

c. Menyusun kisi-kisi instrumen 

Kisi-kisi instrumen diambil dari silabus kelas X semester 2 mata 

pelajaran TIK mengenai perangkat lunak pembuat presentasi. Kisi-kisi tes 

dibuat bentuk kolom sesuai metode garpu supaya runtut, dipaparkan dari hal 

yang lebih luas pengertiannya ke hal yang lebih sempit maknanya. Kisi-kisi 

instrumen soal tes terdapat pada lampiran 7.  

d. Menyusun instrumen 

Instrumen yang digunakan dalam penelitian ini adalah soal tes pilihan 

ganda. Soal tes disusun berdasarkan 10 komponen indikator pencapaian yang 

terdapat pada silabus kelas X semester 2 mata pelajaran TIK mengenai 

perangkat lunak pembuat presentasi. Macam tes dibuat dari yang mudah ke 

yang sulit untuk dapat menerapkan pemahaman yang runtut. Tipe soal tes 

meliputi klasifikasi pemahaman, hafalan dan penerapan.  

1) Tes awal (Pretest). Pada penelitian ini dilakukan tes awal (pretest). 

Pretest dilakukan untuk mengukur kemampuan awal subjek penelitian 

sebelum diberikan perlakuan. Tes yang diberikan untuk kedua kelas 

sampel harus sama. Soal tes yang diberikan merupakan instrumen 

penelitian yang disusun oleh peneliti yang sudah melalui proses uji coba 

instrumen dengan analisis uji validitas, reliabilitas, daya pembeda dan 

tingkat kesukaran soal.  
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2) Tes Akhir (Posttest). Tes akhir (posttest) dilakukan setelah perlakuan 

terhadap subjek diberikan. Tes akhir dilakukan pada kedua kelas sampel. 

Ini untuk melihat perbedaan hasil tes yang terjadi antara kelas kontrol 

dan kelas eksperimen dimana yang satu diberi perlakuan dan yang 

lainnya tidak. Soal tes yang diberikan pada posttest setara dengan soal 

pretest.  

e. Mengujicobakan instrumen 

Uji coba dilakukan dua kali, tes pertama adalah tes awal (pretest) yang 

digunakan untuk mengetahui kemampuan awal siswa dan tes yang kedua 

adalah tes akhir (posttest) yang digunakan untuk mengetahui perbedaan hasil 

setelah mendapatkan perlakuan (treatment) dari masing-masing kelompok 

yang berupa nilai hasil tes. Soal pretest dan posttest adalah setara, sehingga uji 

coba cukup dilakukan sekali untuk mengukur validitas dan reliabilitas 

instrumen tes.  

2. Uji Coba Instrumen 

a. Validitas 

Menurut Suharsimi Arikunto (2010:211), validitas adalah tingkat 

kevalidan suatu instrumen. Instrumen yang valid adalah instrumen yang 

mampu mengukur apa yang seharusnya diukur. Suatu Instrumen yang valid 

atau sahih mempunyai validitas tinggi. Sebaliknya, instrumen yang kurang 

valid berarti memilik validitas rendah.  

Mengingat pentingnya masalah validitas, para ahli telah banyak 

berupaya untuk mengkaji masalah validitas serta membagi validitas ke dalam 
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beberapa jenis. Menurut Sugiyono (2012:177) ada beberapa jenis validitas 

yaitu : 

1) Validitas konstrak (construct validity). Konstruk adalah kerangka dari 

suatu konsep, validitas konstruk adalah validitas yang berkaitan dengan 

konsep, validitas konstruk adalah validitas yang berkaitan dengan 

kesanggupan alat ukur dalam mengukur pengertian suatu konsep yang 

diukurnya. 

2) Validitas isi (content validity). Validitas isi berkaitan dengan 

kemampuan sutu instrumen mengukur isi (konsep) yang harus diukur. 

Ini berarti bahwa suatu alat ukur mampu mengungkap isi suatu konsep 

atau variabel yang hendak diukur. Misalnya tes mata pelajaran TIK, 

harus mampu mengungkapkan isi mata pelajaran tersebut dan demikian 

juga untuk hal-hal lainnya. 

3) Validitas eksternal. Validitas eksternal adalah validasi suatu instrumen 

dengan membandingkannya antara kriteria yang ada pada instrumen 

dengan fakta-fakta emperis yang terjadi di lapangan atau dengan 

instrumen pengukuran lainnya yang sudah valid dan reliabel dengan cara 

mengkorelasikannya, bila korelasinya signifikan maka instrumen 

tersebut mempunyai validitas eksternal.  

Dalam penelitian ini validitas yang digunakan adalah validitas isi. 

Validitas isi (content validity) dilakukan dengan menanyakan pendapat ahli 

(judgement expert) tentang kisi-kisi dan instrumen penelitian. Instrumen 

dalam penelitian ini adalah soal tes pilihan ganda. Soal tes disusun 
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berdasarkan 10 komponen indikator pencapaian yang terdapat pada silabus 

kelas X semester 2 mata pelajaran TIK mengenai perangkat lunak pembuat 

presentasi. Selanjutnya instrumen tes divalidasi kepada ahlinya guna 

mengetahui butir-butir soal tes tersebut sudah layak untuk mengukur hasil 

belajar efektivitas media pembelajaran E-Learning web pada mata pelajaran 

TIK. Validator tersebut yakni Masduki Zakaria M.T, Umi Rochayati, M.T dan 

Arief Budiman, S.Pd. selaku dosen UNY dan guru TIK SMA Negeri 1 

Kalasan yang ahli dalam bidang pengukuran dengan format penilaian yang 

sudah disediakan. Pakar inilah yang akan menetukan layak atau tidaknya 

instrumen tes untuk disebarkan ke subjek survey. Instrumen tersebut 

dinyatakan valid setelah dianalisis oleh pakar tersebut dan dinyatakan untuk 

bisa dijadikan sebagai instrumen penelitian untuk diuji di lapangan sebelum 

disebarkan pada subjek penelitian.  

Setelah divalidasi selanjutnya dilakukan perbaikan atau revisi untuk 

butir-butir soal yang belum layak. Para ahli akan memberikan keputusan: 

instrumen dapat digunakan tanpa perbaikan, ada perbaikan dan mungkin 

dirombak total. Jadi valid tidaknya instrumen ditentukan oleh pendapat ahli 

(judgement expert). Setelah instrumen dinyatakan valid oleh ahli kemudian 

diuji cobakan atau diaplikasikan dan hasilnya dianalisis (Sugiyono, 2012:177).  

Instrumen yang valid berarti alat ukur yang digunakan untuk 

mendapatkan data (mengukur) itu valid. Valid berarti instrumen tersebut dapat 

digunakan untuk mengukur apa yang seharusnya diukur (Sugiyono, 

2012:173). Lembar validasi untuk tes dibuat berdasarkan teori dan dipadukan 
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dengan contoh lembar validasi pada thesis Efektivitas Pembelajaran IPS 

Berbasis Teknologi Informasi Ditinjau dari Motivasi Belajar Siswa Kelas V 

SD Muhammadiyah Purwodiningratan 2 Yogyakarta oleh Ika Kurnia Yuliati, 

yang relevan dengan penelitian ini.  (selengkapnya lihat lampiran 3) 

b. Reliabilitas 

Uji reliabilitas dilakukan untuk memperoleh gambaran keajegan suatu 

instrumen penelitian yang akan digunakan sebagai alat pengumpul data. 

Reliabilitas berhubungan dengan masalah kepercayaan. Suatu tes dapat 

dikatakan mempunyai taraf kepercayaan yang tinggi jika tes tersebut dapat 

memberikan hasil yang tetap. Seandainya terjadi perubahan hasil, perubahan 

itu dapat dikatakan tidak berarti (Suharsimi Arikunto, 2010:213). Reliabilitas 

instrumen yang digunakan dalam penelitian ini dengan menghitung koefisien 

Cronbach berdasarkan data kelas ujicoba.  

G. Teknik Pengambilan Data 

Lokasi penelitian ini adalah SMA Negeri 1 Kalasan dengan sampel 

penelitian didasarkan pada teknik Random Sampling. Karena penelitian bertujuan 

untuk mengaplikasikan E-Learning berbasis web pada pembelajaran TIK di SMA, 

maka subjek penelitian yang dianggap mewakili populasi tersebut adalah siswa 

kelas X dari SMA Negeri 1 Kalasan dimana masih dalam tahap penyesuaian 

metode pembelajaran yang baru.  

Alasan pengambilan sampel tersebut adalah hadirnya E-Learning sebagai 

media baru dalam metode penyampaian pembelajaran akan menjadi hal baru yang 

membutuhkan pengadaptasian. Agar didapatkan kondisi psikologis yang 
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demikian, diambillah kelas X sebagai sampel yang secara psikologis masih dalam 

tahap adaptasi dengan teknologi pembelajaran tingkat Sekolah Menengah Atas.  

H. Teknik Analisis Data 

Instrumen tes yang baik dan benar dapat diperoleh dengan cara menguji 

coba dan menganalisis instrumen tersebut sebelum dipakai dalam pengambilan 

data. Adapun hal-hal yang dianalisis dari hasil uji coba instrumen sebagai berikut: 

1. Validitas Instrumen 

Sebuah tes dikatakan valid apabila tes tersebut mengukur apa yang hendak 

diukur (Suharsimi Arikunto, 2009:65). Untuk instrumen tes, validitas yang 

digunakan adalah validitas isi. Validitas isi instrumen mengacu pada sejauh mana 

item instrumen mencakup keseluruhan situasi yang ingin diukur. Validitas isi 

instrumen tes dapat diketahui dari kesesuaian instrumen tes tersebut dengan 

Standar Kompetensi dan Kompetensi Dasar. Instrumen tes dibuat kemudian 

dikonsultasikan dengan validator ahli yang berkompeten di bidang yang 

bersangkutan untuk memperoleh bukti validitas isi. Setelah dikoreksi oleh 

validator, instrumen tersebut direvisi berdasarkan masukan ahli. Instrumen yang 

sudah direvisi kemudian di uji cobakan pada kelas diluar sampel yang sudah 

pernah menerima pembelajaran yang akan diujikan, maka uji coba ini dilakukan 

pada kelas XC. 

Rumus yang digunakan untuk mengetahui validitas item adalah rumus 

Korelasi Pearson Product Moment sebagai berikut : 

rXY=
𝑁∑𝑋𝑌−(∑𝑋)(∑𝑌)

 {𝑁∑X2−  ∑X)2  {𝑁∑Y2−  ∑Y)2 
   (1) 
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Keterangan : 

rxy = koefisien korelasi 

X = skor item tes 

Y = jumlah skor item 

N = banyaknya peserta tes 

Untuk mengetahui kevalidan butir soal maka harga rhitung dibandingkan rtabel 

sesuai dengan jumlah responden. Jika rhitung > rtabel maka butir soal tersebut 

dinyatakan valid. 

2. Reliabilitas Instrumen 

Suatu tes dapat dikatakan mempunyai taraf kepercayaan (reliability) yang 

tinggi jika tes tersebut dapat memberikan  hasil yang tetap. Teknik analisis data 

untuk pengujian reliabilitas menggunakan rumus Kuder-Richardson ( K-R 20) 

yaitu sebagai berikut (Suharsimi Arikunto, 2009:101) : 

𝑟11 =
𝑛

𝑛−1
   

𝑠2 −∑𝑝𝑞

𝑠2   (2) 

Keterangan:  

r11 = reliabilitas tes secara keseluruhan 

p  = proporsi subjek yang menjawab item dengan benar 

q
  

= proporsi subjek yang menjawab item dengan salah  ( q= 1-p) 

∑ pq = jumlah hasil perkalian antara p dan q 

n  = banyaknya item 

S  = standar deviasi dan tes (standar deviasi adalah akar varians)  

Aplha-Cornbach merupakan salah satu koefisien reliabilitas yang paling 

sering digunakan. Skala pengukuran yang reliabel adalah yang memiliki nilai 
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Aplha-Cornbach  minimal 0,70 dimana tingkat reliabilitas dengan metode Aplha-

Cornbach diukur berdasarkan skala alpha 0 sampai dengan 1. Apabila skala 

tersebut dikelompokkan ke dalam lima kelas yang sama, maka pada (Triton P. B, 

2006: 248) ukuran kemantapan alpha dapat diinterpretasi seperti tabel berikut: 

Tabel 3. Tingkat Reliabilitas 

Alpha Tingkat Reliabilitas 

0,00 ≤ r11 < 0,20 

0,20 ≤ r11 < 0,40 

0,40 ≤ r11 < 0,60 

0,60 ≤ r11 < 0,80 

0,80 ≤ r11 ≤ 1,00 

Sangat rendah 

Rendah 

Cukup 

Tinggi 

Sangat Tinggi 

 

3. Tingkat Kesukaran 

Perhitungan tingkat kesukaran soal adalah pengukuran seberapa besar 

derajat kesukaran suatu soal. Jika suatu soal memiliki tingkat kesukaran seimbang 

(proporsional), maka dapat dikatakan bahwa soal tersebut baik. Suatu soal tes 

hendaknya tidak terlalu sukar dan tidak pula terlalu mudah. Rumus yang 

digunakan untuk menghitung tingkat kesukaran (Suharsimi Arikunto, 2009:208) : 

𝑃 =  
𝐵

𝐽𝑆
         (3) 

Keterangan : 

P  = indeks tingkat kesukaran 

B  = jumlah siswa yang menjawab benar 

JS = jumlah seluruh siswa peserta tes  
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Tabel 4. Klasifikasi Indeks Kesukaran 

Nilai Indeks Kesukaran Tingkat Kesukaran 

0,00<= P < = 0,30 

0,31 <= P <= 0,70 

0,71 <= P <= 1,00 

Sukar 

Sedang 

Mudah 

 

4. Daya Pembeda 

Daya pembeda soal adalah kemampuan suatu soal untuk membedakan 

antara siswa yang pandai (berkemampuan tinggi) dengan siswa yang bodoh 

(berkemampuan rendah). Rumus yang digunakan sebagai berikut: 

 

𝐷 =
𝐵𝐴

𝐽𝐴
−

𝐵𝐵

𝐽𝐵
= 𝑃𝐴 − 𝑃𝐵          (4) 

 

Keterangan : 

D = Daya Pembeda 

J  = Banyaknya siswa 

JA = Banyaknya siswa pada kelompok atas 

JB = Banyaknya siswa pada kelompok bawah 

BA = Banyak siswa kelompok atas yang menjawab soal dengan benar 

BB = Banyak siswa kelompok bawah yang menjawab dengan benar 

 

Menurut Arikunto (2009:218), hasil perhitungan dikonsultasikan atau 

disesuaikan dengan klasifikasi daya pembeda: 
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Tabel 5. Klasifikasi Daya Pembeda 

Nilai Tingkat Daya Pembeda 

0,00 ≤ D ≤ 0,20 

0,21 ≤ D ≤  0,40 

0,41 ≤ D ≤  0,70 

0,71 ≤ D ≤  1,00 

Negative 

jelek (poor) 

cukup (satisfactory) 

baik (good) 

sangat baik (excellent) 

sebaiknya dibuang saja. 

 

I. Teknik Pengolahan Data  

Untuk memberikan makna terhadap data yang telah terkumpul, maka 

dilakukan analisis dan interpretasi. Proses analisis itu sendiri dimulai dengan 

pengolahan data, dimulai dari data kasar hingga menjadi data yang lebih halus dan 

lebih bermakna atau biasa disebut dengan informasi.  

Data yang diperoleh dikelompokkan menjadi dua buah kelompok data, 

yakni data kualitatif dan data kuantitatif. Terhadap data kualitatif, yakni yang 

digambarkan dengan kata-kata atau kalimat yang diperoleh dari hasil observasi, 

proses pelaksanaan dan kuesioner survei, dipisahkan menurut kategori untuk 

memperoleh kesimpulan. Sedangkan data yang bersifat kuantitatif yang diperoleh 

dari hasil validasi serta hasil perlakuan, diproses dengan menggunakan statistika 

deskriptif, meliputi teknik-teknik perhitungan statistika deskriptif serta visualisasi 

seperti tabel, dan grafik.  

Dalam penelitian ini, penulis menggunakan teknik analisis data dengan 

pendekatan metode kuantitatif deskriptif. Dimana dalam pengolahan data secara 
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kuantitatif ini mengolah data hasil pretest dan posttest. Adapun langkah-langkah 

pengolahan datanya sebagai berikut :  

1. Pemberian Skor  

Skor untuk soal pilihan ganda ditentukan berdasarkan metode Right Only, 

yaitu jawaban benar diberi skor satu dan jawaban salah atau butir soal yang tidak 

dijawab diberi skor nol. Skor setiap siswa ditentukan dengan menghitung jumlah 

jawaban yang benar. Pemberian skor dihitung dengan menggunakan rumus : 

 

S = 
𝛴𝑅

𝐽𝑢𝑚𝑙𝑎 ℎ 𝑆𝑜𝑎𝑙  
 x Skor Maksimal  (5) 

Keterangan : 

S  = Skor Siswa 

R  = Jawaban siswa yang benar  

 

2. Pengolahan data skor hasil pretest dan posttest  

Pengolahan data skor hasil pretest dan posttest dianalisis dengan langkah 

sebagai berikut :  

a. Menghitung nilai rata-rata kelompok, minimum maksimum, standar 

deviasi dan varians dengan menggunakan program SPSS 16.0.  

b. Melakukan uji normalitas. Uji ini dilakukan untuk mengetahui apakah data 

dari masing-masing kelompok sampel berdistribusi normal atau tidak. 

Pengujian normalitas sebaran data dilakukan dengan cara membandingkan 

nilai Kolmogorov-Smirnov dan Probabilitas dengan nilai signifikansinya 

adalah 0,05.  
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Dengan dasar pengambilan keputusan bahwa :  

P dari koefesien K-S > ∝(0.05), maka data berdistribusi normal 

P dari koefesien K-S < ∝(0.05), maka data tidak berdistribusi normal  

Perhitungan dalam pengujian normalitas sebaran data ini menggunakan 

program SPSS 16.0 for Windows. 

c. Melakukan uji homogenitas. Uji ini dilakukan untuk mengetahui apakah 

data dari masing-masing kelompok sampel mempunyai varians yang sama 

atau berbeda. Untuk menguji homogenitas digunakan uji Levene dengan 

taraf signifikansi 5% dengan menggunakan program SPSS 16.0.  

Kriteria pengujian : 

Jika nilai signifikansi P > ∝(0.05), maka homogen 

Jika nilai signifikansi P < ∝(0.05), maka tidak homogen  

d. Melakukan uji kesamaan dua rata-rata. Uji kesamaan dilakukan untuk 

mengetahui apakah terdapat kesamaan antara rata-rata nilai pretest 

perolehan dari kelas kontrol dan kelas eksperimen sebelum dilakukan 

pembelajaran. Uji ini dilakukan jika data berdistribusi normal dan 

homogen, maka dilakukan uji T dengan bantuan program SPSS 16.0, 

dengan taraf signifikansi 5%.  

1) Jika data berdistribusi normal dan homogen, maka digunakan uji t 

dengan statistik Independent Sample T-Test menggunakan equal 

variances assumed.  
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2) Jika data berdistribusi normal dan tidak homogen, maka digunakan uji t 

dengan statistik Independent Sample T-Test menggunakan equal 

variances not assumed. 

3) Jika data berdistribusi normal atau salah satu dari kedua data tersebut 

tidak berdistribusi normal dan tidak homogen, maka digunakan uji 

statistik non-parametrik Mann-Whitney.  

e. Pengujian hipotesis dan hasilnya akan digunakan sebagai acuan penarikan 

kesimpulan.  

Hipotesis yang diajukan dalam penelitian ini adalah : Efektivitas 

penggunaan media pembelajaran E-Learning berbasis web lebih tinggi 

daripada penggunaan media pembelajaran konvensional dalam 

meningkatkan hasil belajar siswa kelas X SMA Negeri 1 Kalasan pada 

mata pelajaran Teknologi Informasi dan Komunikasi.  

Kriteria Uji : 

Independent Sample T-Test : 

Jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  ≤ 𝑡𝑡𝑎𝑏𝑒𝑙 , maka 𝐻𝑜  diterima  

Jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  > 𝑡𝑡𝑎𝑏𝑒𝑙 , maka 𝐻𝑜  ditolak  

Berdasarkan signifikansi :  

Jika signifikansi (P) < 0.05, maka 𝐻𝑜  ditolak 

Jika signifikansi (P) > 0.05, maka 𝐻𝑜  diterima  

Sesuai dengan kriteria pengujian, jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  ≤ 𝑡𝑡𝑎𝑏𝑒𝑙  dan P > 0.05 

maka 𝐻𝑜  diterima. Namun, jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  > 𝑡𝑡𝑎𝑏𝑒𝑙  dan P < 0.05 maka 𝐻𝑜  

ditolak dan 𝐻𝑎  diterima yang berarti efektivitas pembelajaran TIK dengan 
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menggunakan media pembelajaran E-Learning lebih tinggi daripada 

menggunakan media pembelajaran konvensional. Penentuan efektivitas 

media pembelajaran E-Learning terhadap hasil belajar siswa dilakukan 

dengan uji t dengan interval kepercayaan 95 % α = (1 - 0,95) = 0.05. 

Proses perhitungan keseluruhan pengolahan data statistik menggunakan 

program Microsoft Excel 2007 dan SPSS 16.0 for Windows. 

Mann-Whitney  

Jika signifikansi (P) < 0.05, maka 𝐻𝑜  ditolak  

Jika signifikansi (P) > 0.05, maka 𝐻𝑜  diterima  

Sesuai dengan kriteria pengujian, jika P < 0.05, maka 𝐻𝑜  ditolak. 

Namun, jika P > 0.05, maka 𝐻𝑜  diterima dan 𝐻𝑎  yang ditolak, yang berarti 

efektivitas penggunaan media pembelajara E-Learning pada mata 

pelajaran TIK lebih rendah atau sama dengan menggunakan media 

pembelajaran konvensional.  

3. Analisis Data Indeks Gain  

 Efektivitas media pembelajaran E-Learning pada mata pelajaran TIK 

dapat dianalisis dengan cara mengadaptasi teori Hake mengenai gain 

ternormalisasi. Gain adalah selisih antara nilai posttest dan pretest. Gain 

menunjukkan peningkatan pemahaman atau penguasaan konsep siswa setelah 

proses pembelajaran. Menurut Hake (1999), nilai gain ternormalisasi dirumuskan 

sebagai berikut :  

g = 
𝑆𝑘𝑜𝑟  𝑃𝑜𝑠𝑡𝑡𝑒𝑠𝑡 −𝑆𝑘𝑜𝑟  𝑃𝑟𝑒𝑡𝑒𝑠𝑡

𝑆𝑘𝑜𝑟  𝑀𝑎𝑘𝑠𝑖𝑚𝑢𝑚 −𝑆𝑘𝑜𝑟  𝑃𝑟𝑒𝑡𝑒𝑠𝑡
 (6) 
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Keterangan :  

g  = nilai gain ternormalisasi  

 Besar gain yang ternormalisasi ini diinterpretasikan untuk menyatakan 

kriteria gain ternormalisasi menurut Richard R. Hake (1999) :  

Tabel 6. Klasifikasi Nilai Gain 

Nilai g Interpretasi 

0.7 < g < 1 
Tinggi  

0.3 ≤ g ≤ 0.7  
Sedang 

0 < g < 0.3 
Rendah  
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BAB IV 

HASIL PENELITIAN DAN PEMBAHASAN 

 

Pada uraian bab ini akan dipaparkan tentang hasil uji coba instrumen, hasil 

penelitian, analisis data dan  pembahasan. Data yang diolah adalah hasil dari tes 

kognitif (pretest dan posttest). Penelitian dilakukan terhadap dua kelas, yaitu 

kelompok eksperimen (XA) dengan jumlah siswa 32 orang diberikan perlakuan 

dengan media pembelajaran E-Learning, sedangkan pada kelompok kontrol (XB) 

sebagai kelompok pembanding dengan jumlah siswa 29 orang diberikan 

perlakuan dengan media pembelajaran konvensional. Penelitian terhadap sampel 

dilakukan selama masing-masing empat kali pertemuan untuk 2 kompetensi dasar 

animasi transisi sederhana dan hyperlink pada presentasi Power Point 2007. 

Banyaknya pertemuan ini disesuaikan dengan standar kompetensi dan kompetensi 

dasar yang harus dicapai siswa. 

Data hasil penelitian yang digunakan adalah berbentuk skor pretest, skor 

posttest, dan skor gain. Skor gain diperoleh dari selisih antara skor pretest dan 

skor posttest baik siswa yang belajar dengan menggunakan media pembelajaran 

E-Learning maupun siswa yang belajar menggunakan media pembelajaran 

konvensional. 
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A. Analisis Data Uji Coba Instrumen  

1. Uji Validitas Butir Soal 

Tabel 7. Validitas Butir Soal 

 

𝒓𝒉𝒊𝒕𝒖𝒏𝒈 𝒓𝒕𝒂𝒃𝒆𝒍 Keterangan 

Soal 1 0.510 

 

0.413 

Valid  

Soal 2 0.773 Valid 

Soal 3 0.773 Valid 

Soal 4 0.510 Valid  

Soal 5 0.572 Valid 

Soal 6 0.491 Valid 

Soal 7 0.611 Valid  

Soal 8 0.528 Valid  

Soal 9 0.349 Tidak valid 

Soal 10 0.400 Tidak valid 

Soal 11 0.467 Valid  

Soal 12 0.663 Valid 

Soal 13 0.435 Valid 

Soal 14 0.441 Valid  

Soal 15 0.773 Valid  

Soal 16 0.356 Tidak valid 

Soal 17 0.422 Valid  

Soal 18 0.645 Valid  

Soal 19 0.205 Tidak valid 

Soal 20 0.544 Valid  

Soal 21 0.472 Valid 

Soal 22 0.436 Valid 

Soal 23 0.380 Tidak valid 

Soal 24 0.773 Valid  

Soal 25 0.162 Tidak valid 

Menentukan valid atau tidaknya butir soal adalah membandingkan hasil  

𝒓𝒉𝒊𝒕𝒖𝒏𝒈 dengan 𝑟𝑡𝑎𝑏𝑒𝑙  Product Moment. Dengan jumlah responden 24 menurut 

𝑟𝑡𝑎𝑏𝑒𝑙   N-1=23 dan taraf signifikansi = 5% maka 𝑟𝑡𝑎𝑏𝑒𝑙  = 0.413. Berdasarkan hasil 

dari 𝑟ℎ𝑖𝑡𝑢𝑛𝑔  tiap butir soal jika dibandingkan dengan 𝑟𝑡𝑎𝑏𝑒𝑙 , maka butir soal yang 

tidak valid adalah jika 𝑟ℎ𝑖𝑡𝑢𝑛𝑔< 𝑟𝑡𝑎𝑏𝑒𝑙 , yaitu pada butir soal ke- 9, 10, 16, 19, 23 

dan 25.  
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2. Uji Reliabilitas Soal 

Tabel 8. Reliabilitas Butir Soal 

Reliability Statistics 

Cronbach's Alpha 

Cronbach's Alpha 

Based on 

Standardized Items N of Items 

.879 .880 25 

Berdasarkan perhitungan dengan menggunakan program SPSS 16.0, 

diketahui bahwa soal yang dipergunakan untuk tes pertama dan tes kedua semua 

reliabel, yaitu nilai Cronbach > 0. 879.  

3. Indeks Kesukaran Butir Soal  

Tabel 9. Indeks Kesukaran Butir Soal 

Butir Soal Indeks Kesukaran Keterangan 

Soal 1 0.88 Mudah 

Soal 2 0.29 Sukar 

Soal 3 0.29 Sukar 

Soal 4 0.88 Mudah 

Soal 5 0.58 Sedang 

Soal 6 0.63 Sedang 

Soal 7 0.75 Mudah 

Soal 8 0.75 Mudah 

Soal 9 0.67 Sedang 

Soal 10 0.42 Sedang 

Soal 11 0.46 Sedang 

Soal 12 0.38 Sedang 

Soal 13 0.83 Mudah 

Soal 14 0.67 Sedang 

Soal 15 0.29 Sukar 

Soal 16 0.63 Sedang 

Soal 17 0.29 Sukar 

Soal 18 0.58 Sedang 

Soal 19 0.46 Sedang 

Soal 20 0.33 Sedang 

Soal 21 0.67 Sedang 

Soal 22 0.54 Sedang 

Soal 23 0.67 Sedang 

Soal 24 0.29 Sukar 

Soal 25 0.83 Mudah 
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Tabel di atas menandakan perhitungan dari rumus (3) dan menghasilkan 

informasi berupa jumlah soal yang tergolong mudah ada 6 soal, soal yang 

tergolong sedang ada 14 soal dan yang tergolong sukar ada 5 soal.  

4. Daya Pembeda  

Disebut kelompok kecil jika banyaknya testee berada di bawah 100 orang. 

Sedangkan jika jumlah testee di atas 100 orang dapat dikategorikan kelompok 

besar. Selanjutnya jika testee termasuk kelompok kecil maka penentuan kelompok 

atas dan kelompok bawah cukup dibagi menjadi dua bagian sama besar.  

Tabel 10. Daya Beda Antar Butir Soal 

 

 

 

 

 

 

 

 

 

 

 

Butir Soal Daya Beda Keterangan 

Soal 1 0.25 Cukup baik 

Soal 2 0.58 Baik 

Soal 3 0.58 Baik 

Soal 4 0.25 Cukup baik 

Soal 5 0.50 Baik 

Soal 6 0.42 Baik 

Soal 7 0.50 Baik 

Soal 8 0.50 Baik 

Soal 9 0.33 Cukup baik 

Soal 10 0.33 Cukup baik 

Soal 11 0.42 Baik 

Soal 12 0.58 Baik 

Soal 13 0.33 Cukup baik 

Soal 14 0.33 Cukup baik 

Soal 15 0.58 Baik 

Soal 16 0.25 Cukup baik 

Soal 17 0.42 Baik 

Soal 18 0.67 Baik 

Soal 19 0.25 Cukup baik 

Soal 20 0.50 Baik 

Soal 21 0.33 Cukup baik 

Soal 22 0.42 Baik 

Soal 23 0.33 Cukup baik 

Soal 24 0.58 Baik 

Soal 25 0.17 Tidak baik  
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Daya beda pada butir soal tes sudah memenuhi kriteria baik dan cukup baik 

dimana mengacu pada tabel 5, sehingga soal tes layak untuk digunakan.  

B. Analisis Data Hasil Penelitian  

Data pokok yang diperoleh dalam penelitian ini adalah data nilai hasil 

belajar siswa dalam mata pelajaran Teknologi Informasi dan Komunikasi (TIK) 

dengan menggunakan instrumen penelitian yang telah divalidasi dan reliabel. 

Sebelum melakukan pengujian hipotesis penelitian, terlebih dahulu akan 

dianalisis mengenai nilai rata-rata siswa, normalitas dan homogenitas yang 

diperoleh baik pada kelas eksperimen maupun pada kelas kontrol.  

1. Analisis Data Hasil Belajar Siswa  

Untuk melihat hasil belajar siswa sebelum dan sesudah diberi perlakuan 

(treatment), maka perlu dilakukan pengolahan dan analisis data terhadap skor 

pretest dan posttest. Rekapitulasi data ditunjukkan pada tabel berikut :  

Tabel 11. Rata-rata Skor Tes Hasil Belajar Siswa 

Nilai Kelas Eksperimen Kelas Kontrol 

Rata-rata pretest  67.03 67.31 

Rata-rata posttest 86.09 80.34 

Berdasarkan tabel di atas, dapat diketahui bahwa rata-rata skor pretest dan 

posttest pada kelas eksperimen adalah 67.03 dan 86.09. Sedangkan pada kelas 

kontrol diketahui rata-rata skor pretest dan posttest adalah sebesar 67.31 dan 

80.34. Dari data tersebut terlihat bahwa terdapat peningkatan hasil belajar siswa 

pada kelas eksperimen dan kontrol. Data lengkap dapat dilihat pada lampiran 4.  
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2. Data Hasil Pretest  

Analisis terhadap pretest dilakukan dengan tujuan mengukur kemampuan 

siswa sebelum menerima proses pembelajaran, atau dengan kata lain mengukur 

kemampuan awal yang dimiliki siswa dalam materi yang akan diajarkan. Berikut 

disajikan analisis statistik deskriptif skor pretest kelas eksperimen dan kelas 

kontrol dengan perhitungan menggunakan program SPSS 16.0.  

Tabel 12. Statistik Deskriptif Data Pretest 

Kelas 
N Mean  Min  Max  

Eksperimen  
32 67.03 47 79 

Kontrol  
29 67.31 32 89 

Berdasarkan data pada tabel di atas, terlihat bahwa rata-rata skor pretest 

kelas eksperimen adalah 67.03 dengan skor maksimum 79 dan skor minimum 47. 

Sedangkan rata-rata skor pretest kelas kontrol adalah 67.31 dengan skor 

maksimum 89 dan skor minimum 32.  

Gambar 8. Rata-rata nilai pretest kelas eksperimen dan kelas kontrol 
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Dengan deskripsi data tersebut serta memperhatikan grafik, dapat dilihat 

bahwa rata-rata skor pretest kelas eksperimen dan kelas kontrol perbedaannya 

tidak terlalu jauh. Akan tetapi, untuk melihat apakah perbedaan tersebut cukup 

berarti atau tidak maka akan dilakukan uji statistik.  

a. Uji Normalitas Data Pretest 

Setelah diketahui analisis statistik deskriptif skor pretest untuk kelas 

eksperimen dan kelas kontrol, langkah selanjutnya adalah melakukan uji 

normalitas terhadap skor pretest kedua kelas tersebut. Uji normalitas 

dilakukan untuk mengetahui apakah data berdistribusi normal atau tidak 

antara kelas kontrol dan kelas eksperimen. Pengujian normalitas dilakukan 

dengan statistik uji Kolmogorov-Smirnov dengan bantuan program SPSS 

16.0. Hasil uji normalitas untuk pretest diberikan pada tabel di bawah ini.  

Tabel 13. Hasil Uji Normalitas Data Pretest 

Kelas 
Z Sig.(P) ∝ Kesimpulan 

Eksperimen 
0.852 0.463  

0.05 
Normal 

Kontrol 
0.946 0.332 Normal 

Kriteria pengujian : 

Jika P > ∝(0.05), maka berdistribusi normal 

Jika P < ∝(0.05), maka tidak berdistribusi normal  

Berdasarkan perhitungan uji normalitas maka pada kelas eksperimen 

diperoleh P = 0.463 dan pada kelas kontrol diperoleh P = 0.332. Dengan 

membandingkan nilai ∝ = 0.05, maka untuk kelas eksperimen P = 0.463 > 
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∝(0.05) dan kelas kontrol P = 0.332 > ∝(0.05). Sehingga dapat 

disimpulkan bahwa untuk kedua data tersebut berdistribusi normal.  

b. Uji Homogenitas Data Pretest 

Setelah diketahui bahwa data pretest berdistribusi normal, maka 

langkah selanjutnya adalah melakukan uji homogenitas untuk mengetahui 

kesamaan varians antara skor pretest. Uji homogenitas varians dengan 

menggunakan SPSS 16.0. Hasil uji homogenitas untuk data pretest 

diberikan pada tabel di bawah ini.  

Tabel 14. Hasil Uji Homogenitas Data Pretest 

  Levene Statistic df1 df2 Sig. 

pretest Based on Mean 3.284 1 59 .075 

Based on Median 2.951 1 59 .091 

Based on Median and with 

adjusted df 
2.951 1 52.503 .092 

Based on trimmed mean 2.918 1 59 .093 

Kriteria pengujian : 

Jika nilai signifikansi (P) > ∝(0.05), maka homogen 

Jika nilai signifikansi (P) < ∝(0.05), maka tidak homogen  

Berdasarkan tabel di atas, pada pretest antara kelas eksperimen dan 

kelas kontrol diperoleh P = 0.075. Dengan membandingkan dengan nilai ∝ 

= 0.05, karena nilai untuk P(0.075) > ∝(0.05), maka dapat disimpulkan 

bahwa data tersebut berasal dari populasi dengan varians yang sama 

(homogen).  
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c. Uji Kesamaan Pretest Kelas Eksperimen dan Kelas Kontrol  

Persamaan kemampuan awal siswa antara yang mendapat perlakuan 

media pembelajaran E-Learning dan media konvensional dapat diketahui 

melalui pengujian terhadap rata-rata nilai pretest pada masing-masing 

kelas. Setelah dilakukan uji normalitas dan uji homogenitas data hasil 

pretest diketahui bahwa penyebaran skor pretest berdistribusi normal dan 

homogen sehingga untuk pengujian digunakan statistik uji parametrik, 

yaitu uji t. Uji t (Independent Samples T Test) dilakukan dengan bantuan 

program SPSS 16.0, dengan taraf signifikansi 5%.  

Tabel 15. Hasil Uji t Pretest 

Kelas  Df  Sig. (P) ∝ 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  𝑡𝑡𝑎𝑏𝑒𝑙  

Eksperimen  
 

59 

 

0.924 

 

0.05 

 

-0.096 

 

1.67165 

Kontrol  

Berdasarkan tabel di atas, ternyata diperoleh P = 0.924 dan  

𝑡ℎ𝑖𝑡𝑢𝑛𝑔 =-0.096. Dengan membandingkan nilai P(0.924) > ∝(0.05) dan  

𝑡ℎ𝑖𝑡𝑢𝑛𝑔  < 𝑡𝑡𝑎𝑏𝑒𝑙 , sehingga dapat disimpulkan bahwa tidak terdapat 

perbedaan yang signifikan antara nilai pretest kelas eksperimen dan 

kontrol. Hal itu berarti keadaan awal siswa kelas eksperimen dan kontrol 

sebelum pembelajaran mempunyai kemampuan yang sama.   
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3. Data Hasil Posttest 

Soal posttest diberikan di akhir rangkaian pembelajaran, untuk mengetahui 

pengetahuan siswa setelah mengikuti proses pembelajaran yang diberi perlakuan 

berupa penerapan media pembelajaran E-Learning.  

Tabel 16. Statistik Deskriptif Data Posttest 

Kelas  
N Mean  Min  Max  

Eksperimen  
32 86.09 74 100 

Kontrol  
29 80.34 63 100 

Berdasarkan  tabel di atas terlihat bahwa skor tertinggi posttest kelas 

eksperimen adalah 100, skor terendahnya adalah 74, skor rata-rata kelas adalah 

86.09 dengan standar deviasi sebesar 7.92448. Sedangkan skor tertinggi posttest 

kelas kontrol adalah 100 dan terendahnya adalah 63. Skor rata-rata kelas adalah 

80.34 dengan standar deviasi sebesar 8.66551.  

 

Gambar 9. Rata-rata nilai posttest kelas eksperimen dan kelas kontrol 
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Dengan deskripsi data tersebut serta memperhatikan grafik, dapat dilihat 

bahwa rata-rata skor posttest kelas eksperimen dan kelas kontrol perbedaannya 

agak jauh. Akan tetapi, untuk melihat apakah perbedaan tersebut cukup berarti 

atau tidak maka akan dilakukan uji statistik.  

a. Uji Normalitas Data Posttest  

Uji normalitas dilakukan untuk mengetahui data berdistribusi normal 

atau tidak antara kelas eksperimen dan kelas kontrol. Pengujian normalitas 

menggunakan statistik uji Kolmogorov Smirnov dengan bantuan program 

SPSS 16.0. Hasil uji untuk posttest diberikan pada tabel di bawah ini.  

Tabel 17. Hasil Uji Normalitas Data Posttest 

Kelas 
Z Sig.(P) ∝ Kesimpulan 

Eksperimen 
0.896 0.398  

0.05  
Normal  

Kontrol 
0.692 0.724 Normal  

Kriteria pengujian : 

Jika signifikansi (P) > ∝(0.05), maka berdistribusi normal 

Jika signifikansi (P) < ∝(0.05), maka tidak berdistribusi normal  

Berdasarkan perhitungan uji normalitas maka pada kelas eksperimen 

diperoleh P = 0.398 dan kelas kontrol diperoleh P = 0.724. Dengan 

membandingkan dengan nilai  ∝ = 0.05, maka diperoleh untuk kelas 

eksperimen P = 0.398  > ∝(0.05) dan untuk kelas kontrol P = 0.724  > 

∝(0.05). Sehingga dapat disimpulkan bahwa kedua data tersebut 

berdistribusi normal.  
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b. Uji Homogenitas Data Posttest 

Uji homogenitas dilakukan untuk mengetahui data mempunyai varians 

homogen atau tidak. Uji homogenitas varians menggunakan program SPSS 

16.0. Hasil uji homogenitas untuk data posttest diberikan pada tabel.  

Tabel 18. Hasil Uji Homogenitas Data Posttest 

  Levene Statistic df1 df2 Sig. 

posttest Based on Mean .108 1 59 .744 

Based on Median .042 1 59 .839 

Based on Median and with 

adjusted df 
.042 1 55.509 .839 

Based on trimmed mean .105 1 59 .747 

Kriteria pengujian : 

Jika nilai signifikansi (P) > ∝(0.05), maka homogen 

Jika nilai signifikansi (P) < ∝(0.05), maka tidak homogen  

Berdasarkan tabel di atas, nilai P posttest antara kelas eksperimen dan 

kelas kontrol diperoleh P = 0.744. Dengan menbandingkan dengan nilai ∝ = 

0.05, maka untuk P = 0.744 > ∝(0.05), sehingga dapat disimpulkan bahwa 

data tersebut berasal dari populasi dengan varians yang sama (homogen).  

c. Uji Perbedaan Posttest 2 Kelas Sampel (Uji Hipotesis) 

Setelah dilakukan uji normalitas dan uji homogenitas data dari hasil 

posttest diketahui bahwa penyebaran skor posttest kelas eksperimen dan 

kontrol berdistribusi normal sehingga untuk menguji perbedaan dua rerata 

posttest digunakan uji statistik parametrik uji t. Uji t (Independent Samples 

T Test) dengan bantuan program SPSS 16.0, dengan taraf signifikansi 5%.  
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Rumusan Hipotesis yang akan diuji :  

𝐻𝑜  

 

 

 

 

𝐻𝑎    

:  

 

 

 

 

:  

Efektivitas penggunaan media pembelajaran E-Learning berbasis 

web sama dengan penggunaan media pembelajaran konvensional 

dalam meningkatkan hasil belajar siswa kelas X SMA Negeri 1 

Kalasan pada pelajaran Teknologi Informasi dan Komunikasi. 

 

Efektivitas penggunaan media pembelajaran E-Learning berbasis 

web lebih tinggi daripada penggunaan media pembelajaran 

konvensional dalam meningkatkan hasil belajar siswa kelas X SMA 

Negeri 1 Kalasan pada pelajaran Teknologi Informasi dan 

Komunikasi. 

Hipotesis Statistiknya :  

𝐻𝑜  

𝐻𝑎    

:  

:  

 𝜇1 = 𝜇2 

 𝜇1 > 𝜇2 

Kriteria Uji Hipotesis Satu Pihak :  

Independent Sample T Test 

1. Jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  > 𝑡𝑡𝑎𝑏𝑒𝑙 , maka 𝐻𝑜  ditolak, 𝐻𝑎  diterima.   

2. Jika  𝑡ℎ𝑖𝑡𝑢𝑛𝑔  < 𝑡𝑡𝑎𝑏𝑒𝑙 ,  maka 𝐻𝑜  diterima, 𝐻𝑎  ditolak.   

Berdasarkan Signifikansi  

3. Jika P > ∝(0.05), maka 𝐻𝑜  ditolak, 𝐻𝑎  diterima.   

4. Jika P < ∝(0.05), maka 𝐻𝑜  diterima, 𝐻𝑎  ditolak.   

 



75 
 

Tabel 19. Hasil Uji t Posttest 

Kelas  
Df  Sig.( P) ∝ 𝑡ℎ𝑖𝑡𝑢𝑛𝑔  𝑡𝑡𝑎𝑏𝑒𝑙  

Eksperimen  
 

59 

 

0.006 

 

0.05 

 

2.870 

 

1.67165 

Kontrol  

Berdasarkan tabel di atas menunjukkan bahwa signifikansi (P) adalah 

0.006. Karena signifikansi P (0.006)<∝(0.05), 𝐻𝑎  diterima. Artinya dapat 

disimpulkan bahwa efektivitas pembelajaran TIK menggunakan media 

pembelajaran E-Learning lebih tinggi daripada menggunakan media 

pembelajaran konvensional.  

4. Hasil Analisis Data Gain 

Nilai gain didapat dari selisih nilai posttest dan nilai pretest. Karena hasil 

belajar merupakan hasil yang diperoleh siswa setelah pembelajaran, maka hasil 

belajar yang dimaksud yaitu adanya peningkatan yang dialami siswa. Untuk 

mengetahui efektivitas penggunaan media pembelajaran E-Learning pada kelas 

eksperimen dan penggunaan media pembelajaran konvensional pada kelas kontrol 

digunakan perhitungan gain ternormalisasi. Hasil dari perhitungan gain 

ternormalisasi (g) pada kelas eksperimen dan kontrol dapat dilihat pada tabel.  

Tabel 20. Hasil Indeks Gain Kelas Eksperimen dan Kontrol 

Kelas  
Pretest  Posttest  Gain  <g> Kriteria  

Eksperimen  67.03125 86.09375 19.0625 
0.54 Sedang  

Kontrol  67.31034 80.34483 13.0345 
0.30 Sedang  
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Berdasarkan data nilai pretest dan posttest pada kelas eksperimen, diperoleh 

nilai gain ternormalisasi kelas eksperimen sebesar 0.54 dan kelas kontrol sebesar 

0.30. Nilai tersebut diinterpretasikan ke dalam kriterium nilai <g>, diperoleh 

efektivitas media pembelajaran E-Learning di kelas eksperimen tergolong sedang.  

 

Gambar 10. Nilai gain kelas eksperimen dan kelas kontrol 

Jika dibandingkan nilai gain antara kelas eksperimen dengan kelas kontrol, 

dapat disimpulkan bahwa efektivitas penggunaan media pembelajaran E-Learning 

di kelas eksperimen lebih tinggi daripada kelas kontrol yang menggunakan media 

pembelajaran konvensional.  

C. Pembahasan Hasil Penelitian  

Hasil analisis data penelitian yang dibuktikan melalui analisis uji statistik 

dengan bantuan software SPSS 16.0 menunjukkan bahwa kemampuan awal siswa 

kelas kontrol dan kelas eksperimen adalah sama (homogen). Hal ini dapat dilihat 

dari nilai rata-rata hasil pretest kedua kelas dan dibuktikan dengan uji t untuk 
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melihat persamaan dua rata-rata. Hasilnya menunjukkan bahwa tidak terdapat 

perbedaan kemampuan awal antara kelas eksperimen dan kontrol. Hal ini wajar 

karena kedua kelas tersebut belum mendapatkan perlakuan dan materi belajar.  

Setelah proses pembelajaran dilaksanakan  dengan memberi perlakuan 

dengan media pembelajaran E-Learning pada kelas eksperimen dan perlakuan 

dengan media pembelajaran konvensional pada kelas kontrol, menunjukkan 

bahwa hasil belajar akhir kedua kelompok mengalami perbedaan. Perbedaan hasil 

belajar ditunjukkan oleh nilai rata-rata kelas eksperimen 86.09 sedangkan pada 

kelas kontrol 80.34. Dari nilai rata-rata posttest terlihat bahwa hasil belajar kelas 

eksperimen lebih tinggi dibandingkan kelas kontrol.  

Untuk mengetahui keefektifan penggunaan media pembelajaran E-Learning 

berbasis web pada kelas eksperimen dan penggunaan media pembelajaran 

konvensional juga digunakan perhitungan gain ternormalisasi. Hasil perhitungan 

tes dengan menggunakan gain ternormalisasi diperoleh nilai g untuk kelas kontrol 

adalah sebesar 0.30 sedangkan nilai g untuk kelas eksperimen adalah sebesar 

0.54. Berdasarkan nilai g di atas terlihat bahwa hasil belajar kelas eksperimen 

lebih tinggi dibandingkan kelas kontrol.  

Berdasarkan hasil penelitian yang dilakukan pada setiap pertemuan, di kelas 

eksperimen siswa dituntut untuk dapat berperan lebih aktif dalam memperoleh 

kesempatan membangun sendiri pengetahuannya sehingga memperoleh 

pemahaman yang mendalam serta dalam proses pembelajarannya lebih bervariatif 

seperti meng-upload, men-download maupun mendemonstrasikan hasil praktik 

belajarnya. Peningkatan hasil belajar yang diraih oleh kelas eksperimen 
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dikarenakan adanya suasana belajar di kelas yang lebih kondusif, aktif dan minat 

serta antusias siswa sangat terlihat dibandingkan pada kelas kontrol, terutama 

pada hal distribusi materi pembelajaran yang tidak terpusat hanya pada guru. 

Budaya belajar yang dikembangkan di kelas eksperimen adalah keaktifan siswa 

dalam membangun sendiri keingintahuannya, membangun karakter keinginan 

membantu teman yang kesulitan, serta pemanfaatan waktu yang bisa optimal di 

kelas karena kegiatan sudah terstruktur. Pada E-Learning terdapat kegiatan 

terstruktur untuk setiap pertemuan, sehingga siswa mampu memanajemen waktu 

belajar di kelas yang harapannya sejalan dengan mengoptimalkan fasilitas yang 

ada. Dengan demikian, keaktifan siswa dalam membangun sendiri 

pengetahuannya diharapkan dapat membantu siswa untuk lebih lama mengingat 

dan memahami materi pelajaran.  

Disamping hasil belajar siswa yang meningkat, kelebihan-kelebihan lain 

yang mendukung E-Learning efektif ditunjukkan dari beberapa indikator dalam 

proses pembelajaran, antara lain meningkatnya keaktifan siswa, baik dalam hal 

bertanya maupun mempresentasikan tugas yang telah diselesaikannya. Kelebihan 

lainnya adalah tugas siswa menjadi lebih variatif dan kreatif karena siswa 

memiliki sumber belajar yang luas sehingga memiliki referensi materi lebih 

banyak dibandingkan dengan siswa pada kelas kontrol yang tidak menggunakan 

media E-Learning. Keunggulan siswa yang menggunakan E-Learning adalah 

memiliki kemampuan lebih dalam berinteraksi dengan internet dan 

penggunaannya, misal paham tentang cara meng-upload tugas serta mengetahui 

link-link belajar untuk meningkatkan kreativitas dalam mengerjakan tugas.  
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Pelaksanaan pembelajaran pada kelompok eksperimen pada awalnya 

mengalami sedikit hambatan. Pembelajaran yang baru bagi guru dan siswa 

memerlukan waktu untuk penyesuaian. Tetapi hambatan-hambatan yang terjadi 

perlahan dapat dikurangi karena partisipasi aktif siswa dalam proses 

pembelajaran. Aktifitas di dalam kelas yang bervariatif dapat menambah 

semangat, motivasi, karakter berbagi, membantu dalam memecahkan masalah dan 

dapat menciptakan lingkungan belajar positif, sehingga pembelajaran menjadi 

lebih interaktif dan efektif. Seluruh uraian di atas menunjukkan bahwa secara 

umum pembelajaran TIK dengan menggunakan media pembelajaran E-Learning 

memberikan pengaruh yang berarti dan efektif dalam meningkatkan hasil belajar 

siswa kelas X SMA Negeri 1 Kalasan.  

D. Keterbatasan Penelitian  

Penelitian ini masih terdapat banyak kekurangan dari segi pelaksanaan 

teknis maupun dalam pengontrolan variabel, maka untuk peneliti selanjutnya 

diharapkan dapat mengatasi keterbatasan tersebut. Persiapan sebelum melakukan 

penelitian harus diperhatikan untuk menghasilkan output yang baik. Baik dari 

persiapan perangkat pembelajaran, instrumen, kondisi sampel serta kontrol 

variabel yang digunakan.  

E. Rekomendasi  

Berdasarkan pembahasan penelitian yang sudah dijelaskan di atas, dapat kita 

ketahui bahwa E-Learning dapat meningkatkan hasil belajar siswa. Oleh karena 

itu, sebaiknya sistem pembelajaran yang digunakan di sekolah adalah 
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menggunakan media pembelajaran E-Learning yang dirasa lebih tepat. Namun 

demikian, penerapan E-Learning di sekolah tidak mudah, karena kenyataannya 

adalah bahwa tidak semua guru memiliki kemampuan untuk mengoperasikan 

media pembelajaran E-Learning ini. Maka, rekomendasi untuk sekolah sebelum 

menerapkan E-Learning secara keseluruhan adalah melakukan beberapa tahapan, 

antara lain : 

1. Mengadakan pelatihan (workshop E-Learning) untuk memberikan asupan 

kompetensi mengenai operasional E-Learning, minimal 50% dari jumlah 

keseluruhan guru.  

2. Sekolah mewajibkan 50% dari jumlah keseluruhan guru yang mengikuti 

pelatihan tersebut untuk menggunakan E-Learning pada mata pelajaran yang 

diampu.  

3. Pengadaan pelatihan E-Learning dilakukan secara kontinyu untuk meng-

upgrade kemampuan guru sekaligus menjadi sarana penilaian perkembangan 

dalam menerapkan E-Learning di sekolah.  

Beberapa tahapan tersebut dapat dilakukan jika sekolah menginginkan 

penerapan E-Learning secara optimal. Setelah semua komponen sekolah terbiasa 

menggunakan E-Learning, maka kebiasaan tersebut dapat menjadi budaya belajar 

yang tepat untuk meningkatkan hasil belajar siswa. 
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BAB V 

KESIMPULAN DAN SARAN  

 

A. Kesimpulan  

Berdasarkan permasalahan, tujuan penelitian, hasil analisis dan pembahasan 

yang telah dipaparkan, maka dapat disimpulkan bahwa efektivitas penggunaan 

media pembelajaran E-Learning berbasis web lebih tinggi daripada menggunakan 

media pembelajaran konvensional. Hal ini ditunjukkan  oleh uji hipotesis posttest 

dan nilai gain ternormalisasi. Hasil uji hipotesis posttest dengan Uji t adalah P 

(0.006) < ∝ (0.05), sehingga 𝐻𝑜  yang berbunyi ‘Efektivitas penggunaan media 

pembelajaran E-Learning berbasis web sama dengan penggunaan media 

pembelajaran konvensional dalam meningkatkan hasil belajar siswa kelas X SMA 

Negeri 1 Kalasan pada mata pelajaran Teknologi Informasi dan Komunikasi’ 

ditolak dan 𝐻𝑎  ‘Efektivitas penggunaan media pembelajaran E-Learning berbasis 

web lebih tinggi daripada penggunaan media pembelajaran konvensional dalam 

meningkatkan hasil belajar siswa kelas X SMA Negeri 1 Kalasan pada mata 

pelajaran Teknologi Informasi dan Komunikasi’ diterima. Perhitungan nilai gain 

ternormalisasi antara kelas eksperimen juga lebih tinggi daripada kelas kontrol, 

yaitu nilai gain ternormalisasi kelas eksperimen g = 0.54 dan pada kelas kontrol g 

= 0.30.  

Melihat kesimpulan yang didapat dari penelitian ini, seharusnya sekolah 

menggunakan dan mengoptimalkan keberadaan E-Learning yang sudah ada 

tersebut, untuk meningkatkan hasil belajar siswa. Selain itu, sebaiknya sekolah 

menggunakan media pembelajaran E-Learning pada mata pelajaran yang lain 
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dengan karakteristik sesuai dengan mata pelajaran TIK yang mana sudah 

diujicobakan dan menghasilkan kesimpulan bahwa media pembelajaran E-

Learning efektif untuk meningkatkan hasil belajar siswa.  

 

B. Saran  

Berdasarkan hasil penelitian yang diperoleh, peneliti merekomendasikan 

beberapa hal untuk dijadikan bahan pertimbangan dan pemikiran antara lain ;  

1. E-Learning merupakan salah satu alternatif media pembelajaran interaktif 

yang mengembangkan sikap aktif, mandiri dan kreatif, maka sebaiknya media 

pembelajaran ini dapat digunakan untuk setiap materi TIK maupun mata 

pelajaran yang lain. Persiapan format penilaian keaktifan siswa juga sangat 

ditekankan demi menghasilkan data yang lengkap.  

2. Sebelum pelaksanaan pembelajaran menggunakan media ini, guru harus dapat 

mempersiapkan komponen pendukung, seperti rencana pembelajaran yang 

lebih sistematis agar lancar serta jelas apa yang akan dilakukan, kemudian 

materi serta tugas di dalam E-Learning harus sudah disediakan sebelum 

pembelajaran dimulai. 

3. Media pembelajaran E-Learning membutuhkan waktu ekstra dalam persiapan, 

sehingga sebelum memulai pembelajaran sebaiknya guru telah 

mempersiapkannya dengan sangat matang. Karena media ini digunakan oleh 

guru sepanjang pembelajaran.  

4. Pengkondisian belajar siswa ketika pembelajaran E-Learning berlangsung 

harus lebih diperhatikan karena siswa akan dituntut secara mandiri menggali 
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materi yang diajarkan secara lebih mendalam, sekaligus mengembangkan 

pengetahuan seluas mungkin.  

5. Untuk penelitian lebih lanjut, sebaiknya melakukan pengembangan sejenis 

tetapi dengan pokok bahasan yang berbeda, supaya dapat dilihat bahwa 

penerapan media pembelajaran E-Learning ini sangat sesuai untuk diterapkan 

pada materi apapun yang menuntut keterampilan praktek siswa.  

6. Fasilitas laboratorium komputer dan koneksi internet sebagai faktor 

pendukung penerapan pembelajaran ini harus memadai, agar efektivitas 

pembelajaran dapat terlaksana dengan baik. Proses pembelajaran dengan 

media E-Learning berbasis web sangat tergantung oleh adanya ketersediaan 

koneksi internet, sehingga ketika fasilitas jaringan internet terganggu, maka 

proses pembelajaran pun dapat terganggu.  
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FORMAT OBSERVASI 
PEMBELAJARAN DI KELAS DAN  

OBSERVASI PESERTA DIDIK  

NAMA MAHASISWA   
NO. MAHASISWA  
TGL. OBSERVASI   

: 
: 
:  

MAWAR RAMADHANI   
08520241028  
16 Februari 2012 

PUKUL  
TEMPAT PRAKTIK  
 
 
 
FAK/JUR/PRODI  

: 
: 
 
 
 
:  

10.00 – 12.00  
LABORATORIUM 
KOMPUTER SMA N 1 
KALASAN  
(KELAS XC)   
FT/PT. ELKA/PT. 
INFORMATIKA   

 
No Aspek yang diamati Deskripsi Hasil Pengamatan 

A Perangkat Pembelajaran   

1. Kurikulum Tingkat 
Satuan Pembelajaran 
(KTSP)  

Menggunakan Kurikulum Tingkat Satuan Pendidikan yang 
mengacu pada MGMP TIK Kabupaten Sleman, namun pada 
praktek penerapannya disesuaikan dengan kondisi sekolah.  

2. Silabus  Mengacu pada Kurikulum Departemen Pendidikan Kabupaten 
Sleman.  

3. Rencana Pelaksanaan 
Pembelajaran (RPP)  

Mengacu pada Silabus pada poin 2.  

B Proses Pembelajaran   

1. Membuka pelajaran  Dibuka dengan salam dan langsung melakukan presensi siswa 
(dipanggil satu per satu). Setelah itu guru me-review materi 
minggu lalu kepada siswa.  

2. Penyajian materi  Menggunakan LCD & layar, contoh ditampilkan pada layar. 
Melalui media viewer, guru menyajikan materi dengan 
menjelaskan tahap demi tahap.  

3. Metode pembelajaran  Ceramah dan praktek langsung. Guru menyampaikan konsep 
materi sedikit di awal dengan perumpamaan-perumpamaan dan 
model manual.  

4. Penggunaan bahasa  Indonesia-Jawa, disertai guyonan.  
 

5. Penggunaan waktu  Dijelaskan konsep materi beberapa menit di awal, dan beberapa 
menit kemudian memberikan contoh praktek, kemudian siswa 
diberi kesempatan untuk mencoba mempraktekkan. 

.  

6. Gerak  Gerak guru : leluasa, flexible, berulang kali kontrol komputer, dan 
aktivitas guru dipermudah dengan adanya pengelola lab yang 
membantu jalannya proses KBM dalam penggunaan komputer.  
 

7. Cara memotivasi siswa  - Memberikan tugas kemudian dinilai sebagai feedback 
nya 

- Guru keliling kelas untuk menilai tugas siswa. 
- Setelah ada siswa yang dapat menyelesaikan tugas 1, 

guru segera memberikan tugas 2. 
 

8. Teknik bertanya  Guru menanyakan kepada seluruh siswa mengenai cara 
membuat animasi yang baik. Teknik ini digunakan sebagai 
feedback mengenai aktivitas siswa.  
Untuk siswa sendiri, memungkinkan untuk bertanya sewaktu-
waktu dan tidak terbatas. Antar teman pun sangat 
memungkinkan untuk saling mengajari penyelesaian masalah.  
Siswa dengan bebas bergerak tanpa ada kontrol dari guru,  
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FORMAT OBSERVASI 
PEMBELAJARAN DI KELAS DAN  

OBSERVASI PESERTA DIDIK  

9. Teknik penguasaan 
kelas  

Guru menjelaskan dengan media viewer dan menjelaskan 
dengan suara yang dapat didengar oleh seluruh kelas. Sesekali 
guru mengucapkan kalimat ’coba perhatikan’ ketika suasana 
kelas kurang kondusif untuk menjelaskan.  

10. Penggunaan media  Dimaksimalkan dengan LCD dan layar sehingga tugas bisa 
diperagakan di layar sepanjang waktu.  
Jumlah komputer yang memadai kurang dari jumlah siswa, 
sehingga menyebabkan siswa jalan-jalan dan terkesan ricuh. 

11. Bentuk dan cara 
evaluasi  

Menjelaskan langsung kepada siswa yang kurang jelas (belum 
bisa menyelesaikan tugas). 
Guru berkeliling kelas untuk melihat hasil pekerjaan siswa dan 
mencatat evaluasi masing-masing siswa mengenai progress 
pekerjaannya.  

12. Menutup pelajaran  Sebelum pertemuan diakhiri, guru memberikan resume 
mengenai manfaat dan ilmu yang dipelajari pada pertemuan 
tersebut. Setelah itu guru juga mengingatkan bagi siswa yang 
belum selesai mengerjakan tugas, diwajibkan meneruskan pada 
pertemuan berikutnya.  
Guru mengakhiri pelajaran dengan mengucap selamat siang dan 
masih melayani siswa yang akan menilaikan tugasnya.  

C  Perilaku Siswa   

1. Perilaku siswa di dalam 
kelas  

- Sejak awal, kondisi kelas dan ketertiban siswa kurang 
terkondisikan.  

- Ketika di tengah KBM ada ’permohonan bantuan’ dari 
siswa kelas lain (bukti solidaritas) pun tidak meminta izin 
pada guru terlebih dahulu.  

- Siswa mulai semakin ricuh ketika jam pelajaran hampir 
habis dan tugas belum terselesaikan.  

- Selama pelajaran berlangsung, terlihat solidaritas antar 
kawan.  

- Guru tidak berusaha mengkondisikan, sehingga siswa 
berkreatifitas tanpa batas (siswa saling mengajari tetapi 
ada kecenderungan untuk ramai). 

- Banyak siswa yang membolos pelajaran ditunjukkan dari 
tidak adanya keterangan siswa yang absen.  

- Suasana kelas kurang aktif dan hasil belajar rendah.  
 

2. Perilaku siswa di luar 
kelas  

Perilaku siswa di luar kelas cukup baik dan berusaha 
menerapkan 4S (senyum sapa salam sopan), namun belum 
mencakup keseluruhan siswa.  

 
 
        Yogyakarta, 16 Februari 2012 

Menyetujui, 

Guru TIK,  

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa Penelitian, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
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Lampiran 2. Silabus  



       

SILABUS  TINGKAT  SATUAN  PENDIDIKAN 

TEKNOLOGI INFORMASI DAN KOMUNIKASI 

KELAS X 

 

Nama Sekolah  : SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi  Informasi dan Komunikasi 

Kelas / Semester  : X / 2 

Standar Kompetensi  : 1. Menggunakan Perangkat Lunak Pembuat Presentasi  

 

Kompetensi 

Dasar  

Materi 

Pembelajaran 

Kegiatan Pembelajaran Indikator Pencapaian Penilaian Alokasi 

Waktu 

(menit)  

Sumber / 

Bahan / Alat 

1.1. 

Menggunakan 

menu, ikon 

yang terdapat 

pada 

perangkat 

lunak pembuat 

presentasi  

 

 

 Kelebihan 

dan 

kekurangan 

berbagai 

paket 

aplikasi 

pembuat 

presentasi  

 Dasar-dasar 

pembuatan 

dokumen 

presentasi  

yang baik 

 Menu, ikon 

dan perintah 

dalam Office 

Power Point  

Tatap Muka :  

 Mendemonstrasikan 

cara membuka 

program pembuat 

presentasi  

 Mendemonstrasikan 

cara menampilkan 

menu dan ikon  

 Mendemonstrasikan 

cara menyembunyikan 

menu dan ikon 

Mandiri Terstruktur :  

 Menggali informasi 

manfaat program 

presentasi  

 Menggali informasi 

berbagai jenis program 

presentasi  

 Mencari visualisasi 

fungsi menu, tools, 

ikon 

 Menunjukkan beberapa 

menu, tools dan ikon 

sesuai dengan 

fungsinya  

 

 

 Membuka program 

pembuat presentasi  

 

 Mengidentifikasi 

fungsi menu, tools 

dan ikon dalam 

program presentasi  

 

 Tertulis  

 

 

 Hasil kerja 

praktek  

 

2 x 50   Fasilitas Help 

Program 

 Joe H, Office 

VP 8 in 1, Que 

Techmedia, 

2001  

 Internet  

 Labsheet  



       

Kompetensi 

Dasar  

Materi 

Pembelajaran 

Kegiatan Pembelajaran Indikator Pencapaian Penilaian Alokasi 

Waktu 

(menit)  

Sumber / 

Bahan / Alat 

1.2  Membuat 

presentasi 

teks dengan 

variasi tabel, 

grafik, 

gambar, 

diagram dan 

hyperlink  

 

 Fungsi menu 

dan ikon 

serta 

perintah 

dalam 

aplikasi 

office 

powerpoint  

 Membuat 

media 

presentasi 

dengan 

variasi tabel, 

grafik, 

gambar dan 

diagram  

Tatap Muka :  

 Menyiapkan halaman 

baru untuk membuat 

presentasi  

 Menyimpan data file 

dengan nama baru 

 Mencermati visualisasi 

format teks, jenis font, 

ukuran, warna, letak, 

dll 

 Memanfaatkan word 

art sebagai bagian dari 

tampilan presentasi 

 Mengatur tampilan 

background pada tiap 

halaman menggunakan 

slide yang tersedia 

 Menampilkan 

background dengan 

foto / gambar ciri 

kedaerahan.  

 Menyisipkan gambar 

dalam slide 

 Menempatkan objek 

dari berbagai sumber 

dan media di lembar 

presentasi 

 Mengatur tampilan 

slide dengan animasi 

yang ada dalam tools 

 Mengatur waktu 

tampilan slide sesuai 

kebutuhan  

 Menghubungkan 

dokumen antar slide 

 

 Membuat presentasi 

menggunakan 

template  

 Membuat halaman 

presentasi dengan 

menggunakan text 

box dan word art 

 Memodifikasi 

tampilan halaman 

dengan 

memanfaatkan 

background  

 Membuat presentasi 

dengan variasi 

gambar, tabel, 

diagram dan grafik 

 Memodifikasi 

tampilan presentasi 

dengan 

memanfaatkan 

custom animation  

 Memodifikasi 

tampilan presentasi 

dengan 

memanfaatkan 

fasilitas efek transisi 

 Menentukan durasi 

presentasi dan 

Membuat slide 

presentasi yang 

berjalan otomatis 

 Menggabungkan 

dokumen presentasi 

dengan hyperlink 

 Tertulis  

 

 Penugasan 

praktek 

individu  

 

 Hasil kerja 

berupa file 

presentasi  

2 x 50 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fasilitas Help 

 Animation 

Factory 

template and 

graphic  

 Gambar dari 

internet  

 Labsheet  

 

 

 

 Seperangkat 

Komputer 

dengan 

software 

Power Point 



       

Kompetensi 

Dasar  

Materi 

Pembelajaran 

Kegiatan Pembelajaran Indikator Pencapaian Penilaian Alokasi 

Waktu 

(menit)  

Sumber / 

Bahan / Alat 

Mandiri Terstruktur  

 Membuat slide dengan 

grafik yang divariasi 

dan tabel yang 

diformat  

 Membuat slide dengan 

menampilkan diagram 

struktur organisasi, 

cycle dan grafik 

 Membuat slide dengan 

variasi design template  

 Membuat slide dengan 

animasi 

 Membuat slide dengan 

variasi animasi 

 Membuat slide dengan 

hyperlink  

6 x 50  

Sleman, 13 Juli  2009 

Mengetahui,                  

Kepala SMA N 1 Kalasan,              Guru Mata Pelajaran TIK, 

  

 

 

Drs. H. Tri Sugiharto                                                 Arief Budiman, S.Pd.  

NIP. 19570707 198103 1 024           NIP. 19761123 200501 1 014 
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Lampiran 3. RPP Kelas Eksperimen  



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 1 (satu)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 1   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Demonstrasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Apersepsi  

3. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Memberikan 

motivasi 

 

3. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa 

memperhatika

n guru  

3. Siswa siap 

menerima 

pelajaran  

Slide 

presentasi  

15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

penyisipan dan 

editing gambar 

pada aplikasi 

Power Point   

2. Memberi tugas 

(labsheet)  

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek  

 

 

2. Mengerjakan 

tugas    

Komputer, 

viewer,file 

presentasi, 

labsheet, 

jaringan 

internet, E-

Learning  

70’ 



3. Penutup  

1. Evaluasi  

2. Rangkuman  

3. Tugas  

4. Pesan  

1. Merangkum 

materi dan 

memberikan 

kesimpulan 

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

1. Siswa 

memperhatika

n guru 

2. Siswa 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

- 15’ 

 

VIII. Alat dan Sumber Belajar 

Labsheet, Bahan dari internet 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi transisi sederhana seperti yang telah tercantum pada labsheet 1.  

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa PPL, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
 

 

 

 

 

 

 

 

 

 

 

 



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 2 (dua)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 2   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink    

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink  

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Presentasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Apersepsi  

3. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Memberikan 

motivasi 

 

3. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa 

memperhatika

n guru  

3. Siswa siap 

menerima 

pelajaran  

Slide 

presentasi  

15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

hyperlink pada 

aplikasi Power 

Point   

2. Memberi tugas 

(labsheet)  

 

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek  

 

2. Mengerjakan 

tugas    

Komputer, 

viewer,file 

presentasi, 

labsheet, 

jaringan 

internet, E-

learning  

70’ 



3. Penutup  

1. Evaluasi  

2. Rangkuman  

3. Tugas  

4. Pesan  

1. Merangkum 

materi dan 

memberikan 

kesimpulan 

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

1. Siswa 

memperhatika

n guru 

2. Siswa 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

 15’ 

 

VIII. Alat dan Sumber Belajar 

Labsheet, Bahan dari internet 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi sederhana menggunakan hyperlink seperti yang telah tercantum pada 

labsheet 2.  

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa PPL, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
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Lampiran 4. RPP Kelas Kontrol  



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 1 (satu)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 1   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Demonstrasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa siap 

menerima 

pelajaran  

Ceramah  15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

penyisipan dan 

editing gambar 

pada aplikasi 

Power Point   

 

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek 

sekaligus 

mengerjakan 

tugas   

Komputer, 

viewer,file 

presentasi 

70’ 

3. Penutup  

1. Evaluasi  

2. Rangkuman  

3. Pesan untuk 

1. Merangkum 

materi dan 

memberikan 

kesimpulan 

1. Siswa 

memperhatika

n guru 

2. Siswa 

Ceramah  15’ 



menilaikan 

tugas bagi 

siswa yang 

belum selesai  

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

 

VIII. Alat dan Sumber Belajar 

Presentasi Powerpoint guru 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi transisi sederhana seperti yang telah dicontohkan guru.  

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 2 (dua)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 2   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink    

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink  

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Presentasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa siap 

menerima 

pelajaran  

Ceramah  15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

hyperlink pada 

aplikasi Power 

Point   

2. Memberi tugas 

(labsheet)  

 

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek 

sekaligus 

mengerjakan 

tugas   

Komputer, 

viewer,file 

presentasi 

70’ 

3. Penutup  

1. Evaluasi  

2. Rangkuman  

1. Merangkum 

materi dan 

memberikan 

1. Siswa 

memperhatika

n guru 

Ceramah  15’ 



3. Pesan untuk 

menilaikan 

tugas bagi 

siswa yang 

belum selesai  

kesimpulan 

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

2. Siswa 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

 

VIII. Alat dan Sumber Belajar 

Presentasi Powerpoint guru 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi sederhana menggunakan hyperlink seperti yang telah dicontohkan guru.  

 

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
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Lampiran 5. Lembar Validasi Ahli  



 

 

LEMBAR VALIDASI INSTRUMEN TES HASIL BELAJAR 

 

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Materi Pokok   : Perangkat Lunak Pembuat Presentasi (Ms. Office Power Point) 

Sasaran Program  : Siswa Kelas X SMA Negeri 1 Kalasan 

Validator   : Umi Rochayati, M.T.  

Peneliti  : Mawar Ramadhani 

 

A. Petunjuk 1 

1. Lembar Validasi ini diisi oleh ahli (judgment expert)  

2. Validasi ini dimaksudkan untuk mengungkap tanggapan bapak / ibu sebagai ahli 

(judgment expert) terhadap instrumen tes hasil belajar Teknologi Informasi dan 

Komunikasi ditinjau dari aspek pembelajaran, aspek kebenaran isi, komentar 

umum dan kesimpulan.  

3. Penilaian dimulai dengan rentangan sangat kurang baik (SK) sampai sangat baik 

(SB). Silakan memberikan tanda cek (√) pada kolom yang sesuai menurut 

pendapat bapak / ibu selaku ahli (judgment expert).  

4. Keterangan skala :  

SB  : Sangat Baik (dengan skor 5) 

B : Baik (dengan skor 4) 

C : Cukup baik (dengan skor 3) 

K : Kurang baik (dengan skor 2) 

SK : Sangat kurang baik (dengan skor 1)  

5. Komentar san saran bapak / ibu mohon dituliskan pada lembar yang telah 

disediakan. Apabila tempat tidak mencukupi, mohon ditulis pada lembar 

tambahan yang telah disediakan.  

6. Atas kesediaan bapak / ibu dalam mengisi lembar validasi, saya sampaikan 

terimakasih.  

 

 

 

 

 



 

 

No. Indikator Skala 

1 2 3 4 5 

1  Kejelasan rumusan standar kompetensi     √  

2 Kesesuaian kompetensi dasar dengan standar 

kompetensi  

   √  

3 Kejelasan indikator keberhasilan     √  

4  Kejelasan sasaran program     √  

5 Ketepatan materi dikaitkan dengan kompetensi 

dasar  

   √  

6 Kejelasan petunjuk mengerjakan tes     √  

7 Kesesuaian soal tes dengan materi    √  

8 Kecukupan soal tes     √  

9 Variasi bentuk soal     √  

10 Kebenaran penggunaan bahasa sesuai EYD 

dalam soal tes  

  √   

11 Kesesuaian soal tes dengan standar kompetensi     √  

12 Kesesuaian soal tes dengan kompetensi dasar     √  

13 Kesesuaian soal tes dengan indikator 

keberhasilan  

   √  

Jumlah      

Penilaian secara umum Kesimpulan Penilaian 

LD LDR TLD 

Penilaian secara umum terhadap instrumen tes  √  

 

Keterangan :  

LD  : Layak Digunakan 

LDR  : Layak Digunakan dengan Revisi 

TLD : Tidak Layak Digunakan  

 

B. Petunjuk 2  

1. Apabila terdapat komentar, mohon dituliskan pada kolom 2 

2. Pada kolom silakan diisi saran untuk perbaikan  

No. Bagian yang perlu diperbaiki Saran perbaikan 

1  Penulisan efek keluar  Diperjelas maksudnya  

2   

3   

 



 

 

Komentar / saran umum :  

 

Layak digunakan.  

 

Kesimpulan :  

Instrumen ini dinyatakan :  

1. Layak untuk uji coba lapangan tanpa revisi  

2. Layak uji coba lapangan dengan revisi sesuai saran  

3. Tidak layak uji coba  

 

 

Yogyakarta, 26 Maret 2012 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Validator, 

 

 

 

Umi Rochayati, M.T.  

NIP. 19630528 198710 2 001 



 

 

LEMBAR VALIDASI INSTRUMEN TES HASIL BELAJAR 

 

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Materi Pokok   : Perangkat Lunak Pembuat Presentasi (Ms. Office Power Point) 

Sasaran Program  : Siswa Kelas X SMA Negeri 1 Kalasan 

Validator   : Masduki Zakaria, M.T.  

Peneliti  : Mawar Ramadhani 

 

A. Petunjuk 1 

1. Lembar Validasi ini diisi oleh ahli (judgment expert)  

2. Validasi ini dimaksudkan untuk mengungkap tanggapan bapak / ibu sebagai ahli 

(judgment expert) terhadap instrumen tes hasil belajar Teknologi Informasi dan 

Komunikasi ditinjau dari aspek pembelajaran, aspek kebenaran isi, komentar 

umum dan kesimpulan.  

3. Penilaian dimulai dengan rentangan sangat kurang baik (SK) sampai sangat baik 

(SB). Silakan memberikan tanda cek (√) pada kolom yang sesuai menurut 

pendapat bapak / ibu selaku ahli (judgment expert).  

4. Keterangan skala :  

SB  : Sangat Baik (dengan skor 5) 

B : Baik (dengan skor 4) 

C : Cukup baik (dengan skor 3) 

K : Kurang baik (dengan skor 2) 

SK : Sangat kurang baik (dengan skor 1)  

5. Komentar san saran bapak / ibu mohon dituliskan pada lembar yang telah 

disediakan. Apabila tempat tidak mencukupi, mohon ditulis pada lembar 

tambahan yang telah disediakan.  

6. Atas kesediaan bapak / ibu dalam mengisi lembar validasi, saya sampaikan 

terimakasih.  

 

 

 

 

 



 

 

No. Indikator Skala 

1 2 3 4 5 

1  Kejelasan rumusan standar kompetensi     √  

2 Kesesuaian kompetensi dasar dengan standar 

kompetensi  

   √  

3 Kejelasan indikator keberhasilan     √  

4  Kejelasan sasaran program     √  

5 Ketepatan materi dikaitkan dengan kompetensi 

dasar  

  √   

6 Kejelasan petunjuk mengerjakan tes     √  

7 Kesesuaian soal tes dengan materi    √  

8 Kecukupan soal tes     √  

9 Variasi bentuk soal    √   

10 Kebenaran penggunaan bahasa sesuai EYD 

dalam soal tes  

  √   

11 Kesesuaian soal tes dengan standar kompetensi     √  

12 Kesesuaian soal tes dengan kompetensi dasar     √  

13 Kesesuaian soal tes dengan indikator 

keberhasilan  

   √  

Jumlah      

Penilaian secara umum Kesimpulan Penilaian 

LD LDR TLD 

Penilaian secara umum terhadap instrumen tes  √  

 

Keterangan :  

LD  : Layak Digunakan 

LDR  : Layak Digunakan dengan Revisi 

TLD : Tidak Layak Digunakan  

 

B. Petunjuk 2  

1. Apabila terdapat komentar, mohon dituliskan pada kolom 2 

2. Pada kolom silakan diisi saran untuk perbaikan  

No. Bagian yang perlu diperbaiki Saran perbaikan 

1    

2   

3   

 



 

 

Komentar / saran umum :  

 

1. Landasan teoritik dari soal yang mudah ke sulit atau sulit ke yang mudah, 

atau acak. 

2. Validitas isi gunakan item analisis atau analisis butir.  

 

Kesimpulan :  

Instrumen ini dinyatakan :  

1. Layak untuk uji coba lapangan tanpa revisi  

2. Layak uji coba lapangan dengan revisi sesuai saran  

3. Tidak layak uji coba  

 

Yogyakarta, 29 Maret 2012 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Validator, 

 

 

 

Masduki Zakaria, M.T.   

NIP. 19640917 198901 1 001 



 

 

LEMBAR VALIDASI INSTRUMEN TES HASIL BELAJAR 

 

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Materi Pokok   : Perangkat Lunak Pembuat Presentasi (Ms. Office Power Point) 

Sasaran Program  : Siswa Kelas X SMA Negeri 1 Kalasan 

Validator   : Arief Budiman, S.Pd.   

Peneliti  : Mawar Ramadhani 

 

A. Petunjuk 1 

1. Lembar Validasi ini diisi oleh ahli (judgment expert)  

2. Validasi ini dimaksudkan untuk mengungkap tanggapan bapak / ibu sebagai ahli 

(judgment expert) terhadap instrumen tes hasil belajar Teknologi Informasi dan 

Komunikasi ditinjau dari aspek pembelajaran, aspek kebenaran isi, komentar 

umum dan kesimpulan.  

3. Penilaian dimulai dengan rentangan sangat kurang baik (SK) sampai sangat baik 

(SB). Silakan memberikan tanda cek (√) pada kolom yang sesuai menurut 

pendapat bapak / ibu selaku ahli (judgment expert).  

4. Keterangan skala :  

SB  : Sangat Baik (dengan skor 5) 

B : Baik (dengan skor 4) 

C : Cukup baik (dengan skor 3) 

K : Kurang baik (dengan skor 2) 

SK : Sangat kurang baik (dengan skor 1)  

5. Komentar san saran bapak / ibu mohon dituliskan pada lembar yang telah 

disediakan. Apabila tempat tidak mencukupi, mohon ditulis pada lembar 

tambahan yang telah disediakan.  

6. Atas kesediaan bapak / ibu dalam mengisi lembar validasi, saya sampaikan 

terimakasih.  

 

 

 

 

 



 

 

No. Indikator Skala 

1 2 3 4 5 

1  Kejelasan rumusan standar kompetensi  √     

2 Kesesuaian kompetensi dasar dengan standar 

kompetensi  

√     

3 Kejelasan indikator keberhasilan   √    

4  Kejelasan sasaran program   √    

5 Ketepatan materi dikaitkan dengan kompetensi 

dasar  

 √    

6 Kejelasan petunjuk mengerjakan tes   √    

7 Kesesuaian soal tes dengan materi  √    

8 Kecukupan soal tes   √    

9 Variasi bentuk soal    √   

10 Kebenaran penggunaan bahasa sesuai EYD 

dalam soal tes  

 √    

11 Kesesuaian soal tes dengan standar kompetensi   √    

12 Kesesuaian soal tes dengan kompetensi dasar   √    

13 Kesesuaian soal tes dengan indikator 

keberhasilan  

 √    

Jumlah      

Penilaian secara umum Kesimpulan Penilaian 

LD LDR TLD 

Penilaian secara umum terhadap instrumen tes  √  

 

Keterangan :  

LD  : Layak Digunakan 

LDR  : Layak Digunakan dengan Revisi 

TLD : Tidak Layak Digunakan  

 

B. Petunjuk 2  

1. Apabila terdapat komentar, mohon dituliskan pada kolom 2 

2. Pada kolom silakan diisi saran untuk perbaikan  

No. Bagian yang perlu diperbaiki Saran perbaikan 

1  Terdapat kata “bukan” Diganti kata “kecuali” 

2 Istilah yang asing pada Power Point  Diganti dengan yang dikenal  

3   

 



 

 

Komentar / saran umum :  

 

Sudah layak digunakan dengan beberapa perbaikan yang telah disarankan.  

 

Kesimpulan :  

Instrumen ini dinyatakan :  

1. Layak untuk uji coba lapangan tanpa revisi  

2. Layak uji coba lapangan dengan revisi sesuai saran  

3. Tidak layak uji coba  

 

 

Yogyakarta, 29 Maret 2012 

 

 

 

 

 

 

 

Validator, 

 

 

 

Arief Budiman, S.Pd. 

NIP. 19761123 200501 1 014 
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Lampiran 6. Surat Keterangan Validator  



SURAT KETERANGAN VALIDASI INSTRUMEN

Yang bertandatangandi bawah ini :

Nama . UUI RoCHA\ATi, MT.
NIP : l967cst8 l9g+1o z ool

Setelah membaca dan memeriksa instrument penelitian skripsi yang be{udul 66Efektivitas

Penggunaan Media Pembelajaran E-Learning Berbasis lYeb Based Training Terhadap

Hasil Belajar Siswa Mata Pelajaran Teknologi Informasi dan Komunikasi Kelas X SMA

Negeri 1 Kalasan", oleh peneliti :

Nama : Mawar Ramadhani

NIM :08520241028

Prodi : Pendidikan Teknik Informatika

Maka dengan ini menyatakan bahwa butir - butir soal pilihan ganda yang ada pada instrument

ini *) :

a. Layak digunakan untuk penelitian dengan revisi sesuai saran sebagai berikut :

QenutrTan 6oal eeuai L\D

Layak digunakan untuk penelitian tanpa revisi.

b. Tidak layak digunakan untuk penelitian.

Demikian surat keterangan ini dibuat dan untuk digunakan sebagaimana mestinya.

Yogyakart", zg Mxte[ ?ott

NIP. t6rlosX8 \Oeao tool

*) Lingkari pada huruf yang sesuai dengan pendapat Bapak Ibu



SURAT KETERANGAN VALIDASI INSTRUMEN

:

Yang bertanda tangan di bawah ini :

Nama : MfsUlFt arF.ARlA, M.t.
NIp : 0G1o5lT l981ot r oot

Setelah membaca dan memeriksa instrument penelitian skripsi yang be{udul "Efektivitas
Penggunaan Media Pembelajaran E-Learning Berba sis lYeb Based Training Terhadap

Hasil Belajar Siswa Mata Pelajaran Teknologi Informasi dan Komunikasi Kelas X SMA

Negeri L Kalasan", oleh peneliti :

Nama : Mawar Ramadhani

NIM z 0852024fi28

Prodi : Pendidikan Teknik Informatika

Maka dengan ini menyatakan bahwa butir - butir soal pilihan ganda yang ada pada instrument

ini *) :

a. Layakdigunakanuntuk tian dengan revisi sesuai saran sebaga!

Layak digunakan untuk penelitian tanpa revisi.

b. Tidak layak digunakan untuk penelitian.

Demikian surat keterangan ini dibuat dan untuk digunakan sebagaimana mestinya.

t2 L"w-

(

Yogyakarta,

Validator,

NIP. le6qo1Y+ \,egol :c,ol

*) Lingkari pada huruf yang sesuai dengan pendapat Bapak Ibu



SURAT KETERANGAII VALIDASI INSTRUMEN

Yang bertandatangan di bawah ini :

Nama : AS\EF TS\-rD I I4AAJ
NIP

Setelah membaca dan memeriksa instrument penelitian skripsi yang be{udul ooEfektivitas

Penggunaan Media Pembelajaran E-Learning Berbasis Web Based Training Terhadap

Hasil Belajar Siswa Mata Pelajaran Teknologi Informasi dan Komunikasi Kelas X SMA
Negeri 1 Kalasano', oleh peneliti :

Nama : Mawar Ramadhani

NIM :08520241028

Prodi : Pendidikan Teknik Informatika

Maka dengan ini menyatakan bahwa butir - butir soal pilihan ganda yang ada pada instrument

ini *) :

I il I-avak disunakan untuk penelitian dengan revisi sesuai saran sebagai berikut :V

Layak digunakan untuk penelitian tanpa revisi.

b. Tidak layak digunakan untuk penelitian.

Demikian surat keterangan ini dibuat dan untuk digunakan sebagaimana mestinya.

Yogyakart^, t9 Mofu( uru

Validator,

(

NIP.

*) Lingkari pada hurufyang sesuai dengan pendapat Bapak Ibu
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Lampiran 7. Kisi-Kisi Soal  



 

 

Kisi–Kisi Instrumen Soal Tes 

“Efektivitas Penggunaan Media Pembelajaran E-Learning Berbasis Web  

Pada Pelajaran Teknologi Informasi dan Komunikasi Terhadap Hasil Belajar  

Siswa Kelas X SMA Negeri 1 Kalasan” 

No. Standar 

Kompetensi  

Kompetensi 

Dasar 

Materi Pokok Indikator Tipe tes  No. Soal 

(Pretest)  

No. Soal 

(Postest)  

Jumlah 

Butir  

1.  Menggunakan 

perangkat 

lunak 

pembuat 

presentasi  

Membuat 

presentasi 

teks dengan 

variasi 

gambar, 

animasi dan 

hyperlink  

 Fungsi menu 

dan ikon serta 

perintah 

dalam 

aplikasi Ms. 

Office Power 

Point  

 

 

 

 

 

 

 

 

1. Membuka program pembuat 

presentasi  

2. Mengidentifikasi menu, tools, 

icon, shortcut key dan elemen 

dalam program pembuat 

presentasi  

3. Mengetahui istilah dalam 

program pembuat presentasi  

4. Membuat presentasi 

menggunakan layout, text box 

atau WordArt  

5. Memodifikasi tampilan slide 

dengan memanfaatkan 

background  

6. Membuat presentasi dengan 

Penerapan  

 

Pemahaman  

 

 

 

Hafalan  

 

Penerapan  

 

 

Pemahaman 

 

 

Penerapan  

5,10,25 

 

2,3, 22 

 

 

 

1, 7 

 

15, 21 

 

 

6, 18 

 

 

4, 13, 20 

1, 2, 7 

 

8, 10, 23 

 

 

 

5, 19 

 

15, 22 

 

 

9, 20 

 

 

6, 13, 21 

3 

 

3 

 

 

 

2 

 

2 

 

 

2 

 

 

3 



 

 

 Membuat 

media 

presentasi 

dengan 

variasi teks, 

gambar, 

animasi dan 

hyperlink  

variasi teks dan gambar 

7. Memodifikasi tampilan 

presentasi dengan 

memanfaatkan custom 

animation  

8. Memodifikasi tampilan 

presentasi dengan 

memanfaatkan fasilitas slide 

transisi  

9. Membuat slide presentasi 

yang berjalan otomatis dan 

melakukan penyisipan objek 

pada materi presentasi 

10. Menggabungkan dokumen 

presentasi dengan 

menggunakan hyperlink  

 

Pemahaman  

 

 

 

Pemahaman  

 

 

 

Penerapan  

 

 

 

Penerapan  

 

 

11, 14, 23 

 

 

 

16, 17 

 

 

 

8, 9, 12 

 

 

 

19, 24  

 

11, 14, 17 

 

 

 

16, 24 

 

 

 

3, 4, 12 

 

 

 

18, 25 

 

3 

 

 

 

2 

 

 

 

3 

 

 

 

2 

      25 25 25 
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Lampiran 8. Soal Uji Coba  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

TES UJI COBA  

MEMBUAT PRESENTASI DENGAN VARIASI TEKS, GAMBAR, 

ANIMASI TRANSISI DAN HYPERLINK 

Kriteria mengerjakan postest :  

1. Berdoalah sebelum mengerjakan tes.  

2. Tulis identitas pada lembar ini dengan jelas.   

3. Baca soal dengan baik dan cermati maksudnya.  

4. Pilih satu jawaban yang paling tepat kemudian beri tanda silang pada huruf a, b, c, atau d.  

5. Telitilah kembali setelah selesai mengerjakan soal sebelum diserahkan untuk dinilai.  

 

SELAMAT MENGERJAKAN 
 

Nama Lengkap  : _____________________________________________ 

Kelas / Presensi  : _____________________________________________ 

1. Langkah – langkah membuka (menjalankan) program aplikasi Power Point secara umum adalah.. 

a. Start – Microsoft Power Point 

b. Start – Office – Microsoft Power Point  

c. Start – All Programs – Microsoft Office – Microsoft Power Point  

d. Start – All Programs - Microsoft Power Point 

e. Start – Microsoft – Power Point  

2. Untuk membuka dokumen baru hingga muncul slide presentasi pada Microsoft Power Point 2007 

menggunakan : 

a. File > New 

b. File > Save 

c. File > Open  

d. File > Blank Document  

e. File > New > Blank Presentation  

3. Untuk menambahkan slide baru menggunakan perintah :  

a. Home > New Slide 

b. Home > Picture  

c. File > Save 

d. New > Slide 

e. File > New  

4. Untuk memasukkan gambar di dalam slide menggunakan perintah  

a. Insert > Picture 

b. Insert > New Slide  

c. Insert > Clip Art  

d. Insert > Picture > Clip Art 

e. Insert > Object  

5. Shortcut yang digunakan untuk menyalin slide adalah.. 

a. Ctrl + X 

b. Ctrl + C 

c. Ctrl + E 

d. Ctrl + M 

e. Ctrl + V  

 

6. Perintah yang digunakan untuk merubah bentuk, ukuran dan gaya huruf adalah.. 

a. File – Format – Font 

b. Insert – Format – Font 

c. Format – Font 



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

d. Home – Font  

e. Edit – Format – Font  

7. Perintah yang digunakan untuk merubah layout pada suatu slide adalah.. 

a. Home – Slide 

b. Home – Style Layout  

c. Home – Layout 

d. Home – Design Layout  

e. Home – Slide Layout  

8. Fasilitas layout slide digunakan untuk.. 

a. Animasi layout 

b. Memberi font 

c. Memilih tata letak isi dan content pada slide 

d. Memberi garis bantu  

e. Memberi spasi  

9. Kegunaan dari tombol “Apply” pada kotak dialog format – background adalah.. 

a. Mengaktifkan pilihan pada setiap presentasi  

b. Mengaktifkan pilihan pada presentasi aktif 

c. Mengaktifkan pilihan pada slide sebelumnya 

d. Mengaktifkan pilihan pada slide aktif 

e. Mengaktifkan pilihan pada setiap slide  

10. Menu yang tidak terdapat pada Microsoft Power Point 2007 adalah..  

a. Insert 

b. Review 

c. Add – Ins  

d. Home 

e. Mailings 

11. Berikut ini termasuk Custom Animation, kecuali… 

a. Entrance 

b. Emphasis  

c. Exit  

d. Motion Paths  

e. Animation Scheme  

12. Berikut yang termasuk sub menu dari Slide Show adalah… 

a. New Slide 

b. Slide Number 

c. Chart 

d. Diagram  

e. Rehearse Timings  

13. Yang dimaksud dengan animasi secara umum adalah… 

a. Objek (teks atau gambar) yang bergerak 

b. Objek yang dapat menghilang dan muncul kembali  

c. Gambar kartun  

d. Objek lucu 

e. Gambar diam  

14. Tools animasi yang dapat kita gunakan untuk membuat suatu objek lingkaran dan berputar sesuai garis 

orbit tersebut adalah.. 

a. Hexagon 

b. Spiral 

c. Octagon 

d. Circle  

e. Football  

15. Layout di bawah ini disebut… 

 



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

a. Title slide 

b. Title and Content  

c. Two Content 

d. Content With Caption 

e. Section Header  

16. Yang digunakan untuk mengatur jenis transisi pada presentasi Power Point 2007 adalah … 

 
 

 

a. 1  b. 2  c. 3  d. 4  e. 5  

17. Bagaimana cara membuat teks berganti warna setelah animasi pada teks tersebut selesai?  

a. Pengaturan pada Effect > Direction 

b. Pengaturan pada Effect > After Animation 

c. Pengaturan pada Effect > Animate Text 

d. Pengaturan pada Timing > Repeat 

e. Pengaturan pada Timing > Delay  

18. Menghubungkan beberapa dokumen presentasi dapat dilakukan mengunakan fasilitas...  

a. Cloning  

b. Hyperlink  

c. Grouping  

d. Verifying  

e. Navigasi 

19. Ekstensi file berikut yang merupakan ekstensi dari tipe file powerpoint 2007 adalah...  

a. .ppt   

b. .Gif  

c. .pptx  

d. .Doc  

e. .Xls 

20. Perintah slide layout digunakan untuk …  

a. Menampilkan presentasi satu layar penuh  

b. Menampilkan bentuk-bentuk slide  

c. Menampilkan navigasi  

d. Menampilkan add effect  

e. Menampilkan bentuk-bentuk background 

21. Gambar kotak dialog di bawah digunakan untuk.. 

 
a. Penggabungan Navigasi  

b. Memberikan efek pada huruf  

c. Memberikan efek setelah animasi tertentu selesai   

d. Menggabungkan slide dan navigasi  

e. Menghubungkan slide-slide maupun file dalam extensi yang lain 

2 3 

4 

5 

1 
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22. Untuk membuat nomor halaman pada slide digunakan tools …  

1. Text Box   

2. Word  Art 

3. Clip Art 

4. Emphasis 

5. Font  

Jawaban yang tepat adalah.. 

a. 1,2   

b. 1,5   

c. 5 

d. 3,4   

e. 3,5  

23. Berikut ini yang merupakan sub menu dari menu review adalah.. 

a.  
 

b.  
 

c.  
 

d.  
 

e.  
 

24. Ada beberapa komponen presentasi yang dapat diberi animasi, kecuali.. 

a. Teks    

b. Objek Gambar 

c. Transisi Slide 

d. Peralihan Slide  

e. Layout  

25. Menu berikut yang digunakan untuk membuat hyperlink dengan hanya mengarahkan kursor pada media 

hyperlink terletak pada bagian nomor.. 

  
a. 1 

b. 2   

c. 3 

d. 4   

e. 5  

 

1 

2 

3 

5 4 
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Lampiran 9. Data Kelas dan Hasil Uji Coba  



ATTENDENCE LIST 
CLASS XC 

SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

30/3     INFO  

1 8796 ANAS BANU AJI M 52      

2 8809 ANNISA MAULUDINA F 28      

3 8811 ANNISA WIDYASTUTI F 36      

4 8852 ERY HIKMANNISA DAMAYANTI F 48      

5 8854 ETMA FATMA MILASARI F 36      

6 8855 FACHRY HAJI MAKKIYAH M 80      

7 8873 FITRI MIANDARI F 28      

8 8883 GITHA NURHADY DZULQINA M 72      

9 8889 HANUNG NAWANG PALUPI F 76      

10 8898 IKA MADYARINA MASTUTI F 88      

11 8903 INDAH KUSUMANINGRUM F -      

12 8906 INTAN MAYASARI F 44      

13 8907 INTAN PUSPITASARI F 24      

14 8918 KHOLIFATUN NASIFAH F 56      

15 8928 MUHAMMAD IRFAN HIDAYAT M -      

16 8930 MUSTOFA NUR KHALISMA M 72      

17 8934 NAJMATUSSALAMAH F -      

18 8935 NANDHIWARDHANA DHARMIKA M 72      

19 8937 NIA PUSPITA DEWI F -      

20 8938 NIKY WULANDARI F 92      

21 8944 NURVITA PUSPITA F 76      

22 8947 PRAMITHA PRIMANGGITA AYU A F -      

23 8951 QHORY KUSUMA SATITI F 32      

24 8953 RAGA GLEGAR WICAKSONO M 92      

25 8955 RAHMAWATI UTAMI F 84      

26 8960 RETNO UTAMI F -      

27 8968 RIZDIANA NUR HANI F 28      

28 8971 RIZQI FAZZAR KURNIA M 64      

29 8976 ROSALIA DYAH NUGRAHANI K D  F 24      

30 8991 TUBAGUS MAHESA ABIRAWA P M 48      

31 9004 YENI NUR PRATIWI F -      

32 9005 YOGA RAKHMANTO 
 

-      

   

L : 10 
P : 22  
 

 
∙ 

     

Menyetujui, 

Guru Pembimbing 
 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 
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Lampiran 10. Instrumen Soal Pretest dan Posttest  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

PRETEST  

MEMBUAT PRESENTASI DENGAN VARIASI TEKS, GAMBAR, 

ANIMASI TRANSISI DAN HYPERLINK 

Kriteria mengerjakan postest :  

1. Berdoalah sebelum mengerjakan tes.  

2. Tulis identitas pada lembar ini dengan jelas.   

3. Baca soal dengan baik dan cermati maksudnya.  

4. Pilih satu jawaban yang paling tepat kemudian beri tanda silang pada huruf a, b, c, atau d.  

5. Telitilah kembali setelah selesai mengerjakan soal sebelum diserahkan untuk dinilai.  

 

SELAMAT MENGERJAKAN 
 

Nama Lengkap  : _____________________________________________ 

Kelas / Presensi  : _____________________________________________ 

1. Dalam Ms. Power Point terdapat istilah slide. Slide merupakan..  

a. Istilah halaman dalam power point 

b. Template bawaan yang sudah disediakan Ms. Office 

c. Gambar yang bisa diberi animasi 

d. Gabungan beberapa animasi  

e. Tools untuk scrolling bar 

2. Shortcut yang digunakan untuk paste slide adalah.. 

a. Ctrl + V 

b. Ctrl + C 

c. Ctrl + E 

d. Ctrl + M 

e. Ctrl + X  

 

3. Selain mempergunakan menu Home – Cut untuk memotong atau menghapus teks, dapat diganti dengan 

menekan.. 

a. Ctrl + X 

b. Ctrl + M 

c. Ctrl + S 

d. Ctrl + A 

e. Ctrl + F  

 

4. Perintah yang digunakan untuk merubah bentuk, ukuran dan gaya huruf adalah pada menu.. 

a. Home  

b. Insert  

c. Design  

d. Animation  

e. Format  

 

5. Perintah yang digunakan untuk membuka atau merubah layout pada suatu slide adalah.. 

a. Home – Slide 

b. Home – Style Layout  

c. Home – Layout 

d. Home – Design Layout  

e. Home – Slide Layout  

 

6. Kegunaan dari tombol “Apply” pada kotak dialog format – background adalah.. 

a. Mengaktifkan pilihan pada setiap presentasi  

b. Mengaktifkan pilihan pada presentasi aktif 

c. Mengaktifkan pilihan pada slide sebelumnya 

d. Mengaktifkan pilihan pada slide aktif 

e. Mengaktifkan pilihan pada setiap slide  

7. Menu yang tidak terdapat pada Microsoft Power Point 2007 adalah..  

a. Insert  

b. Review 

c. Add – Ins  

d. Home 

e. Mailings 
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8. Untuk memasukkan gambar di dalam slide menggunakan perintah  

a. Insert > Picture 

b. Insert > New Slide  

c. Insert > Clip Art  

d. Insert > Word Art 

e. Insert > Object  

9. Berikut ini yang bukan termasuk elemen Custom Animation adalah… 

a. Entrance 

b. Emphasis  

c. Exit  

d. Motion Paths  

e. Animation Scheme  

10. Rehearse Timings merupakan sub menu dari menu… 

a. View  

b. Animation  

c. Home  

d. Insert   

e. Slide Show 

11. Yang dimaksud dengan animasi secara umum adalah… 

a. Objek (teks atau gambar) yang bergerak 

b. Objek yang dapat menghilang dan muncul kembali  

c. Gambar kartun  

d. Objek lucu 

e. Gambar diam  

12. Tools animasi yang dapat kita gunakan untuk membuat suatu objek segi enam dan berputar sesuai garis 

tersebut adalah.. 

a. Hexagon 

b. Spiral 

c. Octagon 

d. Circle  

e. Football  

13. Layout di bawah ini disebut… 

 
a. Title slide 

b. Title and Content  

c. Two Content 

d. Content With Caption 

e. Section Header  

14. Ada beberapa komponen presentasi yang dapat diberi animasi, kecuali.. 

a. Teks 

b. Objek Gambar 

c. Transisi Slide 

d. Peralihan Slide 

e. Layout  

15. Perintah slide layout digunakan untuk  

a. Menampilkan presentasi satu layar penuh  

b. Menampilkan bentuk-bentuk slide  

c. Menampilkan navigasi  

d. Menampilkan add effect  

e. Menampilkan bentuk-bentuk background 

16. Gambar kotak dialog di bawah digunakan untuk.. 
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a. Penggabungan Navigasi  

b. Memberikan efek pada huruf  

c. Memberikan efek setelah animasi tertentu selesai   

d. Menggabungkan slide dan navigasi  

e. Menghubungkan slide-slide maupun file dalam extensi yang lain 

17. Untuk membuat nomor halaman pada slide digunakan tools …  

1. Text Box   

2. Word  Art 

3. Clip Art 

4. Emphasis 

5. Font  

Jawaban yang tepat adalah.. 

a. 1,2   

b. 1,5   

c. 5 

d. 3,4   

e. 3,5  

18. Berikut ini yang merupakan sub menu dari menu insert adalah.. 

a.  
 

b.  
 

c.  
 

d.  
 

e.  
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19. Kotak dialog ini berfungsi untuk.. 

 
a. Mengatur tujuan hyperlink  

b. Mengatur banyaknya slide 

c. Mengatur animasi yang akan di edit 

d. Membuat animasi baru 

e. Mengatur objek yang bergerak 
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POSTTEST  

MEMBUAT PRESENTASI DENGAN VARIASI TEKS, GAMBAR, 

ANIMASI TRANSISI DAN HYPERLINK 

Kriteria mengerjakan postest :  

1. Berdoalah sebelum mengerjakan tes.  

2. Tulis identitas pada lembar ini dengan jelas.   

3. Baca soal dengan baik dan cermati maksudnya.  

4. Pilih satu jawaban yang paling tepat kemudian beri tanda silang pada huruf a, b, c, atau d.  

5. Telitilah kembali setelah selesai mengerjakan soal sebelum diserahkan untuk dinilai.  

 

SELAMAT MENGERJAKAN 
 

Nama Lengkap  : _____________________________________________ 

Kelas / Presensi  : _____________________________________________ 

1. Untuk memasukkan gambar di dalam slide menggunakan perintah  

a. Insert > Picture 

b. Insert > New Slide  

c. Insert > Clip Art  

d. Insert > Picture > Clip Art 

e. Insert > Object  

2. Shortcut yang digunakan untuk menyalin slide adalah.. 

a. Ctrl + X 

b. Ctrl + C 

c. Ctrl + E 

d. Ctrl + M 

e. Ctrl + V  

 

3. Perintah yang digunakan untuk merubah bentuk, ukuran dan gaya huruf adalah.. 

a. File – Format – Font 

b. Insert – Format – Font 

c. Format – Font 

d. Home – Font  

e. Edit – Format – Font  

4. Perintah yang digunakan untuk merubah layout pada suatu slide adalah.. 

a. Home – Slide 

b. Home – Style Layout  

c. Home – Layout 

d. Home – Design Layout  

e. Home – Slide Layout  

5. Fasilitas layout slide digunakan untuk.. 

a. Animasi layout 

b. Memberi font 

c. Memilih tata letak isi dan content pada slide 

d. Memberi garis bantu  

e. Memberi spasi  

6. Kegunaan dari tombol “Apply” pada kotak dialog format – background adalah.. 

a. Mengaktifkan pilihan pada setiap presentasi  

b. Mengaktifkan pilihan pada presentasi aktif 

c. Mengaktifkan pilihan pada slide sebelumnya 

d. Mengaktifkan pilihan pada slide aktif 

e. Mengaktifkan pilihan pada setiap slide  
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7. Menu yang tidak terdapat pada Microsoft Power Point 2007 adalah..  

a. Insert 

b. Review 

c. Add – Ins  

d. Home 

e. Mailings 

8. Berikut ini termasuk Custom Animation, kecuali… 

a. Entrance 

b. Emphasis  

c. Exit  

d. Motion Paths  

e. Animation Scheme  

9. Berikut yang termasuk sub menu dari Slide Show adalah… 

a. New Slide 

b. Slide Number 

c. Chart 

d. Diagram  

e. Rehearse Timings  

10. Yang dimaksud dengan animasi secara umum adalah… 

a. Objek (teks atau gambar) yang bergerak 

b. Objek yang dapat menghilang dan muncul kembali  

c. Gambar kartun  

d. Objek lucu 

e. Gambar diam  

11. Tools animasi yang dapat kita gunakan untuk membuat suatu objek lingkaran dan berputar sesuai garis 

orbit tersebut adalah.. 

a. Hexagon 

b. Spiral 

c. Octagon 

d. Circle  

e. Football  

12. Layout di bawah ini disebut… 

 
a. Title slide 

b. Title and Content  

c. Two Content 

d. Content With Caption 

e. Section Header  

13. Ekstensi file berikut yang merupakan ekstensi dari tipe file powerpoint 2007 adalah...  

a. .ppt   

b. .Gif  

c. .pptx  

d. .Doc  

e. .Xls 

14. Perintah slide layout digunakan untuk …  

a. Menampilkan presentasi satu layar penuh  

b. Menampilkan bentuk-bentuk slide  

c. Menampilkan navigasi  

d. Menampilkan add effect  

e. Menampilkan bentuk-bentuk background 

 

 

 



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

15. Gambar kotak dialog di bawah digunakan untuk.. 

 
a. Penggabungan Navigasi  

b. Memberikan efek pada huruf  

c. Memberikan efek setelah animasi tertentu selesai   

d. Menggabungkan slide dan navigasi  

e. Menghubungkan slide-slide maupun file dalam extensi yang lain 

16. Untuk membuat nomor halaman pada slide digunakan tools …  

1. Text Box   

2. Word  Art 

3. Clip Art 

4. Emphasis 

5. Font  

Jawaban yang tepat adalah.. 

a. 1,2   

b. 1,5   

c. 5 

d. 3,4   

e. 3,5  

17. Berikut ini yang merupakan sub menu dari menu review adalah.. 

a.  
 

b.  
 

c.  
 

d.  
 

e.  
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18. Ada beberapa komponen presentasi yang dapat diberi animasi, kecuali.. 

a. Teks    

b. Objek Gambar 

c. Transisi Slide 

d. Peralihan Slide  

e. Layout  

19. Menu berikut yang digunakan untuk membuat hyperlink dengan hanya mengarahkan kursor pada media 

hyperlink terletak pada bagian nomor.. 

  
a. 1 

b. 2   

c. 3 

d. 4   

e. 5  

 

1 

2 

3 

5 4 
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Lampiran 11. Data Siswa  



ATTENDENCE LIST 
CLASS XA 

SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

31/3 7/2 21/4 28/4 5/5 INFO  

1 8789 
ADANTYO SATYA GILANG 
MARANDRARTA  M ∙ ∙ ∙ S ∙  

2 8791 ADITYA WIHARNANTO  M ∙ ∙ ∙ ∙ ∙  

3 8799 ANASTASIA DWI ANGGITASARI  F S ∙ A ∙ ∙  

4 8824 BENEDICTUS DAVID PRATAMA  M ∙ ∙ ∙ ∙ ∙  

5 8825 BERNADETTA DIAN RAHAYU F ∙ ∙ ∙ ∙ ∙  

6 8830 CICILIA FITRI MEDIASWATI F ∙ ∙ ∙ ∙ ∙  

7 8831 DAVID YUDHA PRANATHA  M ∙ ∙ ∙ ∙ ∙  

8 8837 DESTI VITRIANI F ∙ ∙ ∙ ∙ ∙  

9 8842 DIMAR MUKTIANA F ∙ ∙ ∙ ∙ ∙  

10 8843 DIONYSIUS RIRIHENA  M ∙ ∙ ∙ ∙ S  

11 8859 FANDI AKHMAD KURNIAWAN  M ∙ ∙ ∙ ∙ ∙  

12 8874 FRANSISCA APRILIA TRI UTAMI  F ∙ ∙ ∙ ∙ ∙  

13 8877 GALIH KARTIKA ADE SAPUTRA  M ∙ ∙ ∙ ∙ ∙  

14 8886 HANA UMI PERTIWI  F ∙ ∙ ∙ ∙ ∙  

15 8892 HENI KRISTIANINGTYAS  F ∙ ∙ ∙ ∙ ∙  

16 8896 IFFAH NUR ARDHIYANI F ∙ ∙ ∙ ∙ ∙  

17 8910 IRMA ALFIA ROSYIDA F ∙ ∙ ∙ ∙ ∙  

18 8912 IVANA SRI RAHAYU F ∙ ∙ ∙ ∙ ∙  

19 8933 NADIA RACHMA PUSPITA F ∙ ∙ ∙ ∙ ∙  

20 8939 NOVALITA ULFAH NUR UBAY F ∙ ∙ ∙ ∙ ∙  

21 8941 NUR FAJRIYAH ROSYIDAH  F ∙ ∙ ∙ ∙ ∙  

22 8958 REINARDUS GADING PRADANA  M ∙ ∙ ∙ ∙ ∙  

23 8961 REZA NUR RAHMAN  M ∙ ∙ ∙ ∙ ∙  

24 8981 SHELLA CHINTYA DIAN FIRERA  F ∙ ∙ ∙ ∙ ∙  

25 8984 SKOLASTIKA TYAS ANGGRAINI F ∙ S ∙ ∙ ∙  

26 8985 SPIRIDONA ADVENTIA CHRISTYANTI  F ∙ ∙ ∙ ∙ ∙  

27 8989 THERESIA ERNI PRASTITI F ∙ ∙ ∙ ∙ ∙  

28 8992 TYAS ARI WIBAWA  M ∙ ∙ ∙ ∙ ∙  

29 8995  ULFI ARIANA INDAH SARI  F ∙ ∙ ∙ ∙ ∙  

30 8998 VINCENTIUS EKO CAHYANTO  M ∙ ∙ ∙ ∙ ∙  

31 9000 WAHIB KURNIAWAN  M ∙ ∙ ∙ ∙ ∙  

32 9003 YASINTA MAURA IEKA PURNAMA  F ∙ ∙ ∙ ∙ ∙  

   

 
L : 12 
P : 20  
 

 
∙ 

     

Menyetujui, 
Guru Pembimbing 

 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 

 



ATTENDENCE LIST 
CLASS XB 

SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

31/3 7/4 21/4 28/4  INFO  

1 8790 ADITA WIDHANTARA M ∙ ∙ A ∙   

2 8792 ADNAN SINTAN RIFAI  M ∙ ∙ ∙ ∙   

3 8793 AHMAD NUGROHO MEI HERWANTO  M ∙ ∙ ∙ ∙   

4 8812 ARDINA MAFTUHATUN NIKMAH F ∙ ∙ ∙ ∙   

5 8814 ARNI MAULIDYA FAHIMA F ∙ ∙ ∙ ∙   

6 8819 AYU ISTI PRABANDARI F ∙ ∙ ∙ ∙   

7 8826 BIMO ANANTYO  M ∙ ∙ ∙ ∙   

8 8828 BUDI SATRIYO  M ∙ ∙ ∙ ∙   

9 8835 DESI NUGROHANINGRUM  F ∙ ∙ ∙ ∙   

10 8839 DEVI KUSUMASTUTI  F ∙ ∙ ∙ ∙   

11 8844 DUTA SAYOGA  M ∙ S A ∙   

12 8861 FANINA FADHILAH PUTRI AGLIS  F ∙ ∙ ∙ ∙   

13 8869 FEBRIZA AULIA SYARIATI F ∙ ∙ ∙ ∙   

14 8872 FIKRI FACHRY HIDAYAT M ∙ ∙ ∙ ∙   

15 8882 GILAR MENTARI F ∙ I  ∙ ∙   

16 8884 GUSTOMI ALFIANDRI  M I ∙ ∙ I   

17 8902 INDAH KURNIAWATI F ∙ I ∙ ∙   

18 8908 IRA MUSARAFA  F ∙ ∙ ∙ ∙   

19 8913 JANUAR RISALDI  M I  I ∙ I   

20 8925 MEILANA AYU PUTRI DINI F ∙ ∙ ∙ ∙   

21 8932 NADIA AGATHA PRAMESTHI F ∙ ∙ ∙ ∙   

22 8936 NASIEMATUL ARIFAT F I  ∙ ∙ I   

23 8943 NURUL FITRI ASTUTI  F ∙ ∙ ∙ ∙   

24 8950 QANA’ATUSY SYARIFAH  F ∙ ∙ ∙ ∙   

25 8957 RAVILIONA TIARA YULIANTIKA F ∙ ∙ ∙ ∙   

26 8959 RENY EKA SETIYOWATI F ∙ I ∙ ∙   

27 8964 RIFAN PRANANCA BAGUS SAPUTRA M ∙ ∙ ∙ ∙   

28 8982 SHINTA WAHYU SAPUTRI  F ∙ ∙ ∙ ∙   

29 8996 UNTARI RAHMAWATI F ∙ ∙ S ∙   

30 8999 VISTA AYUNINGTYAS  F ∙ ∙ ∙ ∙   

31 9007 YOHANES WAHYU KENDY PRATAMA M ∙ I ∙ ∙   

32 9008 
YONATAN WISNU KENDY 
PRASETYO  M ∙ I ∙ ∙   

   

 
L : 12 
P : 20  
 

 
∙ 

     

Menyetujui, 
Guru Pembimbing 

 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 
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Lampiran 12. Data Hasil Penelitian  



CLASS XA 
SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

NILAI 

Pretest  
 

Posttest  Keaktifan  

1 8789 
ADANTYO SATYA GILANG 
MARANDRARTA  M 63  79 ** 

2 8791 ADITYA WIHARNANTO  M 79  79 ***** 

3 8799 ANASTASIA DWI ANGGITASARI  F 63  89 * 

4 8824 BENEDICTUS DAVID PRATAMA  M 58  79 ** 

5 8825 BERNADETTA DIAN RAHAYU F 68  75 * 

6 8830 CICILIA FITRI MEDIASWATI F 74  79 * 

7 8831 DAVID YUDHA PRANATHA  M 63  84 * 

8 8837 DESTI VITRIANI F 58  95 *** 

9 8842 DIMAR MUKTIANA F 74  100 ** 

10 8843 DIONYSIUS RIRIHENA  M 63  79 ** 

11 8859 FANDI AKHMAD KURNIAWAN  M 79  89 * 

12 8874 FRANSISCA APRILIA TRI UTAMI  F 74  89 * 

13 8877 GALIH KARTIKA ADE SAPUTRA  M 79  89 * 

14 8886 HANA UMI PERTIWI  F 58  84  

15 8892 HENI KRISTIANINGTYAS  F 68  79  

16 8896 IFFAH NUR ARDHIYANI F 47  100 * 

17 8910 IRMA ALFIA ROSYIDA F 63  95 * 

18 8912 IVANA SRI RAHAYU F 74  89 ** 

19 8933 NADIA RACHMA PUSPITA F 74  100  

20 8939 NOVALITA ULFAH NUR UBAY F 47  100  

21 8941 NUR FAJRIYAH ROSYIDAH  F 63  95 * 

22 8958 REINARDUS GADING PRADANA  M 79  84  

23 8961 REZA NUR RAHMAN  M 68  84 ** 

24 8981 SHELLA CHINTYA DIAN FIRERA  F 79  89 * 

25 8984 SKOLASTIKA TYAS ANGGRAINI F 74  84  

26 8985 SPIRIDONA ADVENTIA CHRISTYANTI  F 68  89 ** 

27 8989 THERESIA ERNI PRASTITI F 47  84  

28 8992 TYAS ARI WIBAWA  M 68  75 * 

29 8995  ULFI ARIANA INDAH SARI  F 74  79 ** 

30 8998 VINCENTIUS EKO CAHYANTO  M 68  89  

31 9000 WAHIB KURNIAWAN  M 63  79  

32 9003 YASINTA MAURA IEKA PURNAMA  F 68  75  

 

    
  

 
Total  2755 L : 12 

  
     

 
Rata – rata  86.09 P : 20 

  
     

 
     

     

Menyetujui, 
Guru Pembimbing 

 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 

 



CLASS XB 
SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

Pretest  
 

Posttest Keaktifan  

1 8790 ADITA WIDHANTARA M 79  74 * 

2 8792 ADNAN SINTAN RIFAI  M 47  84 *** 

3 8793 AHMAD NUGROHO MEI HERWANTO  M 63  63 * 

4 8812 ARDINA MAFTUHATUN NIKMAH F 58  74 ** 

5 8814 ARNI MAULIDYA FAHIMA F 53  79 *** 

6 8819 AYU ISTI PRABANDARI F 68  74 * 

7 8826 BIMO ANANTYO  M 53  63  

8 8828 BUDI SATRIYO  M 84  79  

9 8835 DESI NUGROHANINGRUM  F 68  89  

10 8839 DEVI KUSUMASTUTI  F 74  84 * 

11 8844 DUTA SAYOGA  M 74  84  

12 8861 FANINA FADHILAH PUTRI AGLIS  F 68  79  

13 8869 FEBRIZA AULIA SYARIATI F 53  84  

14 8872 FIKRI FACHRY HIDAYAT M 68  74  

15 8882 GILAR MENTARI F 68  74  

16 8884 GUSTOMI ALFIANDRI  M 

 
   

17 8902 INDAH KURNIAWATI F 84  74  

18 8908 IRA MUSARAFA  F 74  84  

19 8913 JANUAR RISALDI  M 

 
   

20 8925 MEILANA AYU PUTRI DINI F 79  84  

21 8932 NADIA AGATHA PRAMESTHI F 84  100  

22 8936 NASIEMATUL ARIFAT F 

 
   

23 8943 NURUL FITRI ASTUTI  F 79  84  

24 8950 QANA’ATUSY SYARIFAH  F 47  89  

25 8957 RAVILIONA TIARA YULIANTIKA F 89  79  

26 8959 RENY EKA SETIYOWATI F 68  68 ** 

27 8964 RIFAN PRANANCA BAGUS SAPUTRA M 74  89  

28 8982 SHINTA WAHYU SAPUTRI  F 32  79  

29 8996 UNTARI RAHMAWATI F 74  95 ** 

30 8999 VISTA AYUNINGTYAS  F 53  89  

31 9007 YOHANES WAHYU KENDY PRATAMA M 63  89 * 

32 9008 
YONATAN WISNU KENDY 
PRASETYO  M 74  74  

 

    
  

 
Total  2330 L : 12 

  
     

 
Rata – rata  80.34 P : 20 

  
     

      

     

      

     

Menyetujui, 

Guru Pembimbing 
 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 
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Lampiran 13. Surat Keputusan Pembimbing  



KEPUTUSAN DEKAN
FAKULTAS TEKNIK

UNIVERSITAS NEGERI YOGYAKARTA
NOMOR z lztELW Q-l |llzDlt

TENTANG
PENGANGKATAN PEMBIMBING TUGAS AKHIR SKRIPSI

BAGI MAHASISWA FAKULTAS TEKNIK UNIVERSITAS NEGERI YOGYAKARTA

DEKAN FAKULTAS TEKNIK
UNIVERSITAS NEGERI YOGYAKARTA

Menimbang : l. Bahwa sehubungan dengan telah dipenuhi syarat untuk penulisan Tugas Akhir Skripsi bagi

mahasiswa Fakultas Telnik Universitas Negeri Yogyakarta, perlu diangkat pembimbing'

2. Bahwa untuk keperluan dimaksud perlu ditetapkan dengan Keputusan Dekan.

Mengingat : 1. Undang-undang Nomor 20 tahun 2003.

2. PeraturanPemerintah RI Nomor 60 tahun 1999'

3. Keputusan Presiden RI: a. Nomor 93 tahun 1999;b.305i\4 tahun 1999.

4. Keputusan Menteri Pendidikan dan Kebudayaan RI: Nomor 2741C.11999'

5. Keputusan Mendiknas RlNomor 003/0/2001'

6. Keputusan Rektor UNY Nomor : 1160/UN34lKPl20ll

MEMUTUSKAN
Menetapkan

Mengangkat pembimbing Tugas Akhir Skripsi bagi mahasiswa Fakultas Teknik Universitas Negeri

Yogyakarta sebagai berikut :

Pertama

Nama Pembimbing
Bagi mahasiswa
NamaA{o.Mahasiswa
Jurusan/ Prodi

Dr. Eko Marpanaji

Marnrar Ramadhani I A852A:241028,',
pendidikan Teknik Elektronika / Pendidikan Teknik Informatika

tugas membimbing penulisan Tugas Akhir Skripsi sesuai dengan
Kedua

Ketiga

Keempat

Dosen pembimbing diserahi

Pedoman Tugas Akhir SkriPsi.

Keputusan ini berlaku sejak ditetapkan

Segala sesuatu akan diubah dan dibetulkan sebagaimana mestinya apabila di kemudian hari ternyata

terdapat kekeliruan dalam Keputusan ini.

Ditetapkan : di YogYakarta

Padatanggal ; 10 Januxi2}l2

Soenarto
30 198601 1 001

Tembusan Yth :

1. Pembantu Dekan I, II, [I FT LrNY
2. Ketua Jurusan Pendidikan Teknik Elektronika

3. Ka Bag Tata UsahaFT UNY
4. Yang bersangkutan ''l'i

Ie

ffi
f. N(--r

=it'trx. 116*r*
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Lampiran 14. Surat Izin Penelitian  



KEMENTERIAN PENDIDIKAN DAN KEBUDAYAAN

UNTVERSITAS NEGERI YOGYAKARTA

FAKULTAS TEKNIK
Alamat : Kampus Karangmalang, Yogyakarta, 55281

Telp. (0274) 586'168 psw.276,289,292(0274) 586734 Fax. (0274) 586734
website : http://ft . unv.ac. id e-mail: ft@unv.ac. id ; teknik@uny. ac. id

t7,fit':0t: !: {}/}

letffirs'le Nr. QSC l[tSfl

Nomor : 0075/UN34.l5lPLl20l2
Lamp. : 1(satu)benddl
Hal : Permohonan Ijin Penelitian

17 Januari2}l2

Yth.
1. Gubernur Provinsi DIY c.q. Ka. Biro Administrasi Pembangunan Setda Provinsi DIY
2. Bupati Sleman c.q. Kepala Bappeda Kabupaten Sleman

3,. Kepala Dinas Pendidikan, Pemuda dan Olakaga Propinsi DIY
4. Kepala Dinas Pendidikan Kabupaten Sleman

5. Kepala SMANEGEzu 1 KALASAN

Dalam rangka pelaksanaan Tugas Akhir Skripsi kami mohon dengan hormat bantuan Saudara

memberikan rjin untuk melaksanakan penelitian dengan judul "EFEKTMTAS
PENGGUNAAN MEDIA PEMBELAJARAN E.LEARNING BERBASIS WEB BASED

TRAINING TERIIADAP HASIL BELAJAR SISWA MATA PELAJARAN TEKNOLOGI
INFORMASI DAN KOMUNIKASI KELAS X SMA NEGERI 1 KALASAN", bagi

mahasiswa Fakultas Teknik Universitas Negeri Yogyakarta tersebut di bawah ini:

No. Nama NIM Jurusan/?rodi Lokasi Penelitian

1 Mawar Ramadhani 0852024r028 Pend. Teknik Informatika -

S1

SMA NEGERI 1

KALASAN

Dosen Pembimbing/Dosen Pengampu : Dr. Eko Marpanaji
NIP : 19670608 199303 1 001

Adapun pelaksanaan penelitian dilakukan mulai tanggal 17 Januari 2012 sampai dengan selesai.

Demikian permohonan ini, atas bantuan dan kerjasama yang baik selama ini, kami mengucapkan

terima kasih.

Tembusan:
Ketua Jurusan
Ketua Program Studi

Dekan,
u.b. Wakil Dekan I,

ffiR
*i{{;HH}s)e

0852024'1028 No.40



PEMERINTAH PROVINSI DAERAH ISTIMEWA YOGYAKARTA
SEKRETARIAT DAERAH

Kompleks Kepatihan, Danurejan, Telepon (0274) 562811 - 562814 (Hunting)
YOGYAKARTA 55213

SURAT KETERANGAN / IJIN
070t3704Nt4t2012

Membaca Surat : Dekan Fak. Teknik UNY

Tanggal : 17 Januari2012

Nomor : 0075/UN34.15lPLl2012

Perihal : ljin Penelitian

NIP/NIM : 08520241028

Mengingat ;1. Peraturan Pemerintah Nomor 41 Tahun 2006, tentang Perizinan bagi Perguruan Tinggi Asing,
Lembaga Penelitian dan Pengembangan Asing, Badan Usaha Asing dan Orang Asing dalam
melakukan Kegitan Penelitian dan Pengembangan di lndonesia;

2. Peraturan Menteri Dalam Negeri Nomor 33 Tahun 2007, tentang Pedoman penyelenggaraan
Penelitian dan Pengembangan di Lingkungan Departemen Dalam Negeri dan Pemerintah Daerah;

3. Peraturan Gubernur Daerah lstimewa Yogyakarta Nomor 37 Tahun 2008, tentang Rincian Tugas dan
Fungsi Satuan Organisasi di Lingkungan Sekretariat Daerah dan Sekretariat Dewan Perwakilan
Rakyat Daerah.

4. Peraturan Gubernur Daerah lstimewa Yogyakarta Nomor 1B Tahun 2009 tentang Pedoman Pelayanan

Perizinan, Rekomendasi Pelaksanaan Survei, Penelitian, Pendataan, Pengembangan, Pengkajian,

dan Studi Lapangan di Daerah lstimewa Yogyakarta.

DIIJINKAN untuk melakukan kegiatan survei/penelitian/pendataan/pengembangan/pengkajian/studi lapangan kepada:

Nam'a

Alamat
Judul

Lokasi

Waktu

MAWAR RAMADHANI

Karangmalang Yogyakarta

EFEKTIVITAS PENGGUNAAN MEDIA PEMBELAJARAN E.LEARNING BERBASIS WEB

BASED TRAINING TERHADAP HASIL BELAJAR SISWA MATA PELAJARAN

TEKNOLOGI INFORMASI DAN KOMUNTKASI KELAS X SMA NEGERI 1 KALASAN

- Kota/Kab. SLEMAN

17 April 2012 sld 17 Juli 2012

Dengan Ketentuan

1. Menyerahkan surat keterangan/ijin survei/penelitian/pendataan/pengembanganipengkajian/studi lapangan .) dari
Pemerintah Provinsi DIY kepada Bupati/Walikota melalui institusi yang berwenang mengeluarkan ijin dimaksud;

2. Menyerahkan soft copy hasil penelitiannya baik kepada Gubernur Daerah lstimewa Yogyakarta melalui Biro
Administrasi Pembangunan Setda Provinsi DIY dalam compact disk (CD) maupun mengunggah (upload) melalui
website adbang.jogjaprov.go.id dan menunjukkan cetakan asli yang sudah disahkan dan dibubuhi cap institusi;

3. ljin ini hanya dipergunakan untuk keperluan ilmiah, dan pemegang ijin wajib mentaati ketentuan yang berlaku di
lokasikegiatan;

4. ljin penelitian dapat diperpanjang maksimal 2 (dua) kali dengan menunjukkan surat ini kembali sebelum berakhir
waktunya setelah mengajukan perpanjangan melalui website adbang.jogjaprov.go.id;

5. ljin yang diberikan dapat dibatalkan sewaktu-waktu apabila pemegang ijin ini tidak memenuhi ketentuan yang
berlaku.

Dikeluarkan di Yogyakarta

Pada tanggal 17 April2012
A.n Sekretaris Daerah

Asisten Perekonomian dan Pembangunan

ub.

ffi
ii Blts-

,8 *r.P\1. Kepala Biro Ad ministrasi Pemban gunan

t &//tuilO
fl*'
ii ol

Tembusan : il A:JJ
1. Yth. Gub-ernur Daerah lstimewa Yogyakarta (sebagai laporan); o\. @$tl6ZO226 198803 1 0OB

2. BupatiSleman c/q Bappeda

3. Ka. Dinas Pendidikan, Pemuda dan Olahraga Provinsi DIY

4. Dekan Fak. Teknik UNY



PEMERINTAH KABUPATEN SLEMAN

BADAN PERENCANAAN PEMBANGUNAN DAERAH
( BAPPEDA )

Alamat : Jl. Parasamya No. 1 Beran, Tridadi, Sleman 5551 1

Telp. & Fax. (0274) 868800. E-mail :bappeda@slemankab.go'id

Dasar :

Menunjuk :

SURAT IZIN
Nomor : 07.0 / Bappeda/ 1266 I 2012

TENTANG
PENELITIAN

KEPALA BADAI\ PERENCANAAN PEMBANGUNAN DAERAH

Keputusan Bupati Sleman Nomor: 55 /Kep.KDH/N2003 tentang Izin Kuliah Kerja
Nyata, Praktek Kerja Lapangan dan Penelitian.
Surat dari Sekretariat Daerah Pemerintah Provinsi Daerah Istimewa Yogyakarta Nomor:
070/3704N14/2012. Tanggal: l7 April 2012. Hal: Izin Penelitian.

Kepada

Nama
No. MhsA.IIMAilPAIIK
Program/ Tingkat
Instansi/ Perguruan Tinggi
Alamat Instansi/ Perguruan Tinggi
Alamat Rumah
No. Telp/ Hp
Untuk

Lokasi
Waktu

Tembusan Kepada Yth :

1. Bupati Sleman (sebagai laporan)
2. Ka. Kantor Kesatuan Bangsa Kab. Sleman
3. Ka. Dinas Pendidikan, Peumda & OR Kab. Sleman
4. Ka. Bid. Sosbud Bappeda Kab. Sleman
5. Camat Kec. Kalasan
6. Dekan Fak. Teknik-UNY.
7. Ka. SMA Negeri I Kalasan
8. Pertinggal

MENGIZINKAN:

MAWAR RAMADHANI
08520241028
S1

UNY
Karangmalang, Yogyakarta
Kadisoro RT 02 Gilangharjo, Pandak, Bantul, Yogyakarta
0818 0264 3708
Mengadakan penelitian dengan j udul:
(EF'EKTIVITAS PENGGUNAAI\ MEDIA PEMBELAJARAN
E.LEARNING BERBASIS WEB BASED TRAINING
TERIIADAP HASIL BELAJAR SISWA MATA PELAJARAN
TBKNOLOGI INFORMASI DAN KOMTJNIKASI KELAS X
SMA NEGERI 1 KALASAN"
Kab. Sleman
Selama 3 (tiga) bulan mulai tanggalz 17 April 2012 s/d
17 Juli 2012

Dengan ketentuan sebagai berikut :

l. Wajib melapor diri kepada Pejabat Pemerintah setempat (Camat/ Kepala Desa) atau Kepala Instansi
untuk mendapat petunjuk seperlunya.

2. Wajib menjaga tata tertib dan mentaati ketentuan-ketentuan setempat yang berlaku.
3. Izin ini dapat dibatalkan sewahu-wahu apabila tidak dipenuhi ketentuan-ketentuan di atas.

4. Wajib menyampaikan laporan hasil penelitian berupa 1 (satu) CD format PDF kepada Bupati diserahkan
melalui Kepala Bappeda.

5. Izin tidak disalaltgunakan untuk kepentingan-kepentingan di luar yang direkomendasikan.

Demikian izin ini dikeluarkan untuk digunakan sebagaimana mestinya, diharapkan pejabat pemerintah/

non pemerintah setempat memberikan banfuan seperlunya.
Setelah selesai pelaksanaan penelitian Saudara wajib menyampaikan laporan kepada kami I (satu) bulan

setelah berakhimya penelitian.
Dikeluarkan di : Sleman
Pada Taneeal : 17 April2012

A.n. Kepala BAPPBDA Kab. Sleman
Ka. Bidang Pengendaliaa $ f,'valr'rsi

u.b.
Ka. Sub Bid. Litbang

SRI NURHIDAYAH. S.Si. MT
Penafa Tk I TTI/d
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Lampiran 15. Surat Keterangan Selesai Penelitian  



v'- - .-

i
I

I

F:*\

PEMERINTAH KABUPATEN SLEMAN
DINAS PENDIDIKAN, PEMUDA DAN OLAHRAGA

SMA NEGERI I KALASAN
Alamat

Email
Website

: Bogem, Tamanmartani, Kalasan, Sleman 55571
Telp. (027 4 ) 496040, Fax.: (027 4)496040

: www.sman I kalasan.sch.id

SURAT KETERANSAI{
Nomor : 070/ 391

Yang bertanda tangan dibawah ini Kepala Sekolah Menengah Atas Negeri I Kalasan

Kabupaten Sleman menerangkan dengan sesungguhnya bahwa Mahasiswa Universitas

negeri Yogyakarta G[NY) tersebut di bawah ini :

Nama

NIM
Fakultas

Prodi

Jurusan

Program/Tingkat

Alamat

MAWAR RAMADHANI

08520241028

Teknik

Pendidikan Teknik Informatika

Pendidikan Teknik Elektronika

Sarjana (Sl)

Kadisoro RT 02 Gilangharjo pandak Bantul

Telah melaksanakan kegiatan penelitian dengan judul " EFEKTIVITAS PENGGUNAAN
MEDIA PEMBELAJARAN E.LEARNING BERBASIS WEB BASED TRAINTNG
TERHADAP HASIL BELAJAR STSWA MATA PELAJARAN TEKNOLOGI
INFORMASI DAN KOMI.INIKASI KELAS X SMA NEGERI I KALASAN,, pada

tanggal l8 Februari 2012 s.d 5 Mei 2012.

Demkian surat keterangan ini kami buat, untuk digunakan sebagaimana mestinya.

ll Juni 2012
h,

SUGIHARTO

=
H,ffi

//*\6*.il
i o_ [EllAt{Ecrn\\*F\\.N

198103 t 024
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Lampiran 16. Labsheet  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

LABSHEET 1 

SIMULASI ELEKTRON 
MATERI  

 MICROSOFT OFFICE POWER POINT 2007  

POKOK BAHASAN  

 ANIMASI MENGGUNAKAN MICROSOFT OFFICE POWER POINT 2007  

TUJUAN PEMBELAJARAN 

Setelah proses pembelajaran materi ini, peserta didik diharapkan mampu :  

1. Membuat animasi dalam presentasi menggunakan powerpoint 2007.  

LANGKAH – LANGKAH PEMBUATAN (ANIMASI SIMULASI ELEKTRON)  

1. Buka Power Point 2007 

 
2. Buat 3 lingkaran untuk dijadikan perumpamaan electron, proton dan inti atom.  

 
3. Beri animasi pada setiap lingkaran. Lingkaran 1, 2 dengan animasi motion paths – circle 

dan lingkaran 3 dengan emphasis – spin.  
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4. Atur effect seperti ini untuk setiap lingkaran.  

 
 

5. Sesuaikan desain simulasi sehingga menyerupai posisi electron.  

 

 

6. Mainkan.  

 TUGAS  

BUATLAH PRESENTASI ANIMASI SIMULASI ELEKTRON, DENGAN MENGIKUTI LANGKAH – LANGKAH 

YANG SUDAH TERTERA DI ATAS, KEMUDIAN UPLOAD MENGGUNAKAN E-LEARNING.  

SELAMAT MENGERJAKAN!  
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LABSHEET 2 

ANIMASI TRANSISI SEDERHANA 
MATERI  

 MICROSOFT OFFICE POWER POINT 2007  

POKOK BAHASAN  

 ANIMASI MENGGUNAKAN MICROSOFT OFFICE POWER POINT 2007  

TUJUAN PEMBELAJARAN 

1. Membuat animasi dalam presentasi menggunakan powerpoint 2007, terutama dalam 

kompetensi animasi transisi  

LANGKAH – LANGKAH PEMBUATAN (CONTOH ANIMASI TRANSISI SEDERHANA)  

1. Buka Power Point 2007 

 
 

2. Buat 3 slide kosong dengan layout 1(Title Slide) 2(Title and Content) 3(Two Content). 

Jangan lupa beri background bebas, dan sisipkan halaman slide.  

   
 

3. Pasang transisi pada masing – masing slide, dengan cara klik menu “Animations” – 

“Transition to This Slide”. Silakan pilih bebas.  

 
 

4. Ketikkan teks nama lengkap, kelas dan presensi pada slide 1. Kemudian beri animasi 

Entrance – Flip.  
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Contoh slide seperti ini  

 
 

5. Untuk slide 2, perhatikan keterangan di bawah ini.  

Judul 

 > Tipe : entrance, otomatis jalan  

 > Jenis : basic, perhuruf  

Isi  

 > Tipe : entrance, otomatis jalan  

 > Jenis : bebas  

 > Setelah animasi selesai : berubah warna  

Judul dan Isi :  

 > Tipe : exit otomatis lalu berganti slide  

 

Contoh slide seperti ini  

  
Isi teks bebas. 

 

6. Untuk slide 3, buatlah animasi gambar seperti contoh. Perhatikan contoh!  

Judul  

 Emphasis – Brush on Color  

Isi (Teks)  

 Emphasis – Teeter  

Isi (Gambar)  

 Animasi bebas  

 

Atur sedemikian rupa sehingga animasi teks dan gambar yang sama muncul bergantian.  
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Contoh slide seperti ini  

  
Isi gambar seputar binatang.  

 

 

SELAMAT MENCOBA!!! 
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LABSHEET 3 

HYPERLINK DALAM PRESENTASI POWER POINT 
MATERI  

 MICROSOFT OFFICE POWER POINT 2007  

POKOK BAHASAN  

 HYPERLINK DALAM MICROSOFT OFFICE POWER POINT 2007  

TUJUAN PEMBELAJARAN  

 Membuat animasi dalam presentasi menggunakan powerpoint 2007, terutama dalam 

kompetensi hyperlink   

 

TEORI  

Membuat hyperlink  

Anda dapat membuat hyperlink yang akan mengantarkan tampilan ke slide – slide selanjutnya 

ataupun slide secara acak. Anda dapat membuat link dari berbagai macam objek, termasuk teks, 

shape, tabel, paragraf dan gambar.  

 

Anda juga dapat membuat link pada beberapa file, di antaranya : 

 Membuat hyperlink ke halaman Web  

Membuat alamat link menuju situs Web sebuah perusahaan sering menjadi salah satu 

pilihan presenter, sehingga audiensi dapat langsung melihat kegiatan, produk, dan fasilitas 

– fasilitas yang dimiliki perusahaan tersebut. Untuk membuat hyperlink ke situs Web 

lakukan langkah berikut :  

1. Tampilkan slide dalam keadaan Normal View, misalnya pilih teks yang berisi alamat 

situs Web. 

2. Lanjutkan dengan memilih tab Insert kemudian klik Hyperlink, atau tekan Ctrl + K 

untuk shortcutnya.  

3. Akan muncul kotak dialog Insert Hyperlink. Pilih menu Exist file or Web Page, 

kemudian pada kotak Address isi alamat situs Web, misalnya http://www.detik.com. 

Setelah pengaturan selesai, klik OK untuk mengakhiri. 

  
4. Setelah selesai melakukan langkah tersebut, cobalah tampilkan slide pada posisi Full 

Screen dengan klik F5.  

 

 Membuat hyperlink ke file baru 

Untuk membuat hyperlink dari presentasi file baru lakukan langkah sebagai berikut :  

1. Pastikan Anda membuat antarmuka dalam keadaan Normal View, kemudian pilih 

teks atau objek yang ingin Anda gunakan sebagai hyperlink.  

2. Pada tab Insert klik Hyperlink. Untuk shortcut perintah ini, anda dapat menekan 

Ctrl + K pada keyboard.  

http://www.detik.com/
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3. Akan tampil kotak dialog Insert Hyperlink, kemudian pilih Create New 

Document, seperti gambar berikut :  

 
4. Beri alamat yang akan Anda link ke kotak dialog Name of new document. Secara 

default Full Path berada pada lokasi di mana Anda menempatkan file. Jika ingin 

membuat dokumen pada lokasi lain, di bawah Full Path klik Change, cari lokasi 

yang Anda inginkan untuk membuat file baru, kemudian klik OK.  

5. Setelah mengedit lokasi Full Path pada kotak dialog Insert Hyperlink, tentukan 

apakah Anda akan melakukan pengeditan untuk slide baru saat itu juga atau nanti, 

pilih opsi di bawah When to edit kemudian klik OK.  

6. Untuk mengetahui hasil dari langkah tersebut tekan F5 pada keyboard dan Anda 

akan memperoleh tampilan Full Screen.  

 
 

Menghapus hyperlink  

Jika hyperlink sudah tidak dibutuhkan lagi, Anda dapat menghapusnya dengan langkah sebagai 

berikut :  

1. Dalam keadaan Normal View pilih teks atau objek yang menjadi objek hyperlink.  

2. Pilih tab Insert pada grup Links, kemudian klik Hyperlink, atau klik Ctrl + K pada 

keyboard untuk mendapatkan langkah cepat.  

3. Akan tampil kotak dialog Edit Hyperlink untuk menghapus link, kemudian tuliskan alamat 

yang akan dihapus pada kotak Text to display, E-mail address, dan Recently used e-

mail addresses.  

4. Klik Remove Link kemudian klik OK untuk mengakhiri.  
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Action Button 

Action Button terdiri atas beberapa bentuk, seperti anak panah ke kanan dan ke kiri. Sering pula 

tombol ini digunakan untuk simbol yang dipahami sebagai next, previous, first, dan last slides. 

Untuk menggunakan Action Button ikuti langkah sebagai berikut :  

1. Buka slide presentasi dalam keadaan Normal View.  

 
2. Pada tab Insert dalam grup Illustrations klik anak panah di bawahnya kemudian klik 

Shapes, maka akan muncul pilihan shape.  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

3. Dalam menu pilihan shape pada kolom Action Button, klik ikon Home (gambar rumah) 

untuk disisipkan pada slide presentasi, drag ikon tersebut ke dalam slide karena akan 

digunakan sebagai tombol navigasi.  

 
4. Pada slide akan tampil kotak dialog Action Settings.  

  
5. Dalam kotak dialog Action Settings pilih menu Mouse Click sehingga akan tampil 

beberapa menu. Pilih pada Hyperlink to dan dalam kolom di bawahnya pilih First Slide 

(sebagai contoh).  

6. Akhiri dengan meng-klik OK.  

 

TUGAS ! 
 

Bagaimana memberikan perintah Hyperlink hanya dengan mengarahkan kursor ke Media 

Hyperlink tersebut tanpa meng-kliknya?  

Dalam Power Point terdapat fasilitas yang dinamakan Action - Mouse Over. Fasilitas ini dapat diilustrasikan 
seperti ini: kita sedang mempresentasikan sebuah materi di depan umum, anggap saja kita slide show pada 
slide 1 dan kemudian kita ingin memperlihatkan materi yang terdapat di slide 5 maka hanya dengan 
mengarahkan mouse ke media hyperlink (penghubung antara slide 1 dengan slide 5) maka secara cepat slide 
5 ditampilkan. 

Untuk memanfaatkan fasilitas Action - Mouse Over (Hyperlink Tanpa Click), maupun Action – 

Click, ikuti langkah-langkah berikut ini : 

1. Buka PowerPoint, pada slide 1 buatlah Media Hyperlink yang berupa tulisan (bisa juga 

media berupa gambar). Pada contoh dibuat 3 Media Hyperlink (Input, Proses, Output).  

 (Menggunakan Action – Click)  
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2. Pada masing – masing Media Hyperlink buatlah link ke suatu slide yang berhubungan 

dengan tulisan tersebut. Contoh :  

 (Menggunakan Action – Mouse Over) 

Slide arahan dari media hyperlink Input 

 

  
Slide arahan dari media hyperlink Proses 

 

 (Menggunakan Action – Mouse Over) 

Slide arahan dari media hyperlink Output 

 

3. Dari masing – masing slide tujuan, buat lagi hyperlink Action – Mouse Over untuk ketiga 

komponen tersebut.  

4. Tambahkan slide baru sampai minimal 7 buah slide.  

5. Untuk membuat Action – Mouse Over, caranya :  

a. Blok tulisan sebagai media hyperlink 
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b. Pilih sub menu Action pada menu Insert. 

 
c. Klik Action, maka akan muncul kotak dialog Action Settings. Pilih tab Mouse Over dan 

lakukan setting seperti di bawah ini.  

 
d. Lakukan pada semua teks seperti dalam presentasi yang ditampilkan. Jika sudah selesai 

pada kotak dialog Action Settings, akhiri dengan klik OK.  

e. Coba jalankan dengan menekan F5.  

Nb : Teks yang sudah diberikan hyperlink akan memiliki tanda teks berwarna biru dan bergaris 

bawah.  

SELAMAT MENCOBA!!! 
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Lampiran 17. Capture E-Learning SMA Negeri 1 Kalasan  



CAPTURE E-LEARNING SMA NEGERI 1 KALASAN 
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Lampiran 18. Dokumentasi Penelitian  



Dokumentasi Penelitian Skripsi 

TEKNOLOGI INFORMASI DAN KOMUNIKASI 

 MAWAR RAMADHANI | 08520241028 | UNY 2012 

 

 

 

 

 

 

 

 

 


